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	Введение


Практика показывает, что в настоящее время многие российские компании, занима​ющиеся проведением маркетинговых исследований, а также отделы маркетинга про​мышленных и торговых организаций часто используют для анализа получаемых полевых данных весьма ограниченный набор аналитических инструментов, иногда даже вовсе без применения статистики. Вместе с тем именно статистический анализ позволяет вскрыть такие закономерности и внутренние связи в данных, которые невозможно выявить другими средствами. Подтверждение гипотез о наличии связи между переменными, оценка характера данных связей, оценка влияния частных па​раметров продукта на общее впечатление от него потребителей, сегментирование потребителей, прогнозирование изменений рыночной конъюнктуры — вот лишь некоторые задачи, с успехом решаемые с применением статистических методов ана​лиза. На новый уровень выводит статистические методы применение специализи​рованного программного обеспечения для анализа. Наиболее популярным в настоя​щее время является статистический программный комплекс SPSS.

Предлагаемое пособие имеет своей целью в доступной для понимания форме си​стематизировать суть основных методов проведения статистического анализа дан​ных при помощи программного пакета SPSS версии 11-12, используемого в прак​тике проведения маркетинговых исследований. Пособие рассчитано на аудиторию, уже имеющую определенные знания в области маркетинга, — практикующих мар​кетологов и аналитиков. Здесь не разъясняется суть маркетинга и роль маркетин​говых исследований, а дается мощный инструментальный аппарат анализа, кото​рый можно применять на практике для повышения эффективности деятельности различных организаций. Автор имеет значительный опыт аналитической работы в данной сфере и надеется, что настоящее пособие поможет всем желающим повы​сить качественный уровень своей собственной работы при анализе полевых дан​ных и написании аналитических отчетов.

Практически все книги, посвященные рассматриваемой теме, представляют собой объемные произведения, содержащие массу ненужной практикам статистической теории и/или описание редко используемых в практике маркетинговых исследо​ваний статистических методик. В данном пособии содержатся только практичес​кие сведения, причем изложение ведется последовательно, шаг за шагом: от подго​товки матрицы исходных данных до применения к ней различных статистических методов. Здесь вы не найдете ни капли «воды»: только та информация, которая реально нужна для того, чтобы немедленно приступить к анализу и наиболее быс​тро и эффективно его провести. Вместе с тем необходимо отметить, что данное пособие не является исчерпывающим руководством по работе с SPSS. В нем со​держится только та информация, которая реально поможет на практике осуществить наиболее часто применяемые методы статистического анализа. Изложение материала снабжено подробными пошаговыми иллюстрациями и конкретными примерами, облегчающими его восприятие.

Для понимания сути описываемых в настоящем пособии статистических методик необходимо прежде всего определить роль и место компьютеризованного статисти​ческого анализа в системе маркетинговых исследований. На рис. В.1 представлена принципиальная схема проведения полевого маркетингового исследования.
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В целом весь процесс проведения полевого маркетингового исследования можно условно подразделить на два этапа.

■   Подготовка материалов, необходимых для проведения исследования:

□   подготовка технического задания (ТЗ);

□   подготовка структуры аналитического отчета;

□   формирование анкеты (на основании ТЗ и структуры отчета).

■   Проведение исследования:

□   полевые работы (сбор данных, анкетирование), результатом которых явля​ется формирование базы данных первичной информации;

□   анализ данных и написание аналитического отчета.

При этом, как следует из рис. В.1, основным результатом первого этапа («Вход») является анкета для опроса целевой аудитории на втором этапе («Исследование»). Второй этап имеет сразу два результата («Выход»). С одной стороны, в результате полевых работ происходит формирование базы данных первичной информации (на основании заполненных анкет), которые затем вводятся в компьютер и анали​зируются при помощи статистических и когнитивных методов. С другой стороны, в результате анализа данных происходит написание аналитического отчета по ис​следованию. Оба данных элемента — база данных и аналитический отчет — пере​даются заказчику (предоставляются руководству компании).

Статистический анализ данных является неотъемлемой частью практически любо​го серьезного полевого маркетингового исследования. Для его проведения задействуются ресурсы на всех ранее названных этапах маркетингового исследования.

1.   На этапе подготовки к исследованию происходит составление анкеты, по кото​рой затем формируется схема кодировки вопросов. Также важный вклад в про​цесс статистического анализа вносит составление структуры аналитического отчета, которая заранее (еще до сбора данных) позволяет определить, какие переменные будут созданы в базе данных и какие статистические процедуры будут использоваться для их анализа.

2.   Когда все анкеты уже собраны и соответствующие данные введены в компью​тер, исследователи приступают непосредственно к статистическому анализу. Данный этап, так же как и все маркетинговое исследование в целом, начинает​ся с подготовки (например, кодирования переменных) и заканчивается прак​тически одновременно с окончанием написания аналитического отчета.

При этом основным ресурсом для проведения статистического анализа является база данных, в которой в закодированном виде содержатся заполненные анкеты по исследованию. В следующем параграфе процесс проведения статистического анализа рассматривается более детально.

Классификация основных методов статистического анализа, применяемых в маркетинговых исследованиях
Несмотря на огромное многообразие существующих статистических методов анализа данных, разработанных в рамках теории математической статистики, в практике маркетинговых исследований находит эффективное применение лишь ограничен​ный набор статистических инструментов. Такие ограничения отчасти связаны с небольшими, как правило, размерами выборок в большей части проводимых мар​кетинговых исследований, отчасти — с ограниченной сферой интересов марке​тингового анализа, в котором далеко не все существующие статистические методы находят применение. Основываясь на практическом опыте, можно предложить сле​дующую схему классификации статистических методов, используемых при ана​лизе данных количественных маркетинговых исследований (рис. В.2). Схема клас​сификации построена таким образом, как обычно происходит процесс анализа, начиная еще с того момента, когда заказчиком и исполнителем исследования только дописано техническое задание и составлена анкета. Как следует из представлен​ной схемы, весь процесс статистического анализа можно разделить на два этапа: подготовительный и собственно анализ данных.

Первый этап имеет целью собрать и систематизировать информацию, необходи​мую для последующей обработки анкет (например, схемы кодировки вопросов), а также обеспечить исследователя данными в том виде, который наиболее подхо​дит для конкретного вида статистического анализа. Несмотря на название данного этапа — «предварительный» — некоторые его элементы (в частности, различные манипуляции с формой представления данных) присутствуют и непосредственно в процессе статистического анализа на втором этапе (например, сортировка и от​бор анкет). Таким образом, результаты первого, подготовительного этапа исполь​зуются в течение всего хода статистического (и когнитивного) анализа в марке​тинговых исследованиях.

На втором этапе данные, содержащиеся в исходной базе (заполненные анкеты), превращаются в коммерческую информацию: систематизируются, классифициру​ются, между ними производится поиск взаимозависимостей. Результатом второ​го, основного этапа статистического анализа являются аналитические материалы

(табуляции, диаграммы и вербальные выводы), которые затем используются при написании аналитического отчета.

Рассмотрим теперь основные элементы, составляющие оба этапа статистического анализа, более подробно.

Итак, как мы видим на рис. В.2, подготовительный этап проходит в целом по ли​нейной схеме. Первым шагом здесь является сбор материалов, необходимых для анализа. В полевых маркетинговых исследованиях к ним обычно относятся: тех​ническое задание на исследование, анкета для опроса целевой аудитории, а также структура будущего аналитического отчета, который формируется по результатам проведенного исследования. Данный шаг обычно проводится еще до начала поле​вых работ (анкетирования), сразу после того, как утверждено задание на исследо​вание. На основании перечисленных материалов вторым шагом определяются так называемые общие параметры выборки, то есть [image: image56.jpg]Crpoka Marens Haasanmst  CTpoka npasku
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[image: image2]устанавливается уровень доверия к результатам исследования и рассчитывается статистическая ошибка всей выбор​ки. Необходимо отметить, что данный шаг следует уже после окончания сбора дан​ных, когда появляется возможность точно определить реально получившийся раз​мер выборки, а также получить информацию о сложностях, возникавших в ходе опроса. Эта информация может в дальнейшем внести определенные коррективы в ход статистического анализа. Например, если предварительно заказчиком были установлены квоты по опросу, а в реальности их выдержать не удалось, может по​требоваться корректировка базы данных (скажем, удаление анкет одной целевой группы). Далее следует весьма важный шаг — составляется так называемая схема кодировки вопросов и ответов анкеты. С учетом сведений, полученных от интер​вьюеров, проводивших анкетирование респондентов, исследователь кодирует воп​росы и ответы анкеты, формализуя их в соответствии с требованиями, предъявля​емыми SPSS (см. п. 1.3). На описываемом шаге также иногда может потребоваться создание специализированной базы данных для проводимого исследования (если ввод данных осуществляется не непосредственно в SPSS, а в какую-либо другую программу — например, в Microsoft Access). Затем на основании имеющейся схе​мы кодировки анкеты выполняются ввод в компьютер анкет, заполненных в ходе полевых работ, и предварительное формирование базы данных в формате SPSS (создание собственно файла данных с расширением .sav). Окончательное форми​рование базы данных в SPSS происходит на следующем шаге, когда переменным и их значениям в полученном файле данных присваиваются вербальные метки. И на этом, собственно, заканчивается деятельность по подготовке исходного файла данных для статистического анализа. После осуществления вышеописанных пяти шагов перед исследователем оказывается полностью работоспособная база дан​ных, содержащая все необходимые данные для проведения статистического ана​лиза. Однако у нас остался нерассмотренным еще один существенный шаг в рам​ках первого, подготовительного этапа — модификация и отбор данных. Данный шаг позволяет аналитику производить предварительные (перед началом статис​тического анализа) манипуляции с имеющимися данными: перекодировать их, формировать условные и случайные выборки, сортировать, а также вычислять новые переменные на основании имеющихся закодированных вопросов анкеты. Действия, осуществляемые над базой данных в рамках описываемого шага, могут производиться не только непосредственно после ввода данных в компьютер, но и в продолжение всего процесса работы с ними.

Таким образом, данный подготовительный этап статистического анализа осуще​ствляется в шесть основных шагов по линейной схеме. Следующий, основной этап статистического анализа проходит несколько по-другому. Он практически всегда начинается с общей систематизации полученных данных (наиболее часто в форме построения линейных распределений). Дальнейшие шаги статистического анали​за полностью зависят от целей исследования и специфики имеющихся данных. Так, исследователю может потребоваться: установить различия между различны​ми целевыми группами респондентов; установить взаимозависимости, существу​ющие между переменными (вопросами анкеты); классифицировать респондентов по группам (сегментировать) на основании определенных критериев. Данные ста​тистические методы могут использоваться как последовательно, так и параллель​но: все вместе или только несколько методов (возможно, даже один).

В последующих главах настоящего пособия рассматриваются все перечисленные выше этапы статистического анализа в описанном логическом порядке — с самого начала, то есть начиная с подготовительных этапов анализа.

От издательства

Ваши замечания, предложения и вопросы отправляйте по адресу электронной по​чты comp@piter.com (издательство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!

Подробную информацию о наших книгах вы найдете на веб-сайте издательства: http://www.piter.com.
Глава 1.Подготовительные этапы статистического
 анализа
В настоящей главе мы рассмотрим основные методы манипу​лирования с данными в SPSS. Рассматриваемые здесь действия обычно производятся перед началом статистического анали​за. Мы начнем обсуждение с самого начала — то есть с того момента, когда к исследователю попадает задание на проведе​ние маркетингового исследования. Далее по порядку будут рас​смотрены все основные действия с матрицей данных.
1.1. Материалы, необходимые для проведения статистического анализа

Первым шагом при подготовке к проведению статистическо​го анализа данных в маркетинговых исследованиях является подбор исходных материалов, в которых содержатся основные параметры проводимого исследования. Обычно эти материа​лы включают в себя следующие документы.
1.   Техническое задание на исследование (ТЗ) охватывает все общие параметры исследования: цели и задачи, планируе​мый размер выборки, информацию о квотах, методе и мес​те сбора данных, а также другую полезную информацию.
2.   Структура аналитического отчета по результатам иссле​дования позволяет определить заранее, какие статистиче​ские процедуры понадобятся при написании аналитиче​ского отчета по исследованию.
3.   Анкета для опроса является основой для составления схе​мы кодировки переменных в базе данных SPSS.
На основании ТЗ и структуры аналитического отчета исследова​тель должен еще до получения данных для анализа (заполненных анкет) составить план предстоящих манипуляций с анкетами рес​пондентов: преобразования данных, статистических процедур и методик. Исследователь должен приступить к обработке анкеты сразу после ее получения, не дожидаясь окончания полевых ра​бот: изучить ее структуру и составить перечень переменных, кото​рые впоследствии войдут в базу данных SPSS.
Основными выходными данными на названном этапе являются:
■   планируемый размер выборки;
■   структура выборки (наличие и размер квот);
■   вид опроса (личный, телефонный);
■   информация о параметрах опроса (наличие фактов фальсификации анкет);
■   схема (таблица) кодировки переменных в базе данных SPSS;
■   план-схема преобразования данных;
■   план-схема используемых статистических процедур.
Как вы увидите далее, эти данные являются весьма ценным ресурсом для последу​ющего статистического анализа.
Необходимо отметить, что на рассматриваемом этапе также можно выполнять и другие действия. Так, если заполненные анкеты вводятся в компьютер при по​мощи специализированного программного обеспечения (например, программы Data Entry или сканерного программного комплекса), на основании имеющейся анкеты и согласно целям и задачам исследования следует сформировать соответ​ствующие формы (для программы Data Entry) или создать шаблоны и макеты ан​кеты (для сканерного ввода). Только после успешного завершения этого подгото​вительного шага можно приступать к дальнейшим этапам.
1.2. Общие параметры выборки

Определение общих параметров выборки осуществляется после завершения полевых работ (когда собраны все анкеты). Данный этап состоит из ряда взаимосвязанных ша​гов. Это:
■   определение реального количества опрошенных респондентов;
■   определение структуры выборки;
■   распределение по месту опроса;
■   установление доверительного уровня статистической надежности выборки;
■   расчет статистической ошибки и определение репрезентативности выборки. Первое, что должно интересовать исследователя после получения заполненных анкет, — это количество респондентов. Оно может быть либо больше, либо мень​ше запланированного количества анкет. При этом первый вариант лучше с точки зрения статистического анализа, но хуже с точки зрения руководства фирмы, так как дополнительные анкеты являются незапланированными расходами на оплату работы интервьюеров. Второй вариант обычно хуже и с точки зрения анализа (вы​борка менее представительна), и с точки зрения руководства (заказчик будет не​доволен несоблюдением требований, оговоренных в ТЗ).
При оценке разницы между реальным и плановым размером выборки следует при​нимать в расчет разницу в статистической ошибке (см. ниже). Если она невелика (в ту или другую сторону), репрезентативность всей выборки существенно не стра​дает. Но если разница достаточно значима, выборка может оказаться непредстави​тельной. Кроме того, при определении общего размера выборки необходимо иметь в виду, что статистическая ошибка всей выборки относится только к общим распределениям. Разрезы существенно увеличивают статистическую ошибку. Поэто​му еще до начала опроса следует определить, какая численность каждой из инте​ресующих целевых групп респондентов является достаточной для построения ста​тистически значимых заключений и выводов.
Структура выборки может быть случайной (респонденты отбирались в случайном порядке) или неслучайной (респонденты отбирались на основании заранее извест​ных критериев, например методом квотирования). Эта информация важна при ин​терпретации результатов статистического анализа. Случайные выборки априори являются репрезентативными, так как на попадание/непопадание каждого респон​дента в выборку не влияют никакие факторы, кроме случайных. Представитель​ность неслучайных выборок не следует из их определения. Иногда они специально делаются нерепрезентативными относительно генеральной совокупности, однако могут являться весьма представительными относительно какой-либо одной инте​ресующей целевой группы (например, исследуется только мнение мужчин в воз​расте после 40 лет).
При анализе структуры выборки необходимо также изучить фильтрационные во​просы анкеты, то есть вопросы, специально предназначенные для отсеивания не подходящих под требования выборки респондентов. Несмотря на то, что такие вопросы позволяют исключить не нужные для конкретного исследования целе​вые группы, знание доли исключенных категорий позволит впоследствии соста​вить общее представление о параметрах всей генеральной совокупности.
Приведем пример. Методом телефонного опроса исследуется потребительский спрос на московском рынке творожной массы. При этом опрашиваются только лица, покупающие данный продукт, — для чего в анкету добавлен соответствующий фильтрационный вопрос. Однако в дальнейшем потребуется рассчитать емкость рынка исследуемого продукта. Решением данной задачи будет подсчет количества отсеянных респондентов (лиц, не покупающих творожную массу). Таким образом, впоследствии мы сможем определить долю покупателей творожной массы от об​щей численности населения Москвы.
Еще одна важная для исследователя характеристика выборки — это распределе​ние респондентов по месту опроса (личные интервью). Позже эти данные могут помочь при определении различий между респондентами, опрошенными в разных местах. (Очевидна разница в доходах между посетителями рынков и бутиков.)
Имея в своем распоряжении указанную выше информацию, можно приступать к определению представительности (или репрезентативности) выборки. Прежде всего необходимо установить уровень доверия к результатам опроса. Обычно в маркетинговых исследованиях используется уровень доверия 95 % и 99 %. Мы рекомендуем остановиться именно на первом варианте как на наиболее релевант​ном по отношению к маркетинговым исследованиям.
В зависимости от выбранного доверительного уровня определяется специфиче​ская константа г, участвующая в формуле расчета статистической ошибки выбор​ки. Константы доверительных уровней, наиболее часто используемых в маркетин​говых исследованиях, представлены в табл. 1.1.
Таблица 1.1. Константы доверительных уровней
	Доверительный уровень
	Константа z

	90 %

95 %

99 %
	±1,64

±1,96

±2,58


Максимальная статистическая ошибка выборки рассчитывается по следующей формуле:
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где — статистическая константа для соответствующего доверительного уровня; p= q = 50 % — вероятность наступления/ненаступления исследуемого события (то есть попадания/непопадания респондента в выборку); для случайных выборок данная ве​роятность равна 1/2 или 50 %; n — размер выборки (общее количество опрошенных).
Таким образом, для выборки в 1000 респондентов и при уровне доверия к резуль​татам опроса 95 % статистическая ошибка выборки будет равна:
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Эта же статистическая ошибка используется для характеристики всех значений в вы​борке, выраженных в относительных величинах. То есть если в дальнейшем при по​строении линейных распределений по вопросам анкеты мы выясним, что 32 % рес​пондентов покупают газеты в киосках на улице, — это будет означать, что данное значение варьируется в пределах от 28,9 % (32 % - 3,1 %) до 35,1 % (32 % + 3,1 %).
Для расчета статистической ошибки значений переменных, выраженных в абсо​лютных величинах, применяется другая формула. При этом ошибка варьируется в зависимости от конкретной анализируемой величины. Ее расчет основан на по​строении линейных распределений и показан в разделе 2.1.
1.3. Составление схемы кодировки анкеты
Схема кодировки анкеты представляет собой таблицу соответствия вопросов и ва​риантов ответа анкеты внутреннему представлению переменных в базе данных SPSS. Впоследствии ввод анкет в компьютер и кодирование ответов респондентов производятся согласно данной формализованной структуре. Пример таблицы ко​дировки представлен в табл. 1.2.
Как вы видите, различные типы вопросов анкеты кодируются в схеме кодировки (и в базе данных SPSS) по-разному. Существует три основных типа кодирования вопросов анкеты.
1. Закрытые вопросы, в которых респондент может указать только один вариант ответа (одновариантные), кодируются одной переменной (например, ql). Тип шкалы в данном случае может быть любым.
2.   Закрытые вопросы, в которых респондент может дать несколько вариантов от​вета (многовариантные), кодируются несколькими одновариантными перемен​ными (например, q3_l, q3_2). Тип шкалы одновариантных переменных может быть только номинальным (дихотомическим).
3.   Открытые вопросы, независимо от количества возможных вариантов ответа на них, кодируются одной переменной. Тип шкалы в данном случае может быть либо интервальным (для числовых данных, например q5_t), либо номиналь​ным (для нечисловых данных, например q4_t).
Таблица 1.2. Кодировка различных типов вопросов
	Вопрос анкеты
	Код и тип переменной в базе данных

	Номер анкеты________
	n_resp – интервальная шкала

	1. Покупаете ли  Вы мясные полфобриканты?

Да 

Нет 
	q1 – номинальная шкала
Вариант ответа 1

Вариант ответа 2

	2. Как часто Вы покупаете эти продукты?
Почти каждый день

2-3 раза в неделю

Примерно раз в неделю

2-3 раза в месяц

Примерно раз в месяц

Реже раза в месяц
	q2 – порядковая шкала
вариант ответа 1

вариант ответа 2

вариант ответа 3

вариант ответа 4

вариант ответа 5

вариант ответа 6

	3. Где Вы обычно покупаете мясные продукты? (возможно несколько ответов)
В магазине

На рынке

В супермаркете

Другое (укажите где именно)
___________________________
	Все варианты ответа являются номинальными переменными
q3_1

q3_2

q3_3

q3_4

q3_4t

	4. Каких производителей мясных продуктов Вы знаете?
_____________________________
	q4_1t – номинальная шкала

	5. Укажите Ваш возраст: _________лет
	q5_1t – интервальная шкала


1.4. Ввод данных в компьютер и кодирование переменных
Ввод данных в компьютер является четвертым шагом первого (подготовительно​го) этапа статистического анализа данных (см. рис. В.2). Он неразрывно связан со следующим шагом — кодированием переменных. В этом разделе мы последова​тельно рассмотрим эти две взаимосвязанные и взаимообусловленные процедуры.
1.4.1. Способы ввода данных в SPSS
Существует три основных способа формирования базы данных в формате SPSS (перечислены в порядке убывания популярности).
1.  Импорт базы данных из других программных источников (Microsoft Access, Microsoft Excel, текстовых файлов и других).
2.   Ввод данных непосредственно в SPSS при помощи специализированного про​граммного обеспечения (SPSS Data Entry).
3.   Ручной ввод данных в SPSS.
Теперь рассмотрим каждый способ более подробно.
1.4.1.1. Импорт данных из других источников

Данный способ создания базы данных в формате SPSS является наиболее распро​страненным. Чаще всего он предполагает использование SPSS в качестве вспомо​гательного средства для статистического анализа данных. При этом построение линейных распределений в графическом виде (диаграмм по общим распределени​ям) может производиться, например, в Microsoft Excel. Также данный метод при​меним и если у вас есть программное обеспечение для автоматически сканируемого ввода бумажных анкет в компьютер. В этом случае специализированная програм​ма (например, ABBYY FormReader) создает особую базу данных в собственном формате (во внутреннем представлении).
Рассмотрим пример создания базы данных в SPSS при помощи перекачки данных из другой программы — Microsoft Access, как одной из наиболее распространен​ных систем управления базами данных (СУБД).
Чтобы осуществить импорт данных в SPSS, необходимо сформировать в соответ​ствующей программе (из которой будет осуществляться импорт) таблицу данных, отформатированную определенным способом. Файл данных SPSS напоминает рабочую книгу Microsoft Excel (электронную таблицу). Однако SPSS, к сожале​нию, не обладает функциональностью электронной таблицы, и схожесть этих двух программных продуктов заканчивается на внешнем виде. Общая схема построе​ния файла SPSS выглядит примерно так, как на рис. 1.1.
Таблица данных в сторонней программе, из которой будет осуществляться импорт, должна соответствовать именно такой схеме (заголовок переменной → значения переменной). Примеры таблиц из Microsoft Access Base.mdb, Microsoft Excel Base.xls, простого текстового файла MS DOS Base.txt и текстового файла с разделителями Base.csv представлены на рис. 1.2-1.5. Независимо от вида разделителей данных в таблицах их объединяет общая структура: заголовок переменной → данные (зна​чение переменной). Представим, что была создана база данных Microsoft Access Base.mdb, содержащая Таблицу данных.
После того как была создана подходящая для импорта таблица данных, следует от​крыть SPSS и вызвать диалоговое окно импорта данных при помощи меню File ► Open Database ► New Query. Откроется мастер Database Wizard (рис. 1.6); в его окне необхо​димо указать источник данных, из которого будет производиться импорт данных. Выберите в списке справа База данных MS Access и щелкните на кнопке Далее.
Следует отметить, что SPSS поддерживает импорт из любых источников данных, совместимых с технологией ODBC (соответствующие драйверы для них должны быть предварительно установлены в Microsoft Windows). Например, чтобы доба​вить возможность импорта из базы данных Microsoft Paradox (файлы типа *.db), необходимо щелкнуть на кнопке Add Data Source в диалоговом окне Database Wizard. На экране появится стандартное окно Microsoft Windows Администратор источни​ков данных ODBC (рис. 1.7). В этом диалоговом окне представлен список уже уста​новленных в SPSS источников данных. Чтобы добавить новый источник, отсут​ствующий в данном перечне, следует щелкнуть на кнопке Добавить.
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Рис. 1.3. Таблицы данных, подходящие для импорта
 в SPSS: лист MS Excel
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Рис. 1.4. Таблицы данных, подходящие для импорта в SPSS: текстовый файл с фиксированными столбцами
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В открывшемся диалоговом окне Создание нового источника данных (рис. 1.8) содер​жится список всех источников данных, установленных в вашей системе Microsoft Windows. Кроме названий источников, в данном перечне вы можете увидеть но​мер версии и название файла соответствующего драйвера. Выберите драйвер Mi​crosoft Paradox Driver (*.db) и щелкните на кнопке Готово.
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При этом будет открыто новое диалоговое окно Установка драйвера ODBC для Paradox (рис. 1.9). Здесь в строке Имя источника данных следует ввести то название, которое будет в дальнейшем отображаться в диалоговом окне Database Wizard в SPSS (на​пример, База данных Paradox). В этом диалоговом окне можно установить дополни​тельные параметры. Чтобы вернуться в SPSS, следует закрыть все использован-
ные диалоговые окна установки источника данных ODBC. Вы увидите, что в списке доступных источников в окне Database Wizard появится база данных Paradox.
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Вернемся к рис. 1.6. Выберите соответствующий источник данных и щелкните на кнопке Далее, после чего на экране откроется диалоговое окно ODBC Driver Login (рис. 1.10). В этом окне следует указать полный путь к базе данных, из которой будет производиться импорт таблицы (в нашем случае это C:\Base.mdb). Щелкни​те на кнопке 0К для продолжения работы.
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Откроется новое диалоговое окно (рис. 1.11). В нем из левого списка всех таблиц, доступных в указанном источнике данных, выберите ту, которая содержит импор​тируемые данные (в нашем случае Таблица данных), и переместите ее в правый спи​сок. Затем щелкните на кнопке Готово, после чего в окне SPSS Data Editor появится импортированная таблица.
Следует отметить, что процедуры импорта данных для разных источников отлич​ны друг от друга. Однако эти различия несущественны, и поэтому мы не будем описывать все типы импорта. Как правило, для таблицы из базы данных Microsoft Access действия, показанные при помощи вышеописанных шагов, достаточны.
1.4.1.2. Ввод данных в SPSS при помощи Data Entry
Данная программа призвана упростить ввод данных в SPSS. При работе с ней ге​нерируются пользовательские формы, содержащие поля анкеты, куда и вводятся данные. Модуль SPSS Data Entry Builder позволяет создавать формы и правила для их заполнения, а модуль SPSS Data Entry Station — вводить анкеты в компью​тер в распределенном режиме (то есть с нескольких компьютеров одновременно). Детальное описание работы с программой Data Entry выходит за рамки настоящего пособия. Отметим лишь, что данная программа является самостоятельным при​ложением Microsoft Windows и не входит в комплект поставки SPSS. Кроме того, программные продукты SPSS достаточно дороги для большинства российских ком​паний, и поэтому рассматриваемый способ ввода данных не получил должного распространения в нашей стране.
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1.4.1.3. Ручной ввод данных в SPSS
Ручной ввод наиболее эффективен при малых размерах выборки, а также для до​стижения некоторых специфических целей (например, при вводе ранжированных списков в ходе расчета корреляции Спирмана; см. раздел 4.2.1). Как и в случае использования программы Data Entry, существует возможность распределенного ввода анкет с несколькими операторами. Когда все операторы закончат ввод своей части анкет, полученные базы данных сливаются в одну при помощи меню SPSS Data ► Merge files, в котором следует выбрать объект добавления анкеты (Add Cases) или переменных (Add Variables).
1.4.2. Кодирование переменных

После того как в файл SPSS помещена таблица с данными по исследованию, сле​дует перейти к очередному этапу формирования базы данных — кодированию пе​ременных.
Если данные вводились в SPSS методом импорта, вы увидите только имена пере​менных и их значения. В этом случае кодирование переменных является обяза​тельным шагом и должно проводиться сразу после процедуры импорта. Если для
ввода данных в SPSS использовалась программа Data Entry, все переменные и их значения окажутся, скорее всего, уже закодированными (на этапе генерирования пользовательских форм). При ручном вводе картина может быть такой, как при импорте данных из других источников (если вы предварительно не производили кодирование), либо аналогичной использованию Data Entry. Тем не менее, неза​висимо от способа ввода, на этапе кодирования необходимо произвести ревизию имеющихся переменных и меток их значений — чтобы удостовериться, что в буду​щем при проведении статистического анализа все используемые величины будут названы осмысленными именами.
Основное рабочее окно SPSS (см. рис. 1.1) содержит специальные вкладки для перемещения между видом файла данных (Data View) и таблицы переменных (Variable View). Кодирование переменных осуществляется на вкладке Variable View. Общий вид окна программы после щелчка на вкладке Variable View показан на рис. 1.121.
[image: image81.jpg]



[image: image82.jpg]



Если в данную таблицу ввести какую-либо переменную (поле Name), все осталь​ные ее поля будут заполнены автоматически значениями по умолчанию. После импорта данных из другой программы все полученные переменные будут пред​ставлены также значениями по умолчанию (сохранятся только имена переменных). Рассмотрим более детально структуру таблицы Variable View.
Первое поле таблицы Name предназначено для ввода имени переменной, которое должно состоять только из латинских букв и цифр; имя переменной не может на​чинаться с цифры. При импорте данных из другого источника данное поле запол​няется теми значениями, которые были указаны в исходной базе данных. Все ос​тальные поля рассматриваемой таблицы заполняются программой автоматически, причем SPSS сама определяет, к какому типу относится та или иная переменная, а в качестве меток дублирует имена переменных.
Поле Туре служит для указания типа переменной. Установленный по умолчанию тип Numeric можно изменить, установив курсор в данную ячейку и щелкнув на по​явившейся кнопке со значком .... Доступные типы переменных представлены на рис. 1.13. Для некоторых из них (например, Numeric) необходимо задать количе​ство используемых разрядов (или букв — для текстовых переменных) и цифр пос​ле запятой, а для других (например, Date) — шаблон, по которому отражаются зна​чения.
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Поле Width служит для указания количества разрядов (для числовых переменных) или букв (для текстовых переменных), если они не были указаны в диалоговом окне указания типа переменной. Следующее поле Decimals позволяет указать ко​личество цифр после запятой для числовых переменных.
Поле Label служит для задания метки переменной. Данное поле важно, так как именно указанные в нем значения появляются на графиках и в таблицах при про​ведении всех видов статистического анализа. В анкетах, используемых при прове​дении маркетинговых исследований, содержатся как одновариантные вопросы (рес​понденты могут указать только один вариант ответа), так и многовариантные (респонденты могут указать несколько вариантов ответа). При этом если однова​риантные вопросы обычно представляются одной переменной, которая может при​нимать столько значений, сколько имеется вариантов ответа, то многовариантные вопросы, как правило, кодируются количеством одновариантных переменных, рав​ным числу вариантов ответа. Каждая такая одновариантная переменная всегда при​нимает только два значения (дихотомии) — отмечено/не отмечено, которые коди​руются соответственно двумя цифрами (обычно 1 и 0). Более подробно схема работы с многовариантными переменными описана в разделе 2.2, мы отметим лишь способ кодирования различных переменных.
Так, при кодировании одновариантных переменных поле Label используется для указания формулировки вопроса анкеты (варианты ответа кодируются в другом поле). При кодировании многовариантных переменных, представленных вариантами ответа, формулировка самого вопроса не отражается в рассматриваемой таб​лице: кодируются только варианты ответа (дихотомические переменные).
Приведем пример. У нас есть одновариантный вопрос Укажите пол респондента — это формулировка данного вопроса, и она отражается в поле Label, а переменной присваивается имя по принципу ql. Формулировка многовариантного вопроса Что для Вас наиболее важно при выборе велосипеда? не будет фигурировать в таблице Variable View. Вместо нее будет указан набор одновариантных дихотомических пе​ременных (по числу вариантов ответа). В поле Label будут указаны названия вари​антов ответа, а в поле Name — имена переменных, кодирующие каждый из вариан​тов ответа (например, переменная q2_l — Цена велосипеда; q2_2 — Качество велосипеда и т. д.).
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Поле Values предназначено для указания вариантов ответа в одновариантных во​просах. Общий вид соответствующего диалогового окна представлен на рис. 1.14. Данное поле не заполняется для многовариантных переменных. В окне Value Labels в поле Value указываются числовые коды вариантов ответа, а в поле Value Label — вербальные формулировки вариантов ответа. При задании меток необходимо пред​лагать разумные варианты ответов, учитывая, что впоследствии именно эти назва​ния (в том же виде) будут фигурировать на графиках и в аналитических таблицах. Например, вариант ответа на вопрос о половой принадлежности респондента сле​дует называть не Мужской или Женский, а Мужчины или Женщины. Также при наиме​новании переменных и вариантов ответа следует избавляться от лишних слов, как то: предлоги в начале предложения, междометия, вводные слова. Это, с одной сто​роны, позволит сократить само название, что в дальнейшем облегчит его восприя​тие, а с другой стороны, избавит таблицы и диаграммы от массы ненужной инфор​мации. Итак, наша основная рекомендация при наименовании переменных — формализация названий.
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Поле Missing используется редко, так как не несет существенной смысловой на​грузки. В нем можно указать, какие коды следует исключить из анализа (присвоить им статус System Missing). По умолчанию все отсутствующие значения (пропу​щенные одновариантные вопросы или неотмеченные варианты ответа многовари​антных вопросов) представляются в SPSS как System Missing и отражаются для числовых переменных символом,.
Также при помощи поля Missing можно наглядно продемонстрировать разницу между различными типами пропущенных значений — типа «user missing» (значе​ния, специально пропущенные исследователем) и типа «system missing» (значения, которые в принципе должны были присутствовать, но которых не оказалось в базе данных в связи с причинами случайного характера, — в том числе и динами​чески, не меняя структуры базы данных. Предположим, что для исследования нам нужны только люди с доходом свыше $ 500. Тогда в начале анкеты мы зададим респондентам фильтрационный вопрос (закрытый): Укажите Ваш примерный сред​немесячный доход в расчете на 1 члена семьи. При этом респондент может выбрать один из пяти вариантов ответа:
1.   до $500;
2.   от $ 500 до $ 1000;
3.   от $1000 до $1500;
4.   свыше $1500;
5.   отказываюсь отвечать.
Очевидно, что для дальнейшего анализа нам подходят только те респонденты, ко​торые указали варианты ответа 2-4. Теперь эти три варианта ответа, которые не​обходимы нам для построения линейных и перекрестных распределений, мы за​носим в поле Values, а оставшиеся два — 1 и 5 — в поле Missing. Два последние варианта исключаются из дальнейшего анализа и будут представляться как значе​ние System Missing. Впоследствии, если мы захотим, например, построить общее линейное распределение по всему фильтрационному вопросу (включая все кате​гории), нужно будет просто убрать два пропущенных (в терминологии SPSS — User Missing) значения из поля Missing и добавить их в поле Values. Поле Columns служит для указания ширины столбца при отображении переменной в окне Data View. Следующее поле Align предназначено для выбора выравнивания значений переменной в столбце: по правому краю (Right), по левому краю (Left) или по центру (Center).
Поле Measure является для SPSS единственной возможностью определить тип шкалы имеющихся переменных: номинальная (Nominal), порядковая (Ordinal) или интервальная (Scale). Как показано далее в разделе 2.5 «Статистический анализ данных», важно знать, к какому типу шкалы относится та или иная переменная в базе данных. От этого во многом зависит выбор используемой статистической про​цедуры. Ниже приведена краткая характеристика трех типов шкалы переменных, используемых в SPSS.
1.   Номинальные переменные (Nominal) могут принимать дискретные, не связан​ные друг с другом значения. Вопросы анкеты, кодируемые номинальными пе​ременными, могут быть как закрытыми (с вариантами ответов), так и открыты​ми (с текстовым полем вместо прямого указания вариантов ответа). Например, вопрос анкеты Каких производителей мясных полуфабрикатов Вы знаете? с вариан​тами ответа Царицыно, Черкизовский, Браво и Другое будет закодирован в базе данных SPSS номинальной переменной, так как между вариантами ответа на данный вопрос не существует логического порядка, это просто названия ком​паний-производителей.
2.   Особое место среди номинальных переменных занимают переменные, являю​щиеся вариантами ответа на многовариантные вопросы или имеющие только два варианта ответа. Тип шкалы данных переменных называется дихотомиче​ским (Dichotomous). Данным переменным в SPSS отводится особая роль, так
как их варианты ответа могут рассматриваться в статистических процедурах как вероятность выбора одной категории или не выбора другой. В качестве вопросов анкеты дихотомические переменные могут кодировать как открытые, так и закрытые вопросы.
3.   Порядковые переменные (Ordinal) кодируют такие закрытые вопросы, вари​анты ответа на которые подчиняются логическому числовому порядку. То есть варианты ответа на такие вопросы представляют собой связанные между собой группы значений. Например, вопрос Как часто Вы покупаете мясные полуфабрика​ты? с вариантами ответа: Чаще раза в неделю, Примерно раз в неделю и Реже раза в неделю — кодируется переменной с порядковой шкалой.
4.   Интервальными (Scale) являются переменные, не имеющие выделенных кате​горий. Они содержат числовые данные (например, номер анкеты в базе дан​ных) и кодируют чаще всего открытые вопросы. Интервальные переменные (или другие типы переменных, приводимые к интервальному виду) используются практически во всех статистических процедурах. Они являются основным ре​сурсом для SPSS.
1.5. Модификация и отбор данных
Этап модификации и отбора данных объединяет целый ряд процедур, используе​мых для манипуляции с имеющимися данными: условный отбор данных, форми​рование случайной выборки, сортировка данных, перекодирование переменных, вычисление новых переменных и т. д. В настоящем разделе мы рассмотрим наибо​лее часто используемые методы автоматизированного управления переменными и их значениями в базах данных SPSS.
1.5.1. Условный отбор данных и случайная выборка
В настоящем параграфе мы рассмотрим такие методы манипуляций с данными, как отбор респондентов по определенному условию (например, выбор из всей базы данных только анкет мужчин), а также формирование случайной выборки.
1.5.1.1. Отбор анкет по условию
Часто при анализе данных в SPSS возникает необходимость отбора только тех рес​пондентов, которые соответствуют определенным требованиям (например, имеют среднемесячный доход свыше $ 1000). В этом случае используют условный отбор данных. Соответствующее диалоговое окно вызывается при помощи меню Data ► Select Cases.
Как вы видите на рис. 1.15,.это диалоговое окно не только позволяет осуществлять условный отбор данных, но и разрешает многие другие манипуляции. При прове​дении маркетинговых исследований наиболее часто применяются только два па​раметра: If condition is specified (Условный отбор данных) и Random sample of cases (Формирование случайной выборки). По умолчанию установлен параметр All cases, что означает выбор всех без исключения респондентов.
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Выберите параметр If condition is specified и щелкните на кнопке If. Откроется но​вое диалоговое окно Select Cases: If, позволяющее задать условие, согласно которо​му будет производиться отбор респондентов (рис. 1.16). Основная рекомендация относительно работы с данным диалоговым окном — заключайте все уравнения (название переменной и ее значение) в круглые скобки. Соблюдение данного тре​бования весьма полезно при составлении длинных последовательностей условий.
[image: image89.jpg]


[image: image90.jpg]



В табл. 1.3 представлена расшифровка всех логических и арифметических операн​дов, используемых при составлении условных выражений. Такие же операнды используются и в других диалоговых окнах, описываемых в разделе 1.5. Это стан​дартные операнды для составления логических выражений.
Необходимо отметить, что все логические операторы, кроме = и ~=, применимы только для числовых переменных (не для текстовых).
Помимо представленных стандартных логических операторов, существуют специ​альные предустановленные функции (область Functions) — при щелчке правой кнопкой мыши на любой из них появляется описание соответствующей функции.
Таблица 1.3. Стандартные логические операторы, используемые в SPSS
	Арифметические
	Логические

	Оператор
	Значение
	Оператор
	Значение

	+
	Сложение (x + y)
	<
	меньше (x < y)

	-
	вычисление (x - y)
	>
	больше (x > y)

	*
	умножение (x * y)
	<=
	меньше или равно (x <=  y)

	/
	деление (x / y)
	>=
	больше или равно (x >= y)

	**
	возведение в степень (x ** y)
	=
	равно (x = y)

	()
	приоритет вычислений
	~=
	не равно (x ~ y)

	|
	или (x | y)
	&
	и (x & y)

	~
	отрицание (~ x)
	
	


В приведенном примере мы выбрали все анкеты, полученные от респондентов, являющихся мужчинами (вопрос q37, вариант ответа 1) в возрасте от 26 до 30 лет (вопрос q39, вариант ответа 2). Щелкнув на кнопке Continue и завершив операцию при помощи щелчка на кнопке 0К в главном диалоговом окне, мы увидим, что рес​понденты, не соответствующие данному условию, оказались исключенными из рассмотрения (их номера перечеркнуты). Можно не только временно исключить из рассмотрения респондентов, не подходящих под определенное условие, но и полностью удалить такие нерелевантные анкеты из базы данных SPSS. Для этого в диалоговом окне Select cases (рис. 1.15) необходимо заменить выбранный по умол​чанию параметр Filtered (в области Unselected Cases Are) на Deleted.
1.5.1.2. Отбор анкет случайным образом

Иногда при обработке данных маркетинговых исследований возникает необходи​мость отбора респондентов не по конкретному условию, а случайным образом (то есть формирование случайной выборки). Эта возможность весьма полезна для уменьшения размера исходной выборки — например, для выполнения статисти​ческих процедур, предъявляющих повышенные требования к вычислительным ресурсам компьютера. Также случайная выборка применяется при проверке кор​ректности работы некоторых статистических процедур (например, факторного анализа): сначала процедура проводится для общей выборки, а затем — для слу​чайной выборки из n-го количества респондентов.
Для формирования случайных выборок в диалоговом окне Select Cases, (см. рис. 1.15) предусмотрен параметр Random sample of cases. Выберите этот параметр и щелкни​те на кнопке Sample. Открывшееся диалоговое окно (рис. 1.17) содержит два спо​соба формирования случайной выборки: с указанием доли респондентов, которых необходимо отобрать из исходной выборки (Approximately), либо с указанием кон​кретного количества респондентов, которое необходимо отобрать (Exactly). При этом в последнем случае необходимо также указать в поле from the first ... cases количество респондентов, из которого следует осуществить выбор. Для формиро​вания случайной выборки из общего числа опрошенных в данном поле следует указать совокупный размер выборки.
В нашем случае мы случайным образом отобрали 50 % респондентов из исходной выборки.
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1.5.2. Сортировка и группировка данных
Сортировка и группировка данных — наиболее часто применяющиеся операции с данными. Причем эти операции могут производиться как перед началом прове​дения статистического анализа, так и на других этапах работы.
1.5.2.1. Сортировка файла данных SPSS
При помощи функции сортировки в SPSS можно упорядочить значения перемен​ных по одному или нескольким ключевым полям анкеты. Вызов диалогового окна сортировки осуществляется последовательностью меню Data ► Sort Cases.
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Как указано на рис. 1.18, левый список содержит все доступные в текущей базе данных переменные. В область Sort by помещаются переменные, по которым сле​дует произвести сортировку. Порядок следования переменных в данной области соответствует порядку сортировки, то есть сначала сортировка происходит по пер​вой переменной, затем — по второй и т. д. Группа переключателей Sort Order позво​ляет выбрать направление сортировки: по возрастанию (Ascending) или убыванию (Descending). При этом для каждой переменной можно выбрать свой тип сортировки.
В нашем случае мы отсортировали базу данных по возрастанию номера анкеты.
1.5.2.2. Группировка значений переменных
SPSS позволяет автоматически разделять значения интервальных переменных на заданное число групп. Разделение производится на основании процентилей, то есть образующиеся группы содержат примерно одинаковое количество значений. Ре​зультатом работы этой процедуры является новая порядковая переменная, кото​рая содержит столько категорий, сколько было указано групп. Диалоговое окно группировки данных вызывается при помощи меню Transform ► Categorize Variables (рис. 1.19). В область Create Categories for переносятся переменные, значения которых необходимо сгруппировать. Поле Number of categories служит для указали числа групп.
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В нашем примере мы разделили выборку по номеру анкеты на четыре примерно равных доли — по 25 %.
1.5.3. Перекодирование переменных
Перекодирование переменных служит для трансформации значений переменных с созданием или без создания новых переменных, а также для автоматического кодирования текстовых переменных для преобразования их к числовому виду.
1.5.3.1. Перекодирование внутри одной переменной
Рекомендуется производить перекодирование значений многовариантных пе​ременных (точнее, наборов дихотомий, как было показано в разделе 1.4.2) сразу после создания базы данных. При этом все пропущенные значения (вариант не отмечено) в таких вопросах следует перекодировать из System Missing в нули. В дальнейшем это позволит использовать данные дихотомические переменные (уже с двумя вариантами ответа: 0 и 1) при проведении статистического анализа (например, при построении перекрестных распределений). Альтернативой обра​ботки многовариантных переменных является формирование серии полноцен​ных одновариантных переменных путем кодирования всех возможных взаимо​действий между вариантами ответа на многовариантный вопрос. Очевидно, что такая методика подходит только для вопросов с небольшим количеством вари​антов ответа.
Перекодирование может осуществляться как внутри одной уже существующей переменной, так и с созданием новой переменной, содержащей перекодированные значения. В последнем случае исходная переменная будет содержать неперекодированные значения, а вновь созданная — перекодированные значения.
Рассмотрим методику перекодирования внутри одной существующей переменной (без создания новой). В качестве примера возьмем случай с многовариантным воп​росом Где Вы обычно покупаете кетчуп?, у которого есть четыре варианта ответа:
1.   q2_l — рынки;
2.   q2_2 — магазины;
3.   q2_3 — палатки;
4.   q2_4 — другое.
При этом выбор респондентом данных пунктов закодирован в базе данных как 1, а отсутствие выбора — значением System Missing (отражается символом,). Про​изведем перекодирование отсутствующих значений System Missing в нули.
Вызов диалогового окна перекодировки внутри одной переменной осуществляет​ся при помощи меню Transform ► Recode ► Into Same Variables. Открывшееся диало​говое окно, как и большинство других окон SPSS, в левой области содержит спи​сок всех доступных переменных, а в правой (имеющей метку Variables) — место для помещения перекодируемых переменных. Необходимо особо подчеркнуть, что за один цикл использования диалогового окна Recode into Same Variables можно пе​рекодировать сколько угодно переменных, но только одними и теми же кодами. Иными словами, нельзя в одной переменной нули заменить на единицы, а в дру​гой — шестерки на строки Шесть. Для этого придется сначала перекодировать пер​вую переменную (нули на единицы), а затем вновь вернуться в диалоговое окно Recode into Same Variables, щелкнуть на кнопке Reset и затем ввести данные для пе​рекодировки другой переменной.
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В нашем случае мы собираемся перекодировать четыре переменные, имеющие одинаковые унарные шкалы, состоящие всего из одного значения 1. Поэтому в описываемом диалоговом окне можно ввести их одновременно в область Variables (рис. 1.20).
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При щелчке на кнопке If вызывается диалоговое окно, по внешнему виду и по функ​циям аналогичное окну Select Cases: If, представленному на рис. 1.16. Из этого окна молено производить перекодирование переменных, помещенных в область Variables, не для всех респондентов, а только для конкретных групп (например, только для мужчин).
В нашем случае мы не будем ставить никаких условий. Щелкните на кнопке Old and New Values, которая открывает диалоговое окно, позволяющее задать перекоди​руемые значения (рис. 1.21). Это окно разделено на две части. В левой можно ука​зать, какие конкретно значения подлежат перекодировке, а в правой — в какие зна​чения они будут перекодированы. Чтобы указать конкретное значение для перекодировки, введите исходное значение в левое поле Value, а конечное значе​ние — в правое поле Value.
Для специальных значений System Missing есть специальный одноименный пара​метр. В нашем примере в левой области диалогового окна выберите пункт System Missing, а в правой — в поле Value введите 0. Далее щелкните на кнопке Add, чтобы добавить указанное сочетание в список перекодировки. (Необходимо особо отме​тить, что значения, не указанные в списке перекодировки, оставляются неизменны.)
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После того как были указаны все необходимые варианты перекодирования (в на​шем случае — только один), следует закрыть окно щелчком на кнопке Continue и запустить процедуру перекодирования кнопкой ОК. В исходной базе данных SPSS все значения System Missing в переменных q2_l - q2_4 будут перекодированы в ну​ли, единицы при этом сохранятся.
1.5.3.2. Перекодирование с образованием новых переменных

Рассмотрим теперь другой случай перекодирования переменных, в результате ко​торого исходная переменная остается неизменной, а перекодированные значения отражаются в новой переменной. Данная процедура осуществляется при помощи меню Transform ► Recode ► Into Different Variables. Диалоговое окно Recode into Different Variables (рис. 1.22) аналогично окну Recode into Same Variables (рис. 1.20), только добавлена дополнительная область Output Variable, предназначенная для указания имени (Name) и метки (Label) вновь создаваемой переменной, которая будет содер​жать перекодированные значения.
В качестве примера мы взяли переменную ql6, содержащую ответы на вопрос от​носительно частоты покупок респондентами плавленого сыра. При этом опрошен​ные должны были выбрать один из восьми вариантов:
1.   каждый день;
2.   3-4 раза в неделю;
3.   1-2 раза в неделю;
4.   1-2 раза в месяц;
5.   реже 1 раза в месяц;
6.   1 раз в полгола:
7.   1 раз в год;

8.   затрудняюсь ответить.

После перекодирования мы должны получить переменную ql6_rec, в которой ин​тервалы 1,2 и 3 будут объединены в группу с кодом 1 (Частые покупатели); интерва​лы 4, 5, 6 и 7 — в группу с кодом 2 (Редкие покупатели); а интервал 8 — в значения System Missing.
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Введите в соответствующие поля название и метку новой переменной. Обратите внимание, что в описываемом диалоговом окне также есть кнопка условного отбо​ра данных If. Откройте диалоговое окно Old and New Values, щелкнув на одноимен​ной кнопке (рис. 1.23).
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Это окно напоминает окно, представленное на рис. 1.21, но в нем также содержатся некоторые дополнительные полезные инструменты. По умолчанию значения исход​ной переменной, не указанные в списке перекодировки, не попадают в новую пере​менную. Изменить данное условие по умолчанию можно при помощи параметра Сору old value(s). Также появилась возможность конвертации числовых значений в стро​ковые (параметр Output variables are strings). При этом изменится тип всей новой пе​ременной; следовательно, все исходные значения должны быть перекодированы как

строковые. Существует и обратная возможность — конвертации строковых значе​ний, похожих на цифры, в числовой вид (например, «5» в 5). Данная возможность реализуется при помощи параметра Convert numeric strings to numbers.

В нашем случае мы при помощи параметра Range перекодировали значения исход​ной переменной — от 1 до 3 — в 1, от 4 до 7 — в 2, а значение 8 — в System Missing. После щелчков в соответствующих диалоговых окнах на кнопах Continue и ОК бу​дет создана новая переменная ql6_rec, содержащая перекодированные по указан​ной схеме значения переменной ql6.

1.5.3.3. Автоматическое перекодирование
Данная процедура предназначена для автоматического кодирования полей анке​ты числовыми значениями типа индекс. В маркетинговых исследованиях эта про​цедура применяется в основном для текстовых полей в тех случаях, когда в анкете есть либо открытые вопросы (являющиеся текстовыми переменными в базе дан​ных), либо варианты ответа Другое с дополнительным полем для указания респон​дентом конкретного варианта.

При выполнении процедуры одинаковые ответы из текстовых полей группируют​ся, и им присваиваются соответствующие коды ответа (например, начиная с 1). Для того чтобы автоматическое перекодирование имело практический смысл, не​обходимо жестко формализовать ответы респондентов в текстовых полях. Если при заполнении анкет допускалась свободная формулировка респондентами сво​их ответов, следует перед вводом анкет в компьютер (или на этапе ввода) пере​формулировать их в соответствии с требованиями формализации. Меньшее количе​ство различных вариантов ответа на открытый вопрос является предпочтительным, так как в дальнейшем при построении распределений большое число категорий трудно читается на графиках и в таблицах. Еще одно существенное требование к ответам респондентов на открытые вопросы — это достаточное количество респон​дентов в каждой группе ответов. Варианты ответов, указанные малым числом оп​рошенных, обычно относятся к варианту Другое.

Диалоговое окно Automatic Recode (рис. 1.24) вызывается при помощи меню Trans​form ► Automatic Recode. В нашем примере мы задавали респондентам вопрос Какие марки глазированных сырков Вы знаете?. После списка основных конкурентов на дан​ном рынке в анкете был вариант ответа Другое (переменная q9_13t), в который за​писывались компании-производители, не вошедшие в данный перечень. Закодиру​ем эти марки числовыми значениями (вместо текстовых полей). Для этого следует перенести из левого списка всех доступных переменных интересующую нас тек​стовую переменную q9_13t в область Variable ► New Name и в соответствующем поле указать новое имя вновь создаваемой числовой переменной q9_13t_n. Затем, что​бы подтвердить преобразование, необходимо щелкнуть на кнопке New Name. В груп​пе переключателей Recode Starting from есть два параметра, позволяющие присво​ить номера вариантам ответа либо по алфавиту, начиная с самого малого значения (Lowest value), либо начиная с конца упорядоченного списка вариантов ответа (Highest value).

После щелчка на кнопке ОК и выполнения указанных преобразований в базе дан​ных будет создана новая числовая переменная (q9_13t_n) с вариантами ответа со​гласно списку перекодировки. Список также выводится SPSS (в окне SPSS Viewer), он показан на рис. 1.25.
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Как видно на рисунке, список разделен на три части: слева находятся значения ис​ходной переменной (q9_13t); в среднем столбце расположены коды, под которыми данные текстовые значения представляются в новой переменной (q9_13t_n); пра​вый столбец дублирует левый. Теперь по вновь созданной числовой переменной мож​но строить графики, а также использовать ее в других статистических процедурах.

1.5.4. Вычисление новых переменных
Вычисление новых переменных — весьма полезная возможность SPSS. При помо​щи данной функции можно производить расчеты по формулам любой сложности, задаваемым пользователем.

1.5.4.1. Вычисление новых переменных

Кроме перекодирования переменных, SPSS позволяет создавать новые перемен​ные, содержащие либо совершенно новые значения, либо значения, вычисленные на основании существующих переменных. Таким образом действует процедура Compute Variable, вызываемая при помощи меню Transform ► Compute (рис. 1.26).

В качестве примера мы рассчитаем годовой объем закупок сметаны на основании имеющихся данных о частоте покупок данного продукта в месяц (интервальная переменная q5) и кратности покупок (интервальная переменная q6).
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В поле Target Variable мы указали имя вновь создаваемой переменной, которая будет содержать вычисленные для каждого респондента годовые объемы покупок сметаны. Далее щелкните на кнопке Type&Label и укажите метку и ее тип (рис. 1.27). В нашем случае в качестве метки в поле Label мы указали Годовой объем закупок сметаны. Новая переменная будет содержать числовые значения, поэтому мы выбрали тип Numeric.
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После определения новой переменной в области Numeric Expression следует указать непосредственно рассчитываемое выражение. В нашем случае мы умножаем час​тоту покупок (q5) на кратность покупок (q6) и затем умножаем на 12 месяцев, что​бы получить объем покупок сметаны в год. После запуска процедуры вычисления новой переменной будет создана новая переменная q100, содержащая годовые объ​емы покупок сметаны каждым респондентом в выборке.

1.5.4.2. Подсчет значений переменных

Еще одной полезной возможностью SPSS, не рассмотренной при описании про​цесса модификации и отбора данных, является подсчет значений переменных (как правило, многовариантных).

Приведем пример. Предположим, у нас есть ответы респондентов на многовари​антный вопрос Из каких источников Вы получаете информацию о рынке сантехники? с пятью вариантами ответа:

1.   q22_l - газеты;

2.   q22_2 — журналы;

3.   q22_3 — выставки;

4.   q22_4 — Интернет;

5.   q22_5 — другие источники.

В результате работы описываемой процедуры мы получим новую переменную q100, в которой для каждого респондента в выборке будет отражаться количество ис​пользуемых источников при поиске информации о рынке сантехники.
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Диалоговое окно Count Occurrences of Values within Cases, позволяющее выполнить поставленную задачу, открывается при помощи меню Transform ► Count (рис. 1.28). В полях Target Variable и Target Label следует указать соответственно имя вновь со​здаваемой переменной (q100) и ее метку (Количество используемых источников). В об​ласть Numeric Variables помещаются интересующие нас переменные q22_l - q22_5, значения которых необходимо подсчитать.
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Диалоговое окно Count Occurrences of Values within Cases так же, как и многие другие окна SPSS, содержит кнопку If, позволяющую осуществить расчеты не для всех респондентов в выборке, а только для отдельных групп.

Щелкните на кнопке Define Values. Открывшееся диалоговое окно (рис. 1.29) пред​назначено для указания конкретных значений рассматриваемых переменных, под​лежащих подсчету. Так как у нас есть пять дихотомических переменных, соответ​ствующих вариантам ответа на многовариантный вопрос, мы указали 1 в качестве объекта подсчетов.
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Запустив процедуру, мы получим новую переменную с результатами расчетов. В дальнейшем мы можем построить по данной переменной линейное распределе​ние (см. раздел 2), чтобы узнать, сколько респондентов используют при поиске сантехники только один, два, три, четыре или пять источников информации.

1.5.5. Коррекция нерепрезентативности выборки

В практике маркетинговых исследований случается, что собранные в ходе опроса данные не соответствуют параметрам генеральной совокупности (то есть являют​ся нерепрезентативными). Такие ситуации возникают, если заложенные перед началом исследования социально-демографические квоты были искажены в ре​зультате нарушения методологии проведения исследования, ошибок в работе ин​тервьюеров или недостаточного контроля проведения полевых работ.

Например, в результате проведения контрольных мероприятий после завершения основных полевых работ были выявлены многочисленные факты некорректного заполнения анкет интервьюерами или даже фальсификация анкет, вследствие чего из итоговой базы данных пришлось удалить некоторую часть анкет. Очевидно, что в этом случае социально-демографические квоты, заложенные в начале исследо​вания и обеспечивающие соответствие параметров выборки параметрам общей генеральной совокупности (репрезентативность), скорее всего, изменятся. Это в свою очередь приведет к тому, что выводы, основанные на результатах проведен​ного опроса, не могут быть отнесены к генеральной совокупности. То есть мы не можем утверждать, что наши выводы действительно отражают мнение реальных потребителей. Исследование фактически теряет свой смысл.

Если полученная выборка является нерепрезентативной, применяется метод кор​рекции параметров выборки путем взвешивания. Приведем пример. Известно, что доля мужчин всего населения России составляет 45,5 %. В результате проведения всероссийского исследования оказалось, что доля мужчин в выборке составляет 72,1 %. Следовательно, полученная выборка является нерепрезентативной. Для устранения ошибки следует провести взвешивание, то есть скорректировать по​лученные значения переменной Пол (dl) на весовой коэффициент. Данный коэф​фициент рассчитывается для каждой социально-демографической группы по сле​дующей формуле:
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 — весовой коэффициент; 
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 — значение исследуемого параметра в генераль​ной совокупности; 
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 — значение исследуемого параметра в выборке.

В нашем случае весовой коэффициент должен рассчитываться для двух социаль​но-демографических групп: мужчин и женщин. (Если у вас большое количество групп, весовой коэффициент следует рассчитывать для каждой группы.) Для муж​чин А будет равна: 45,5 % / 72,1 % ≈0,63. Так как у нас всего две группы, подлежа​щие взвешиванию (мужчины и женщины), то весовой коэффициент для женщин будет рассчитан так: (100 % - 45,5 %) / (100 % - 72,1 %) = 54,5 % / 27,9 « 1,95. (Если у вас большое количество групп, подлежащих взвешиванию, вам нужно знать значения параметров генеральной совокупности для каждой из групп.)

Итак, на первом этапе мы получили весовые коэффициенты, которые помогут нам скорректировать полученную нерепрезентативную выборку. Теперь необходимо создать новую переменную в файле данных SPSS, которая будет содержать для каждого респондента его вес (то есть для мужчин — 0,63, а для женщин — 1,95). Проще всего перекодировать с образованием новой переменной (как было описа​но в разделе 1.5.3.2).

В настоящем пособии мы не описываем важный элемент SPSS — программный синтаксис. Данный элемент является альтернативой использованию диалоговых окон в SPSS. Другими словами, все то, что можно сделать при помощи мыши в диалоговых окнах (и многое другое), можно выполнить посредством программного синтаксиса. В некоторых случаях его использование является предпочтительным. В частности, в нашем примере для создания новой весовой переменной удобнее воспользоваться синтаксисом. Откройте редактор синтаксиса File ► New ► Syntax. На экране появится окно, показанное на рис. 1.30. Введем в нем следующие команды:

if dl=l weight=45.5/72.1 .
if dl=2 weight=54.5/27.9 . 
exe .
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Обратите внимание, что в синтаксисе SPSS символ, отделяющий целую и дроб​ную части числа, — всегда точка, а не запятая. Также следует внимательно отно​ситься к точкам в конце каждой строки. Эти точки дают понять интерпретатору SPSS, что следует выполнить данную команду. Последовательность символов ехе. на третьей строке запускает процедуру синтаксиса. Рекомендуется использовать не приблизительные значения весовых коэффициентов (0,63 и 1,95), а вычисляе​мые выражения (45.5/72.1 и 54.5/27.9); что обеспечивает точность расчетов. Пос​ле того как вы введете указанные строки в редакторе синтаксиса (см. рис. 1.30), выделите их все (это очень важно) и затем нажмите Ctrl+R или на кнопке ► на панели инструментов окна синтаксиса.
В результате работы процедуры синтаксиса будет создана новая переменная weight, содержащая весовые коэффициенты для каждого респондента. Теперь осталось только провести собственно процедуру взвешивания каждого респондента на его весовой коэффициент. В этом вам поможет диалоговое окно Weight Cases (Data ► Weight Cases). В данном диалоговом окне (рис. 1.31) следует выбрать параметр Weight cases by, затем в левом списке всех доступных переменных выбрать весовую переменную (в нашем случае weight) и перенести ее в поле Frequency variable, при щелч​ке на кнопке ОК база данных будет скорректирована на весовые коэффициенты, и репрезентативность данных будет восстановлена. Для отмены взвешивания сле​дует в данном диалоговом окне установить переключатель в положение Do not weight cases.
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Если искажение квот в выборке произошло не только по одной социально-демо​графической переменной, а сразу по нескольким (например, не только по полу, но и по возрасту и уровню образования), следует сначала создать отдельные весовые переменные для каждой из искаженных социально-демографических переменных, а затем создать новую общую весовую переменную, которая будет произведением всех отдельных весовых коэффициентов (то есть для каждого респондента: вес по полу, вес по возрасту, вес по образованию).

При всей кажущейся простоте корректировки репрезентативности при помощи взвешивания следует иметь в виду, что для использования данного метода суще​ствуют серьезные ограничения. Например, часто число респондентов во взвешен​ной базе данных оказывается иным, чем в невзвешенной. Это происходит из-за того, что сумма весовых коэффициентов по всем респондентам не равна общему количеству респондентов. Также нужно весьма осторожно подходить к интерпре​тации статистических тестов по взвешенной базе. Поскольку число респондентов с определенными социально-демографическими характеристиками во взвешенной базе искусственно увеличивается (в нашем случае это доля женщин), рассчитан​ная статистическая значимость является некорректной. Таким образом, взвеши​вание рекомендуется проводить для построения общих (линейных) распределе​ний.

Итак, в главе 1 мы подробно рассмотрели часто используемые в маркетинговых исследованиях методы манипуляции с данными. SPSS содержит массу других до​полнительных возможностей, но в данном пособии мы не стали их приводить, по​скольку на практике эти методы не находят широкого применения.
Глава 2 Описательный анализ
и линейные распределения
Статистический анализ данных — основное предназначение SPSS (в отличие, например, от Microsoft Excel или Microsoft Access). Графическая подсистема данного программного ком​плекса, внешний вид создаваемых отчетов и возможности элек​тронной таблицы оставляют желать лучшего; пользовательский интерфейс рассчитан на лиц, хорошо знакомых со статистикой. Некоторые статистические процедуры (например, множест​венный дисперсионный анализ по методу Фишера) вызыва​ются исключительно при помощи программного синтаксиса (Syntax), работа с которым требует определенных навыков программирования. Но все же, несмотря на эти недостатки, в настоящее время SPSS является одной из лучших программ для проведения профессионального статистического анализа в самых различных областях человеческой деятельности: в биз​несе, психологии, медицине и т. д.
Данный раздел знакомит читателя с основными статистически​ми процедурами и методами статистического моделирования, наиболее часто применяемыми в маркетинговых исследовани​ях. Практически все описываемые статистические функции могут применяться для решения нескольких задач. В этом смысле предлагаемое общепринятое разделение методов ста​тистического анализа на описательный анализ, анализ разли​чий, ассоциативный и классификационный анализ весьма ус​ловно и отражает лишь общие тенденции их использования именно в маркетинговых исследованиях. Прежде чем присту​пить к рассмотрению статистических функций SPSS, сделаем одно существенное отступление необходимое для понимания всех последующих разделов этого пособия.
Одним из центральных понятий в статистике является ста​тистическая значимость (р). Именно на основании статисти​ческой значимости в большинстве процедур SPSS проверяет​ся практическая пригодность построенных моделей. По сути, статистическая значимость — это вероятность наступления ненаступления исследуемого события. Уровень р ≤ 0,05 часто используется в качестве критерия установления статистиче​ской значимости. Он означает, что с вероятностью 95 % мож​но утверждать: исследуемое событие произошло неслучайно, то есть связано с какой-то системой. В табл. 2.1 представлен наиболее распростра​ненный способ интерпретации различных уровней значимости в маркетинговых исследованиях.
  Таблица 2.1. Интерпретация уровней значимости
	Уровень статистической значимости, р
	Статистическая интерпретация
	Обозначение в SPSS

	р < 0,001
	Максимально значимая
	***

	0,001 ≤ р ≤ 0,01
	Очень значимая
	**

	0,01 < р ≤0,05
	Значимая
	*

	0,05 < р ≤ 0,10
	Слабо значимая
	

	р > 0,10
	Незначимая
	


В некоторых случаях (например, t-тесты) статистическая значимость в SPSS мо​жет быть одно- (1-tailed Sig.) или двухсторонней (2-tailed Sig.). Двухсторонняя зна​чимость показывает, отличается ли значительно среднее значение первой иссле​дуемой переменной от среднего значения второй — без указания направления этого различия, положительного или отрицательного. Односторонняя значимость по​казывает только направление, в котором второе исследуемое среднее отличается от первого. Второй тип значимости (односторонняя) при анализе данных марке​тинговых исследований используется редко, и именно двухсторонняя значимость выводится SPSS по умолчанию. Таким образом, на практике нет необходимости обращать внимание на тип значимости, выводимой SPSS: она всегда будет пока​зывать статистическую значимость исследуемого события1.
Целью описательного анализа является систематизация имеющихся данных. В рам​ках данной задачи происходит построение линейных распределений, а также ха​рактеристика переменных в различных статистических аспектах: расчет среднего, медианы, моды и т. п. Линейные (общие) распределения позволяют подсчитать количество респондентов, указавших тот или иной вариант ответа на рассматри​ваемый вопрос.
Построение линейных распределений обычно является первым шагом в статисти​ческом анализе данных. При помощи линейных распределений становится воз​можным систематизировать ответы респондентов. В табл. 2.2 представлены основ​ные характеристики переменных, участвующих в анализе.
Таблица 2.2. Основные характеристики переменных, участвующих в линейных распределениях
	Линейные распределения
	
	

	Зависимые переменные
	
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	-
	-
	Одна
	Любой


2.1. Линейные распределения для одновариантных вопросов

Одновариантные вопросы являются основным ресурсом анализа при помощи SPSS. Практически все функции, реализованные в данном программном пакете, пред​назначены для работы только с одновариантными переменными. Анализ многова​риантных переменных производится методом выделения каждого варианта отве​та в отдельную одновариантную переменную и последующей работы уже с набором одновариантных переменных. Существуют табличные и графические способы по​строения линейных распределений по одновариантным вопросам. Ниже представ​лен способ, наиболее распространенный в маркетинговых исследованиях. Рассмотрим линейное распределение респондентов по возрастному признаку. Для этого предположим, что у нас есть файл данных, содержащий одновариантную переменную q4 (Возраст), имеющую порядковую шкалу, с четырьмя возможными вариантами ответа:
1.   от 16 до 18 лет;
2.   от 19 до 35 лет;
3.   от 36 до 60 лет;
4.   старше 60 лет.
Вызов диалогового окна для построения линейных распределений (также называе​мых частотами) осуществляется при помощи меню Analyze ► Descriptive Statis​tics ► Frequencies (рис. 2.1). В открывшемся окне в левом списке содержатся все доступные переменные, по которым можно построить линейные распределения. При помощи мыши перетащите нужные одновариантные переменные в правый список (в нашем случае — q4). При этом для анализа можно указать сразу несколь​ко переменных.
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В диалоговом окне Statistics, вызываемом при помощи одноименной кнопки, мож​но указать, какие описательные статистики, кроме относительных и абсолютных значений, необходимо рассчитать (рис. 2.2). Например, рассчитаем моду (наибо​лее часто встречающееся значение), выбрав соответствующий параметр. Кроме этой статистики, SPSS позволяет рассчитать другие полезные величины:
■   среднее арифметическое для интервальных переменных (Mean);
■   минимальное и максимальное значения (Minimum и Maximum), — а также разбить значения переменной на квартили или другие процентили (об​ласть PercentiLe Values) и т. д.
Однако большинство представленных в этом диалоговом окне статистик подхо​дит только для переменных, имеющих интервальный тип шкалы. Закрыв диалого​вое окно Statistics посредством щелчка на кнопке Continue, вы вновь попадете в ос-, новное окно Frequencies.
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Необходимо сказать несколько слов относительно основных описательных ста​тистик, показанных на рис. 2.2. Пожалуй, наиболее популярными характерис​тиками, используемыми для описания переменных, являются показатели груп​пы Central Tendency (центральная тенденция): среднее арифметическое (Mean); медиана, или половина значений отрезка (Median); мода, или наиболее часто встречающееся значение (Mode); а также сумма (Sum). Имейте в виду, что дан​ные показатели применяются неодинаково к переменным с различным типом шкалы (табл. 2.3).
Таблица 2.3. Наиболее релевантные показатели центральной тенденции для переменных с различным типом шкалы
	Тип шкалы
	Наиболее релевантная характеристика
	Другие релевантные характеристики

	Интервальная
	Среднее арифметическое
	Средневзвешенное, мода

	Порядковая
	Средневзвешенное
	Мода

	Номинальная
	Мода
	-


Из представленной таблицы видно, что наиболее релевантной описательной ста​тистикой, характеризующей переменные с интервальной шкалой, является сред​нее арифметическое (Mean). Для переменных с порядковой шкалой данный пока​затель неприменим, так как он рассчитывается исходя из значений переменной (кодов вариантов ответа), а не самих значений интервалов.
Например, если рассчитать простое среднее по переменной Возраст (в которой воз​растные группы закодированы цифрами от 1 до 4), получится 250,5 (см. рис. 2.6). Данное значение не несет в себе практически значимой нагрузки. Если же мы вме​сто этого рассчитаем средневзвешенное значение данной переменной по нижепри​веденной формуле, мы получим реальный средний возраст респондентов: 43 года (43 - (408 × 48 + 321 × 27 + 207 ×68 + 66 × 17) / (408 + 321 + 207 + 66)).
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 — средневзвешенное значение; n — количество интервалов (вариантов от​вета) в порядковой переменной; 
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 — частота появления i-го варианта ответа; 
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s

 — среднее арифметическое значение i-ro интервала.
Средняя тенденция переменных с номинальной шкалой не может быть оценена никак, кроме моды, — то есть для таких переменных можно определить только наи​более многочисленную группу. Например, по переменной Пол можно сказать, что в данном случае мужчины составляют три четверти всей выборочной совокупно​сти респондентов.
В табл. 2.2 также видно, что интервальные переменные — наиболее гибкие относи​тельно применения показателей центральной тенденции. Для них можно рассчи​тать все три рассматриваемые статистики: среднее арифметическое, средневзве​шенное и моду. Порядковые переменные находятся на втором месте: с ними могут использоваться только средневзвешенное и мода. И наконец, номинальные пере​менные являются наименее гибкими: к ним может эффективно применяться толь​ко мода.
Теперь мы вновь возвращаемся к диалоговому окну Frequencies. Кнопка Charts вы​зывает одноименное диалоговое окно, которое позволяет помимо таблиц вывести диаграммы по выбранным переменным (рис. 2.3). По умолчанию SPSS не выводит диаграмм. Давайте построим круговую диаграмму (сектограмму), выбрав параметр Pie charts и указав в области Chart Values на необходимость отобразить на диаграмме не абсолютные (установлено по умолчанию), а относительные значения (Percen​tages). Выполнив это, закройте диалоговое окно Charts.
С помощью кнопки Format в главном диалоговом окне линейных распределений Frequencies можно указать, каким способом следует сортировать результаты в час​тотных таблицах (рис. 2.4). Это можно сделать, выбрав соответствующий пара​метр в области Order by. При этом возможной альтернативой будет сортировка ко​дов вариантов ответа (в нашем случае — кодировок возрастных групп):
■   по возрастанию: от 1 (16-18 лет) до 4 (старше 60 лет);
■   по убыванию: от 4 до 1;
■ по количеству респондентов, выбравших каждый из рассматриваемых вариан​тов ответа (в нашем случае — по численности четырех рассматриваемых возра​стных групп).
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Для иллюстрации нашего примера выберем сортировку по численности возраст​ных групп по убыванию Descending counts и закроем диалоговое окно Format, щелк​нув на кнопке Continue.
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После щелчка на кнопке ОК в главном диалоговом окне Frequencies откроется окно SPSS Viewer, в котором будут представлены частотные таблицы, а также другая ин​формация, указанная нами на подготовительном этапе.
В таблице Statistics (рис. 2.5) отражаются общие параметры линейного распреде​ления. Здесь представлены:
■   количество респондентов, ответивших на вопрос Возраст (строка Valid), — 1002 че​ловека;
■   количество анкет, в которых на данный вопрос не было получено ответа (стро​ка Missing), — 1 человек;
■   мода (строка Mode), то есть наиболее многочисленная возрастная группа рес​пондентов (в нашем случае вариант 3: лица от 36 до 60 лет).
Следующая таблица, озаглавленная меткой анализируемой переменной (Возраст), отражает количество респондентов, которые указали тот или иной вариант ответа (столбец 2, Frequency), отсортированный по убыванию (рис. 2.6). Также в этой таб​лице представлен процент лиц, указавших данные варианты ответа от общего чис​ла респондентов (столбец 3, Percent) и от числа ответивших на анализируемый во​прос Возраст (столбец 4, Valid Percent). Последний столбец 5 (Cumulative Percent)
отражает кумулятивные проценты (то есть вклад каждого варианта ответа в об​щую сумму). Так же как и в таблице Statistics, здесь указано общее количество от​ветивших (строка Valid Total) и не ответивших (строка Missing System) на данный вопрос, а также общее количество респондентов (строка Total, в нашем случае 1003).
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	Frequency
	Percent
	Valid Percent
	Cumulative
Percent

	Valid
	36-60 лет
	408
	40,7
	40,7
	40,7

	
	19-35 лет
	321
	32,0
	32,0
	72,8

	
	Старше 60 лет
	207
	20,6
	20,7
	93,4

	
	16-18 лет
	66
	6,6
	6,6
	100,0

	
	Total
	1002
	99,9
	100,0
	

	Missing
	System
	1
	,1
	
	

	Total
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	1003
	100,0
	
	


На подготовительном этапе анализа мы указали на необходимость построения сектограммы по рассматриваемой переменной. Она представлена в результатах ли​нейных распределений после таблицы Возраст (рис. 2.7). Несмотря на то, что мы прямо указали SPSS вывести на диаграмме проценты каждой возрастной группы, программа проигнорировала это указание: в построенной сектограмме указаны только названия категорий.
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К сожалению, графическая подсистема SPSS весьма слаба и не выдерживает срав​нения со средствами Microsoft Office. Поэтому рекомендуем пользоваться ею, только когда это действительно оправдано (например, в дисперсионном анализе). Во всех остальных случаях предпочтительнее копировать выводимые таблицы в Mi​crosoft Excel и уже там строить по полученным данным диаграммы.
В рассматриваемом случае, чтобы исправить ситуацию и вывести проценты, дваж​ды щелкните мышью по диаграмме Возраст в окне SPSS Viewer. Откроется специаль​ное окно SPSS Chart Editor, предназначенное для редактирования простых диаграмм (simple charts)1. В нем выберите меню Chart ► Options. Откроется диалоговое окно Pie Options, в котором следует указать параметр Percents в области Labels (рис. 2.8). Далее щелкните на кнопке ОК и закройте окно SPSS Chart Editor. В окне SPSS Viewer к построенной диаграмме будут добавлены проценты каждой возрастной группы.
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Существует еще один способ построения диаграмм по линейным распределениям. Он применяется в случае, если вы уже построили частотную таблицу, но не указа​ли на подготовительном этапе на необходимость вывести диаграмму. В такой си​туации следует дважды щелкнуть мышью на данной таблице в окне SPSS Viewer, a затем выделить тот ее столбец, по которому необходимо построить диаграмму. Например, выделите столбец Valid Percent (значения во всех четырех строках, обо​значающих варианты ответа на вопрос Возраст). Затем щелкните правой кнопкой мыши и в открывшемся контекстном меню выберите пункт Create Graph ► Pie для построения сектограммы по долям каждой возрастной группы. В результате после частотной таблицы будет выведена соответствующая круговая диаграмма.
В разделе 1.2 было показано, как рассчитывается статистическая ошибка для ве​личин, выраженных в процентах. Теперь, после того как мы изучили линейные распределения и основные описательные статистики, можно рассмотреть форму​лу для расчета статистической ошибки значений, выраженных в абсолютных ве​личинах (например, средние значения). Напомним, что статистическая ошибка для данной категории величин рассчитывается для каждой из них в отдельности.
В качестве примера рассмотрим линейное распределение оценок на вопрос Оцени​те, пожалуйста, качество сухих строительных смесей марки X по пятибалльной шкале: от 1 (очень плохо) до 5 (отлично). При этом в диалоговом окне Statistics (см. рис. 2.2) не​обходимо выбрать параметры: Mean (среднее арифметическое) и Variance (диспер​сия). После окончания расчетов в окне SPSS Viewer будет выведена следующая таблица (рис. 2.9).
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Формула для расчета статистической ошибки величин, выраженных в абсолютных показателях, имеет следующий вид:
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где z — статистическая константа для выбранного доверительного уровня (см. табл. 1.1); 
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— дисперсия (строка Variance в таблице Statistics на рис. 2.9); n — раз​мер выборки для данного вопроса (строка Valid в таблице Statistics на рис. 2.9).
Таким образом, для нашего случая и стандартного для маркетинговых иссле​дований доверительного уровня в 95 % статистическая ошибка выборки будет равна:
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то есть средняя оценка качества ССС варьируется в пределах от 3,87 балла (3,89 --0,02) до 3,91 (3,89+ 0,02).
2.2. Линейные распределения
для многовариантных вопросов

Как было сказано выше (см. раздел 1.4.2), в SPSS все многовариантные вопросы рассматриваются как совокупность одновариантных переменных, обозначающий варианты ответа. Иными словами, многовариантный вопрос, содержащий три варианта ответа, в SPSS представляется как три дихотомические переменные, принимающие два значения-флага: отмечено/не отмечено.
Наиболее распространены два формата представления многовариантных переменных. В первом случае переменные, представляющие варианты ответа многовариантной переменной, принимают значение 1 (выбрано) или 0 (не выбрано); во втором случае — 1 (выбрано) или System Missing (не выбрано).
Как показывает опыт, первый способ предпочтительнее. Второй способ использу​ется в специфических случаях (например, если необходимо использовать SPSS в качестве клиента автоматизации построения распределений при помощи программ на Sax Basic). Чтобы указать SPSS, какие переменные являются вариантами отве​та для многовариантной переменной, наиболее часто используется описываемый далее способ, при котором после формирования многовариантной переменной ее можно использовать для построения линейных и перекрестных распределений.
Для иллюстрации мы построим линейное распределение по многовариантному вопросу Где Вы покупаете сметану? (q7) с вариантами ответа:
1.   продмаг (q7_l);
2.   рынок (q7_2);
3.   супермаркет (q7_3);
4.   палатка (q7_4);
5.  универсам (q7_5).
Чтобы построить распределения по многовариантным вопросам, прежде всего не​обходимо сформировать многовариантную переменную. Это делается при помо​щи меню Analyze ► Multiple Response ► Define Sets. Открывшееся диалоговое окно по​зволяет сформировать многовариантные переменные (правый список) из общего списка доступных переменных (левый список), как показано на рис. 2.10.
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Для создания многовариантной переменной, обозначающей типы торговых точек, сначала выберите в левом списке все дихотомические переменные, кодирующие мно​жественные варианты ответов (q7_l — q7_5), и переместите их в правый список. Далее в области Variables Are Coded As оставьте выбранный по умолчанию параметр Dichotomies (он указывает, что переменные, обозначающие варианты ответа в многовариантном вопросе, являются дихотомическими) и в соответствующее поле введите цифру, ука​зывающую, что вариант ответа выбран (в нашем случае 1). В поле Name введите имя для вновь создаваемой многовариантной переменной. Назовите ее q7 и присвойте метку Торговые точки (в поле Label). Затем, чтобы создать новую переменную, щелкните на кнопке Add. Обратите внимание, что к именам создаваемых многовариантных пере​менных добавляется префикс $ (этим они отличаются от обычных одновариантных переменных). Теперь вы можете создать еще одну или несколько многовариантных переменных, добавляя их в соответствующий список при помощи кнопки Add. Так как в нашем случае мы собираемся анализировать только один многовариантный вопрос, завершим процесс создания новых переменных щелчком на кнопке Close.
Необходимо отметить, что SPSS не сохраняет многовариантные переменные при закрытии рабочего файла с данными. Поэтому каждый раз, когда нужно проана​лизировать многовариантные вопросы, вам придется снова создавать соответству​ющие переменные.
Мы создали многовариантную переменную для анализа и теперь можем присту​пать к построению линейных распределений. Для этого воспользуемся меню Ana​lyze ► Multiple Response ► Frequencies. Следует отметить, что данное меню позволяет строить только таблицы линейных распределений (и нет возможности вывести диаграммы). В открывшемся диалоговом окне в левом списке всех доступных мно​говариантных переменных (в нашем случае там только одна переменная Торговые точки) выберите интересующие переменные для анализа и перенесите их в правую область Table(s) for (рис. 2.11). Для того чтобы запустить процедуру построения линейных распределений, щелкните на кнопке ОК.
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В окне SPSS Viewer будет создана таблица с линейными распределениями (частота​ми) по выбранным переменным (рис. 2.12). Столбец Count содержит количество респондентов, указавших каждый из возможных вариантов ответа на многовари​антный вопрос. Столбец Pet of Cases показывает доли каждого варианта ответа от общего числа респондентов, ответивших на многовариантный вопрос (гисто​грамма). Данное число показано под таблицей (999 valid cases, то есть линейное распределение построено по 999 респондентам) и рассчитано как количество анкет, в которых выбран хотя бы один из возможных вариантов ответа на дан​ный многовариантный вопрос. В той же строке (под таблицей) указано количество анкет, в которых не выбрано ни одного варианта ответа (4 missing cases, то есть четыре респондента не указали, в каких типах торговых точек они обычно при​обретают сметану). Столбец Pet of Responses показывает доли каждого варианта ответа от общего числа ответов; их сумма всегда равна 100 % (сектограмма). Суммы по каждому столбцу анализируемой таблицы представлены в строке Total responses.
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	Pet   of
	Pet  of

	Dichotomy  label
	Name
	Count
	Responses
	Cases

	Продмаг
	Q7_l
	518
	39,4
	SI,9

	Рынок
	Q7_2
	306
	23,3
	30,6

	Супермаркет
	Q7_3
	258
	19,6
	25,8

	Палатка
	Q7_4
	166
	12,6
	16,6

	Универсам
	Q7_5
	66
	5,0
	6,6

	
	
	------
	-----------
	-----------

	
	Total  responses
	314
	100,0
	131,5

	4 missing cases;     999 valid cases
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В связи с тем, что линейные распределения по многовариантным вопросам в SPSS выводятся в текстовом формате (Plain text) и не могут быть перенесены в Microsoft Excel для построения диаграмм, далее мы рассмотрим, как можно строить диа​граммы по многовариантным вопросам непосредственно в SPSS.
Если вам необходимо построить гистограмму или сектограмму по многовариантному вопросу, меню Define Sets не используется. Вместо него применяется меню Graphs ► Bar (для гистограмм) или Graphs ► Pie (для сектограмм). За один раз можно построить ги​стограмму или сектограмму только по одной многовариантной переменной.
Итак, давайте построим гистограмму по многовариантной переменной Торговые точки (параллельно мы построим и сектограмму). Для этого воспользуемся меню Graphs ► Bar. В открывшемся диалоговом окне (рис. 2.13) необходимо указать тип гистограммы Simple (если мы строим сектограмму, данный пункт отсутствует; см. рис. 2.14), а в группе Data in Chart Are выбрать пункт Summaries of separate variables. Затем необходимо щелк​нуть на кнопке Define, чтобы перейти к следующему шагу построения диаграммы.
[image: image144.jpg]Symmetric Measures

Foymp.

Morte Caro Sig

5% Confidence Irterval

Touer Bound | Upper Bound

flox Valse | i, Bl | ppprox. + |spprox. Sig. | Sig.

Wyxam  Ordinal by Ondial Gamima 060 A A X T Bz 6
Nof \aid Cases E

e Ordinal by Ordinal Gamina T T e o0 015 o o7
Nof Vaid Cases 378

3. ot assuming the nul hypathesis
b. Using the asymptotic standard eror assuming the nul hypothesis.

. Based on 10000 sampled tables with starting seed 2000000,




[image: image145.jpg]



В открывшемся диалоговом окне Summaries of Separate Variables (оно одинаково и для гистограмм и для сектограмм) из левого списка всех доступных переменных, име​ющихся в файле данных, переместите в правый список все варианты ответа на ка​кой-либо один многовариантный вопрос (в нашем случае это переменные q7_l — q7_5). как видно на рис. 2.15.
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Щелкните на кнопке Change Summary и в открывшемся диалоговом окне (рис. 2.16) выберите пункт Sum of values. Данный параметр указывает SPSS на необходимость построить гистограмму по суммарному количеству выбранных вариантов ответа в многовариантном вопросе. После этого закройте данное окно, щелкнув на кнопке Continue.
Теперь щелкните на кнопке Options и в открывшемся окне выберите пункт Exclude cases variable by variable; щелкните на Continue (рис. 2.17).
Щелкните на кнопке ОК в главном диалоговом окне Summaries of Separate Variables, и программа выведет результаты построения гистограммы в окне SPSS Viewer (рис. 2.18).
Как видите, столбцы построенной гистограммы отражают абсолютное количество рес​пондентов, указавших ту или иную торговую точку. К сожалению, SPSS не позволяет строить гистограмму по многовариантным вопросам, отражающую проценты каждого варианта ответа от общего числа респондентов (или от общего числа ответов). Чтобы отобразить на нашей гистограмме точные количества респондентов, указавших ту или иную торговую точку, следует воспользоваться схемой действий, представленной выше.
Мы рассмотрели наиболее популярный метод статистического анализа данных в мар​кетинговых исследованиях — построение линейных распределений. Как показывает практика, именно на этом этапе в некоторых отечественных компаниях заканчивает​ся работа с SPSS (иногда строятся также перекрестные распределения), в то время как описательный анализ является лишь начальным этапом анализа данных.
Глава 3 Анализ различий
Цель анализа различий — выявление групп респондентов, статистически значимо различающихся между собой. Все ста​тистические процедуры, относящиеся к группе процедур, ко​торые позволяют выявить такие различия (t-тесты и диспер​сионный анализ), сравнивают респондентов на основании средних значений переменных. Иными словами, провести раз​личие можно на основании двух или более числовых перемен​ных.
В практике маркетинговых исследований достаточно часто встречаются ситуации, когда в ходе предварительного анали​за (на основании опыта исследователя, когнитивного или ста​тистического анализа) появляется гипотеза о разделении всей выборочной совокупности на определенные группы на осно​вании одного или нескольких признаков (например, при сег​ментировании потребителей продукта или при построении разрезов). Линейное распределение может показывать, что дан​ные группы респондентов действительно различаются (напри​мер, мужчин в выборке в два раза больше, чем женщин). Од​нако визуального различия между категориями недостаточно для того, чтобы с уверенностью констатировать наличие ста​тистически значимого различия. На установление статистиче​ской значимости различий между целевыми группами респон​дентов и направлены процедуры, объединенные под названием «Анализ различий».
Существует два основных метода определения различий меж​ду группами: t-тесты и дисперсионный анализ. Первый ме​тод прост в использовании, и поэтому он применяется часто (в том числе и в маркетинговых исследованиях). Однако в связи с ограничением на количество тестируемых групп (между которыми устанавливается различие) t-тесты не мо​гут применяться для решения всех задач, возникающих при проведении маркетингового анализа. Для преодоления дан​ного ограничения используется дисперсионный анализ, яв​ляющийся универсальной методикой для определения ста​тистически значимых различий между любым числом групп респондентов.
3.1. Т-тесты
Т-тесты предназначены для установления различий между двумя группами рес​пондентов. При этом сравниваются только два средних значения. SPSS предлага​ет три основных типа t-тестов:
■   для двух независимых выборок;
■   для двух зависимых выборок;
■   для одной выборки.
В последующих разделах мы подробно расскажем о каждом из них, но сначала при​ведем основные характеристики переменных, участвующих в t-тестах (табл. 3.1).
	Т-тесты для независимых  выборок

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	Одна
	Дихотомическая интервальная
	Любое
	Интервальная

	Т-тесты для зависимых выборок

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	-
	-
	Две
	Интервальная

	Т-тесты для одной выборки

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	-
	-
	Любое
	Интервальная


Обратите внимание: зависимая переменная есть только для t-тестов независимых выборок. Для других видов t-тестов (зависимых выборок и одной выборки) зави​симая переменная отсутствует. Это связано с тем, что в последнем случае анализу подвергается фактически одна и та же выборка респондентов. В качестве тестиру​емых независимых переменных во всех случаях используются только переменные с интервальной шкалой. Порядковые переменные могут использоваться только после преобразования их к интервальному виду (см. раздел 2.1).
3.1.1. Т-тесты для независимых выборок

В случае t-тестов для независимых выборок под независимыми выборками пони​маются бинарные категории (то есть варианты ответа) какой-либо переменной. Например, мужчины и женщины (вопрос Пол респондента), покупатели и не поку​патели какого-либо продукта (вопрос Покупаете ли Вы данный продукт?) и т. д. То есть когда есть два уровня группирующей (зависимой) переменной и несколько независимых переменных, на основании которых и будет выполняться различие между группами зависимой переменной.
Рассмотрим методику проведения t-тестов для независимых выборок на следую​щем примере. Предположим, что мы оцениваем различия в частоте посещения иг​ровых клубов между посетителями заведений марки X и других марок. Откройте диалоговое окно Independent-Samples T Test при помощи меню Analyze ► Compare Means ► Independent-Samples T Test (рис. 3.1). В область Test Variable(s) поместите переменные, являющиеся критерием для установления различий (в нашем случае это ql8_i Частота посещения). Затем в поле Grouping Variable переместите переменную, которая будет яв​ляться группирующей (зависимой). В нашем случае это переменная ql_8, кодирую​щая категории респондентов, посещающих/не посещающих игровые залы марки X.
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Так как данная переменная является вариантом ответа на многовариантный во​прос Какие игровые клубы Вы посещаете?, она может принимать два значения:
■   1 — посещают клубы X;
■   0 — не посещают клубы X.
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Эти два значения необходимо указать в специальном диалоговом окне Define Groups, вызываемом одноименной кнопкой (рис. 3.2). Обратите внимание, что если вмес​то дихотомии мы имеем группирующую переменную с интервальной шкалой, это диалоговое окно позволяет установить точку отсечения Cut point, которая буде! разделять все возможные значения данной переменной на две группы.
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С помощью кнопки Options в главном диалоговом окне рассматриваемой процедуры можно установить доверительный уровень для результатов расчета t-теста (рис. 3.3). По умолчанию установлен уровень доверия 95 %. Как было показано выше в раз​деле 1.2, этот уровень точности (достоверности) результатов является достаточ​ным при проведении статистического анализа в маркетинговых исследованиях.
[image: image160.jpg]



[image: image161.jpg]® Buaeo mporpar:
® Miecea [a4]





После завершения процедуры расчета t-теста в окне SPSS Viewer будут отражены результаты (рис. 3.4). В первой таблице Group Statistics вы видите средние значе​ния тестируемой переменной (частота посещения клубов) для обеих групп зави​симой переменной X. Как следует из рисунка, для респондентов, посещающих иг​ровые залы марки X, средняя частота посещения составляет 11,9 раз в месяц. Для респондентов, не посещающих данные залы, это значение равно 11,5. Вторая таб​лица Independent Samples Test позволяет установить статистическое различие меж​ду данными значениями.
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2. Predictors: (Constant), Mpecca, Pabora GopmposogHukos, LisHa,
KomdoprabensHocte cancHa, CnupTHble HanuTku, MuTalke B0 Bpewma nosera,

Topasible HaBopk!, BHASONEOrpaKHL, AYANCDOrpaMIMEI

b. Predictors: (Constant), Mpecca, PaGiota Goprnposogmkos, KomdioprabensHocTs
canoHa, CnupTHsIe HanuTk, MuTanue Bo BpemA Noneta, JopoxHuie Habope,
Buaeonporpammbl, AyAHONPOrpakIMb!

c. Predictors: (Constant), Mpecca, Paora Goprnposoaikos, KomiopraBensHocTs
canoHa, CnupTHble HanuTkw, MuTakive Bo BpemA nonera, [opoxHsie Habope!,

Buaeonporpammel

d. Dependent Variable: OBuja ougkka cepeuca Ha Gopry

2. Selecting only cases for which Knacc noneta = 3KOHOMWNECKUN Knace



T-Test
	
	X
	N
	Mean
	Std. Deviation
	Std. Emor Mean

	Частота посещения
	1
	49
	11,9288
	10,43081
	1,49140

	
	0
	526
	11,5048
	9,98682
	,43546
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	Levene’s Test for Equality of Variances
	t-test for Equality of Means

	
	F
	Sug.
	t
	df
	Sig. (2-talid)
	Mean Difference
	Std. Emor Difference
	

	
	
	
	
	
	
	
	
	Lower
	Upper

	Частота посеще-ния
	Equal variances assumed
	,382
	,547
	,283
	573
	,777
	,4238
	1,49745
	-2,61734
	3,36497

	
	Equal variances not assumed
	
	
	,273
	56,495
	,786
	,4230
	1,55367
	-2,68795
	3,51559
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Анализ этой таблицы начинается с определения значимости теста Ливина (Levene). Данный тест служит для тестирования гипотезы о равенстве дисперсий в тестиру​емых переменных. Если значение в столбце Sig. столбца Levene's Test for Equality of Variances показывает статистическую незначимость теста (в нашем случае — 0,547), то различие между двумя анализируемыми средними определяется из строки Equal variances assumed. В противном случае, если тест Levene статистически значим, раз​личие между двумя средними определяется из строки Equal variances not assumed.
Поскольку в нашем примере тест Ливина является статистически незначимым, то определить значимость различия между двумя тестируемыми группами можно при помощи значения, находящегося на пересечении первой строки и столбца Sig. (2-tailed). Значение 0,777 говорит о том, что различие в частоте посещения игро​вых залов респондентами, посещающими и не посещающими клубы марки X, яв​ляется статистически незначимым.
3.1.2. Т-тесты для спаренных выборок
Т-тесты для спаренных выборок применяются в случае, когда на различные во​просы отвечает одна и та же группа респондентов.
Например, пассажиры оценивают уровень и качество питания авиакомпании X и авиакомпании Y. Чтобы определить, является ли статистически значимой разница в оценке этих двух авиакомпаний, следует воспользоваться диалого​вым окном Paired-Samples T Test, вызываемым при помощи меню Analyze ► Compare Means ► Paired-Samples T Test (рис. 3.5). В левом списке содержатся все доступ​ные переменные из базы данных. Выберите из списка две переменные для тес​тирования. В нашем случае это qll (Питание в авиакомпании X) и q26 (Питание в авиакомпании Y). По мере того как вы будете выбирать переменные, они будут последовательно отображаться в области Current Selections. Указав две перемен​ные для анализа, щелкните на кнопке с символом ► , чтобы перенести перемен​ные в область Paired Variables. Кнопка Options позволяет установить уровень до​верия для производимых расчетов.
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После щелчка на кнопке ОК будут произведены расчеты t-теста для анализиру​емых переменных; результаты теста будут отражены в окне SPSS Viewer (рис. 3.6). Как видно на рисунке, SPSS выводит на экран три таблицы. Рассмотрим их по порядку.
Итак, в первой таблице, Paired Samples Statistics, вы видите рассчитанные средние значения для обеих тестируемых переменных. Так, в нашем случае респонденты оценили питание в авиакомпании Y в среднем на 0,4 балла выше, чем в авиакомпа​нии X.
В следующей таблице Paired Samples Correlations представлен коэффициент корре​ляции (Пирсона) между оценками двух анализируемых переменных. Подробно корреляционный анализ рассматривается в разделе 4.2. Здесь стоит сказать лишь, что чем ближе значение коэффициента к 1, тем сильнее линейная связь между пе​ременными (при условии статистической значимости коэффициента). То есть чем выше уровень оценки по первой переменной, тем выше оценка второй — и наобо​рот. В нашем случае налицо отсутствие линейной связи между оценками питания в авиакомпании X и Y (коэффициент корреляции = 0,027 при статистической зна​чимости 0,463).
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T-Test
	
	Mean
	N
	Std. Devition
	Std. Emor Mean

	Pair
	Питание в X
	3,9
	731
	,974
	,036

	1
	Питание в Y
	4,3
	731
	,787
	,029
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	N
	Correlation
	Sig.

	Pair
	Питание в X &
	731
	,027
	,463

	1
	Питание в Y
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	Paired Diffirences
	t
	df
	Sig. (2-tailed)

	
	Mean
	Std. Devition
	Std. Emor Mean
	95% Confidence interval of the Difference
	
	
	

	
	
	
	
	Lower
	Upper
	
	
	

	Pair
	Питание в X &
	-,4
	1,236
	,046
	-,44
	-,26
	-7,692
	730
	,000

	1
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Питание в Y
	
	
	
	
	
	
	
	


Наконец, третья таблица, Paired Samples Test, позволяет сделать вывод о наличии/ отсутствии статистически значимого различия между тестируемыми переменны​ми, что следует из значения в столбце Sig. (2-tailed). В нашем случае различие меж​ду оценками питания в авиакомпаниях X и Y, равное 0,4 балла, является статистиче​ски значимым (<0,001).
3.1.3. Т-тесты для одной выборки
В результате t-теста для одной выборки можно выяснить, отличается ли значи​тельно реальное среднее значение какой-либо переменной от стандарта. В марке​тинговых исследованиях при помощи данного теста определяют, отличается ли среднее значение какого-либо параметра для определенной целевой группы респон​дентов от среднего значения по всей выборке.
Например, питание на борту самолетов авиакомпании X (переменная qll) всеми респондентами оценено в среднем на 4,0 балла. Вместе с тем пассажиры первого класса оценили питание несколько выше: в среднем на 4,1 балла. Возникает во​прос, является ли выявленное различие статистически значимым. То есть отлича​ются ли пассажиры первого класса от всех респондентов на основании уровня оцен​ки питания на борту? Выяснить это нам поможет t-тест для одной выборки. Ниже описан механизм его проведения.
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Для проведения t-теста мы должны отобрать только тех респондентов, которые летают первым классом. (Как это сделать, см. в разделе 1.5.1.1.) После этого следу​ет воспользоваться меню Analyze ► Compare Means ► One-Sample T Test, чтобы открыть диалоговое окно One-Sample T Test (рис. 3.7). Далее перенесите из левого списка всех доступных переменных в область Test Variable(s) интересующую нас перемен​ную qll (Питание). В поле Test Value укажите стандартное значение, с которым мы будем сравнивать среднее тестируемой переменной. В нашем случае это 4,0. Кнопка Options позволяет указать доверительный уровень, для которого устанавливается различие.
После того как SPSS завершит расчет t-теста, в окне SPSS Viewer появятся две таблицы с результатами (рис. 3.8).
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В первой таблице, One-Sample Statistics, отражены расчеты среднего значения ис​следуемой переменной (столбец Mean). В нашем случае данное значение отражает среднюю оценку питания пассажиров первого класса (4,1 балла). Вторая таблица, One-Sample Test, позволяет сделать вывод о статистической значимости/незначи​мости тестируемого различия. Как следует из значения столбца Sig. (2-tailed), раз​личие в оценках пассажиров первого класса и всей выборочной совокупности рес​пондентов является статистически незначимым (0,149). Разница между реальным и тестируемым значениями (в нашем случае — 0,1 балла) отражается в столбце Mean Difference.
3.2. Дисперсионный анализ
Иногда при анализе данных маркетинговых исследований достаточно сравнить только две группы респондентов, то есть установить различия между двумя кате​гориями опрошенных. Однако часто у исследователей возникает необходимость проанализировать не две, а три или более категории респондентов. В этом случае
следует прибегнуть к использованию дисперсионного анализа, который позволяет анализировать одновременно любое число групп.
Различают одномерный (Analysis of variance, ANOVA) и многомерный (Multiple analysis of variance, MANOVA) дисперсионный анализ. Для одномерного диспер​сионного анализа существует только одна зависимая переменная; для многомерно​го — несколько. Также в этом разделе мы рассмотрим одномерный дисперсион​ный анализ с повторными измерениями (ANOVARM)1.
В табл. 3.2 приведены основные характеристики переменных, участвующих в раз​личных видах дисперсионного анализа.
Таблица 3.2. Основные характеристики переменных, участвующих в дисперсионном анализе
	Одномерный дисперсионный анализ

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	Одна
	Любой
	Любое
	Любой

	Одномерный дисперсионный анализе повторными измерениями

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип
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3.2.1. Одномерный дисперсионный анализ
Как было сказано выше, одномерный дисперсионный анализ исследует влияние одной или нескольких независимых переменных на одну зависимую. Одномер​ный дисперсионный анализ может быть однофакторным (one-way ANOVA) или многофакторным (n-way ANOVA). В первом случае есть только одна независимая переменная; во втором — несколько.
Однофакторный одномерный дисперсионный анализ можно проводить двумя спо​собами: при помощи специальной процедуры One-way ANOVA (меню Analyze ► Compare Means ► One-way ANOVA) или посредством обобщенной линейной модели (меню Analyze ► General Linear Model ► Univariate). Второй прием является более универсальным и обладает полным объемом функциональности первого, поэтому да​лее мы рассмотрим только GLM (использование первого метода аналогично GLM). Необходимо отметить, что для проведения одномерного дисперсионного анализа на практике (в маркетинговых исследованиях) существует одно весьма существен​ное ограничение. При увеличении количества факторов (то есть независимых пере​менных) в модели сложность интерпретации результатов расчета возрастает много​кратно. Так, однофакторный анализ является наиболее простым. Его результаты понятны сразу при взгляде на итоговую таблицу. Двухфакторный анализ намного сложнее в интерпретации — чтобы понять его результаты, приходится потратить много времени, разбираясь в таблицах и графиках. Для интерпретации результатов трехфакторного анализа необходимо обладать некоторым опытом в его проведе​нии. Четырех- и мультифакторные модели в большинстве своем могут успешно интерпретироваться только квалифицированными исследователями. Таким об​разом, для практических целей лучше воздержаться от исследования большого числа взаимодействий между факторами и ограничиться несколькими наиболее важными. В настоящем разделе мы последовательно рассмотрим одно-, двух- и трехфакторные модели одномерного дисперсионного анализа. При этом будут использовать​ся следующие исходные данные:
Исследуется покупательское поведение потребителей глазированных сырков. Респонденты разделяются на целевые группы в зависимости от их пола (q3), возраста (q4) и количе​ства членов семьи (q72). Одним из вопросов анкеты является: «Какое количество глази​рованных сырков в среднем Вы покупаете за одно посещение магазина?» (q6) с варианта​ми ответа: 1 шт., 2 шт., 3 шт., 4 шт., 5 шт., 6-7 шт., 8-10 шт. и более 10 шт. Требуется выяснить, различается ли кратность покупок глазированных сырков различными целевы​ми группами респондентов (половыми, возрастными и по количеству членов семьи).
Прежде всего мы проведем однофакторный одномерный дисперсионный анализ и установим, насколько значимо различается кратность покупок в различных воз​растных группах респондентов (1 — младше 18 лет; 2 — 19-35 лет; 3 — 36-60 лет; 4 — старше 60 лет).
Диалоговое окно одномерного дисперсионного анализа запускается при помощи меню Analyze ► General Linear Model ► Univariate (рис. 3.9). Из левого списка всех до​ступных переменных переместите в поле для зависимой переменной Dependent Variable переменную q6 (Кратность покупок). Как видите, в качестве зависимой пере​менной в дисперсионном анализе выступает основание сегментирования респон​дентов по группам, то есть та переменная, которая и определяет различия между категориями независимой переменной. (Это замечание достаточно сложно осоз​нать, так как при проведении дисперсионного анализа как бы стираются границы в трактовке зависимых и независимых переменных — по крайней мере, по сравне​нию с другими видами статистического анализа, например регрессионного.)
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В область для независимых переменных Fixed Factor(s) поместите Возраст (q4). Об​ратите внимание на разницу между областями Fixed Factor(s) (факторы с фиксиро​ванными эффектами) и Random Factor(s) (факторы со случайными эффектами). Фиксированными факторами называют переменные, уровни которых охватыва​ют все возможные состояния этой переменной. Например, пол может быть только мужской или женский, а возраст, например, младше 30 лет, от 30 до 60 лет и стар​ше 60 лет. Случайные факторы представляют переменные, уровни которых охватывают лишь часть из всего многообразия возможных состояний. Так как в нашем случае переменная q4 (Возраст) содержит все возможные возрастные группы рес​пондентов, мы поместили ее в область фиксированных факторов.
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Если после этого вы щелкнете на кнопке ОК, то получите только одну таблицу, из которой можно узнать лишь о наличии/отсутствии значимых различий между воз​растными группами. Однако останется неизвестным, какие именно группы отли​чаются от других.
Для того чтобы определить это, существуют дополнительные статистические тес​ты, задаваемые при помощи кнопки Post Hoc. Соответствующее диалоговое окно представлено на рис. 3.10. Перенесите из области Factor(s) в область Post Hoc Tests for те независимые переменные (факторы), которые необходимо подвергнуть тес​тированию на предмет установления различий между их группами. В нашем слу​чае есть всего одна факторная переменная q4, которую и следует перенести в об​ласть тестирования. Далее укажите релевантные дополнительные тесты для указанной переменной. При этом, как видно на рисунке, SPSS выводит различные тесты для равных и неравных дисперсий (Equal Variances Assumed и Equal Variances Not Assumed соответственно).
Установить равенство/неравенство дисперсий позволяет тест Levene, вывод кото​рого на экран мы покажем ниже. В общем случае мы не знаем, равны ли дисперсии и, соответственно, какую группу статистических тестов следует использовать. По​этому рекомендуется сразу вывести тесты для равных и неравных дисперсий, что​бы сократить количество итераций при проведении дисперсионного анализа. SPSS предлагает много различных дополнительных тестов, помогающих определить различия между группами исследуемых переменных. Однако использовать их все нецелесообразно. Мы рекомендуем ограничиться наиболее популярным и универ​сальным тестом Scheffe для равных дисперсий и тестом Tamhane's T2 — для нерав​ных дисперсий. Теперь можно закрыть описываемое диалоговое окно щелчком на кнопке Continue.
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Выше мы упомянули о специальном тесте, позволяющем установить равенство/ неравенство дисперсий. На необходимость проведения данного теста (так же как и многих других) можно указать в диалоговом окне Options, вызываемом одноимен​ной кнопкой в главном диалоговом окне Univariate (рис. 3.11). Для однофакторного дисперсионного анализа можно ограничиться только одним тестом Levene на равенство дисперсий (параметр Homogeneity tests).
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Следует отметить, что если исследуемая независимая переменная имеет всего две ка​тегории (дихотомия), апостериорные тесты для нее не проводятся. Установить на​правление различия между категориями позволяет вывод средних значений зависи​мой переменной в каждой из двух категорий. Для этого перенесите исследуемую независимую дихотомическую переменную из области Factor(s) and Factor Interactions
в область Display Means for. В нашем случае единственная независимая переменная Воз​раст имеет больше двух категорий (4), и поэтому специально выводить для нее сред​ние значения нет смысла (они будут выведены в таблице Homogenous Subsets).
Остальные кнопки главного диалогового окна Univariate предназначены для мно​гофакторного анализа, рассматриваемого ниже. Теперь щелкните на кнопке О К, что​бы запустить процедуру дисперсионного анализа. В окне SPSS Viewer будут выве​дены результаты расчетов.
Первой практически значимой таблицей является результат теста на равенство дисперсий зависимой и независимых переменных Levene's Test of Equality of Error Variances (рис. 3.12). В столбце Sig. данной таблицы содержится единственное ин​тересующее нас значение — это статистическая значимость тестовой статистики F. Если значение в данном столбце показывает незначимость F — значит, дисперсии равны, и в дальнейшем мы будем анализировать результаты расчета теста Scheffe (предполагающего равенство дисперсий). В противном случае, если F-статистика значима, — дисперсии не равны, и при анализе различий между группами следует использовать тест Tamhane's T2 (предполагающий неравенство дисперсий). Как вы видите на рисунке, статистика F незначима (Sig. = 0,433) — и, следовательно, можно сделать вывод о равенстве дисперсий.
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Следующая таблица — это Tests of Between-Subjects Effects (рис. 3.13). Данная таб​лица является центральной в выводимых результатах дисперсионного анализа и показывает наличие/отсутствие значимых различий между категориями исследу​емых переменных. Первое, на что следует обратить внимание при анализе описы​ваемой таблицы, — это величина R2, отражающая долю совокупной дисперсии в зависимой переменной, описываемой статистической моделью. Другими словами, это та часть вариации зависимой переменной, которую можно объяснить на осно​вании независимой переменной. Естественно, что чем меньше независимых пере​менных, тем меньше величина R2, и наоборот.
Так, в нашем случае есть только одна независимая переменная q4 (Возраст), и при этом R2 весьма мала (0,019). Для дисперсионного анализа значения R2 можно про​сто проигнорировать, так как они не важны для практического использования по​лученной модели'. Второе, на что обращают внимание исследователи при интер​претации таблицы Tests of Between-Subjects Effects, — это собственно значимость различия между группами независимой переменной. Этот вывод следует из значения на пересечении строки, содержащей соответствующую независимую перемен​ную, и столбца Sig.. Как вы видите на рисунке, имеет место статистически высоко значимое различие между различными возрастными группами респондентов по кратности покупок глазированных сырков (значимость F-статистики у перемен​ной q4 < 0,001). Обратите внимание, что если тест Levene выявил факт неравен​ства дисперсий независимых и зависимых переменных, следует поднять по[image: image183.jpg]Observed and Predicled Frequencies
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рог зна​чимости со стандартного значения 0,05 до 0,01.
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После того как мы установили наличие статистически значимого различия между возрастными группами респондентов на основании кратности покупок сырков, необходимо определить, какие из четырех имеющихся возрастных групп отлича​ются от остальных и каким образом (в большую или в меньшую сторону).
Давайте сделаем это при помощи таблицы Multiple Comparisons, представленной на рис. 3.14. При интерпретации данной таблицы прежде всего вспомните результа​ты теста Levene. Так, в нашем случае на основании данного теста дисперсии оказа​лись равными, и поэтому в данной таблице мы будем рассматривать только ту ее часть, в которой приведены расчеты по методу Scheffe (напомним, что тест Tamhane мы бы применяли только если бы дисперсии были неравны).
Итак, в первой части таблицы (Scheffe) мы видим сравнение различий между каж​дой из четырех возрастных категорий с остальными категориями. На основе этих данных и определяются та или те группы, которые значимо отличаются от других. Так, из столбца Sig. (статистическая значимость) мы видим, что только группа рес​пондентов старше 60 лет статистически значимо отличается от всех остальных. Остальные целевые группы не отличаются друг от друга. При этом из столбца Mean Difference можно видеть, насколько отличается среднее значение той или иной груп​пы от среднего значения других групп (звездочками отмечены значимые различия при 95%-ном доверительном уровне)1.
Наконец, в последней таблице Homogeneous Subsets (рис. 3.15) представлена однознач​ная картина различий между группами независимой переменной. Здесь все возрастные группы разделены на две категории на основании различий в кратности покупок. В первую категорию входит целевая группа респондентов старше 60 лет; во вторую — все остальные возрастные группы (то есть респонденты младше 60 лет). Если бы ока​залось, что статистически значимых различий в кратности покупок глазированных сырков различными возрастными группами респондентов не наблюдается, все груп​пы независимой переменной были бы отнесены к одной категории (Subset был бы толь​ко 1). Иногда возникает ситуация, при которой одна и та же группа респондентов мо​жет относиться сразу к нескольким группам. В таком случае следует поднять порог значимости со стандартных 0,05, скажем, до 0,01 (или любого другого значения).
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Также из рассматриваемой таблицы можно сделать вывод о направлении различия между выделенными категориями. Так, в нашем случае мы можем заключить, что респонденты старше 60 лет покупают глазированные сырки в меньших объемах, чем респонденты младше 60 лет. В точности определить размер или величину раз​личия можно, только если в качестве зависимой переменной выступает интерваль​ная переменная. Так как у нас переменная q6 Кратность покупок относится к поряд​ковой шкале, мы не можем сделать точный вывод о величине различия. Если стоит такая задача, можно преобразовать зависимую порядковую переменную к интер​вальному виду (например, при помощи перекодирования кодов групп в средние значения данных групп: 1 (от 16 до 18 лет) —> 17 и пересчитать дисперсионный анализ. Это даст хотя бы приблизительную оценку величины различия. Нам достаточно только установленной статистической значимости (то есть существова​ния) различия и его направления (респонденты старше 60 лет покупают меньше сырков, чем более молодые).
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Рассмотрим теперь ситуацию, когда необходимо исследовать сразу две независи​мые переменные (и взаимодействия между ними), то есть выполнить двухфактор-ный одномерный дисперсионный анализ.
Исходные данные останутся такими же, как в предыдущем примере, однако те​перь мы будем устанавливать различие в кратности покупок сырков возрастными и половыми группами (переменная q3). Для этого вновь откроем диалоговое окно Univariate (рис. 3.9) и добавим в область для фиксированных факторов (независи​мых переменных с фиксированными эффектами) переменную Пол. При проведении многофакторного анализа (двухфакторной и более) кнопка Model позволяет задать исследование либо всех возможных взаимодействий между неза​висимыми переменными (в нашем случае будет установлено различие не только меж​ду четырьмя возрастными и двумя половыми группами по отдельности, но и между каждой половозрастной группой), либо только каких-то конкретных взаимодействий. В диалоговом окне Model можно задать и другие значения, но для большинства задач маркетинговых исследований достаточно оставлять все эти значения по умолчанию. Иными словами, кнопкой Model лучше не пользоваться. То же самое касается и кнопки Contrasts (исследование взаимодействий между уровнями независимых переменных), а также кнопки Save, позволяющей сохранять некоторые значения. В большинстве практических случаев, встречающихся в маркетинговых исследованиях, при прове​дении дисперсионного анализа вам не потребуется ничего сохранять. При проведении многофакторного дисперсионного анализа в диалоговом окне Post Нос (рис. 3.10) следует добавить к списку исследуемых переменных все независи​мые факторы, кроме дихотомических. В нашем случае переменная Пол является
дихотомической, так что добавлять ее в область Post Hoc Tests for (дополнительно к переменной Возраст) не следует. Таким образом, все параметры этого диалогово​го окна останутся неизменными по сравнению с предыдущим примером.
В диалоговом окне Options (рис. 3.11) необходимо добавить дихотомическую пере​менную q3 (Пол), а также ее взаимодействие с переменной q4 (Возраст) — q3*q4 — в область Display Means for, что позволит вывести средние значения по каждой группе мужчин и женщин при определении направления различия между ними. После этого можно запускать процедуру дисперсионного анализа на выполнение.
В окне SPSS Viewer будут выведены результаты расчетов. Они будут отличаться от результатов предыдущего примера. Во-первых, как видно из рис. 3.16, тест Levene те​перь является значимым (Sig. = 0,033), из чего следует вывод о неравенстве дисперсий.
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Во-вторых, в таблице Tests of Between-Subjects Effects появились результаты расчета значимости F-статистики для переменной Пол (q3), а также для взаимодействия q3*q4. Как видно из рис. 3.17, мужчины и женщины не имеют статистически зна​чимых различий по кратности покупок глазированных сырков. То же относится и к взаимодействию q3*q4: оно не является статистически значимым. При этом, не​смотря на неравенство дисперсий (порог значимости возрос до 0,01), переменная q4 (Возраст) сохранила свое значимое влияние на зависимую переменную (Sig. = 0,011), то есть возрастные группы по-прежнему различаются по кратности поку​пок сырков. Необходимо также отметить, что с добавлением переменной q3 доля совокупной дисперсии в зависимой переменной, объясняемая построенной моде​лью, несколько возросла (R2 = 0,022).
После таблицы Tests of Between-Subjects Effects следуют расчеты средних значений для дихотомической переменной q3 (Пол) и для взаимодействия q3 x q4 (рис. 3.18). В нашем случае ни переменная q3, ни ее взаимодействие с q4 не являются статис​тически значимыми, поэтому данные таблицы бесполезны. Однако если бы пере​менная Пол была значима (то есть различие между мужчинами и женщинами су​ществовало), на основании первой таблицы можно было бы сделать заключение о том, какая именно половая группа покупает больше сырков.
Так, если предположить, что влияние переменной Пол статистически значимо, из рис. 3.18 можно было бы заключить, что женщины покупают глазированные сыр​ки в больших объемах по сравнению с мужчинами. То же можно сказать и относи​тельно второй таблицы (Пол х Возраст). Случается, что по результатам таблицы Tests of Between-Subjects Effects некая переменная оказывается незначимой, однако в таблице Multiple Comparisons отдельные уровни этой переменной значимо отлича​ются друг от друга. В такой ситуации все равно следует признать рассматриваемую переменную незначимой и в дальнейшем игнорировать связанные с нею апо​стериорные тесты.
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Завершают вывод результатов двухфакторного анализа таблицы с расчетами апо​стериорных тестов. В нашем случае они практически такие же, как в предыдущем примере, поскольку переменная Возраст сохранила свою значимость (см. рис. 3.14 и 3.15). Однако при интерпретации таблицы Multiple Comparisons следует помнить
о неравенстве дисперсий. Поэтому значимость различий между отдельными возраст​ными группами надо устанавливать на основании второй части таблицы Tamhane.
Итак, мы рассмотрели одно- и двухфакторный одномерный дисперсионный анализ. Далее мы поговорим более подробно о трехфакторном дисперсионном анализе. На его примере мы рассмотрим построение графиков и методы их использования с целью облегчения интерпретации значимых взаимодействий между переменными.
Теперь мы будем использовать все четыре переменные из исходного условия зада​чи (см. выше), то есть проанализируем различия в кратности покупки глазирован​ных сырков анализируемыми целевыми группами респондентов (половыми, воз​растными и по количеству членов семьи). Откройте диалоговое окно Univariate и добавьте в список независимых переменных (область Fixed Factor(s)) еще одну пе​ременную q72 (Количество членов семьи).
Здесь необходимо сделать одно важное отступление. Время проведения расчетов в дисперсионном анализе (как одномерном, так и многомерном) при добавлении каж​дого нового фактора существенно возрастает. Если при этом зависимая переменная содержит достаточно большое количество уровней, расчеты могут затянуться на весь​ма длительное время. Исследователям-практикам следует знать об одной существен​ной особенности SPSS: скорость ее работы лимитируется тактовой частотой основ​ного микропроцессора и объемом оперативной памяти (скорость работы жесткого диска не играет существенной роли). SPSS может использовать в своей работе толь​ко один процессор, то есть если у вас в компьютере установлено два и более процес​сора, для SPSS это не будет иметь никакого значения. Поэтому при работе с данной программой мы настоятельно рекомендуем использовать мощные машины с высо​копроизводительным процессором и достаточным объемом оперативной памяти. К сожалению, в настоящее время не все отечественные компании имеют возможность приобретать мощные компьютеры. Предлагаем следующий выход. В главном диало​говом окне Univariate есть кнопка Model, которая, как мы сказали выше, в маркетинго​вых исследованиях используется редко, поскольку при проведении дисперсионного анализа не требуется анализировать сразу много (четыре и более) факторов и, следо​вательно, скорость работы программы будет приемлемой. Однако если в анализ при​ходится включать четыре и более независимых переменных, придется воспользоваться кнопкой Model. Щелкните на ней — и вы увидите одноименное диалоговое окно, пока​занное на рис. 3.19. По умолчанию в SPSS выбрана полнофакторная модель дисперси​онного анализа Full factorial, где исследуется влияние на зависимую переменную:
1.   всех независимых переменных по отдельности;
2.   всех возможных взаимодействий между независимыми переменными.
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Именно на расчеты, связанные со вторым пунктом, и тратится основное время. Поэтому при ограничениях, налагаемых аппаратным обеспечением компьютера, следует отказаться от использования полнофакторных моделей в пользу опреде​ляемых пользователем (Custom). Если ограничения жесткие, можно выполнить только исследования влияния независимых переменных на зависимую по отдель​ности (в терминологии SPSS, Main effects)1.
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В данном диалоговом окне в левом списке содержатся все выбранные для анализа независимые переменные. Чтобы определить пользовательскую модель, в левом списке Factors & Covariates выберите переменные, которые будут включены в итого​вую пользовательскую модель. Затем из раскрывающегося списка Build Term(s) выберите тот или иной тип взаимодействия между переменными. И наконец, щелк​ните на соответствующей кнопке, чтобы перенести сформированную пользователь​скую модель в правый список Model.
Если вы хотите рассмотреть только влияние факторных переменных по отдельно​сти, выполните действия, показанные на рис. 3.19. Выберите все независимые пе​ременные в левом списке, тип модели Main effects и перенесите эти переменные в правую область. Другими видами моделей являются:
■   Interaction — исследование всех видов взаимодействий между выбранными пе​ременными;
■   АН 2-, 3-, 4-, 5-way — исследование только взаимодействий соответственно второго (ql*q2), третьего (ql*q2*q3), четвертого (ql*q2*q3*q4) и пятого (ql*q2*q3*q4*q5) порядков.
Обратите внимание, что одновременно можно сформировать в правом списке Model сколько угодно различных моделей, подбирая только основные, необходимые вам взаимодействия факторов.
Для иллюстрации решения задачи (выполнение трехфакторного дисперсионного анализа) не будем задавать пользовательские модели, а воспользуемся полнофак​торной моделью, установленной по умолчанию. В диалоговом окне Model есть еще два не рассмотренных ранее параметра: Sum of squares и Include interceptin model. Пер​вый параметр позволяет задать тип формулы для расчета суммы квадратов (тесто​вой величины, на основании которой и производится расчет статистической значи​мости различий). В маркетинговых исследованиях рекомендуется использовать тип III, установленный по умолчанию. Второй параметр служит для указания на необ​ходимость включить в итоговую модель расчеты значимости отрезка значений. Дан​ный параметр также можно всегда оставлять установленным по умолчанию.
Вернемся к описанию решения поставленной задачи. Мы добавили в соответству​ющие поля главного диалогового окна Univariate одну зависимую переменную и cразу три независимые. При помощи кнопок Post Hoc и Options необходимо выбрать те же параметры, которые мы выбирали для одно- и двухфакторного анализа. В ре​зультате останется не рассмотренной одна важная кнопка в главном диалоговом окне Plots, позволяющая указать параметры для построения графиков. Эту кнопку следует использовать в тех ситуациях, когда обнаружено статистически значимое взаимодействие между факторами.
Для того чтобы построить график взаимодействия факторов, сначала мы должны про​вести дисперсионный анализ по обычной схеме (без графиков) и выяснить, есть ли значимые взаимодействия. После щелчка на кнопке ОК в окне SPSS Viewer будут выве​дены результаты расчетов для трехфакторного одномерного дисперсионного анализа. Нет смысла приводить их здесь — в них нет ничего для вас нового. Вместо этого да​вайте посмотрим, как интерпретировать значимые взаимодействия между факторами.
Существует два основных способа интерпретации взаимодействий:
■   в табличной форме — по результатам апостериорных тестов;
■   в графической форме — по построенным графикам взаимодействий.
Графическая форма представления результатов зачастую более предпочтительна по сравнению с табличной, особенно при анализе взаимодействий трех и более уровней. На рис. 3.20 показано диалоговое окно Profile Plots. Для того чтобы построить график по двухуровневому взаимодействию, из левого списка всех независимых переменных (область Factors) выберите переменную, категории которой будут располагаться по оси абсцисс (горизонтальной), и поместите ее в поле Horizontal Axis. Далее выберите пере​менную, значения каждой категории которой будут отображаться на графике в виде отдельных линий (пример см. ниже), и поместите ее в поле Separate Lines.
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Для иллюстрации процесса построения графиков предположим, что по результа​там трехфакторного дисперсионного анализа была установлена статистическая значимость взаимодействия между переменными q3 (Пол) и q4 (Возраст). В окне Profile Plots мы поместили переменную с наименьшим числом категорий q3 в поле Horizontal Axis, а переменную q4 — в поле Separate Lines. Теперь щелкните на кнопке Add, чтобы подтвердить построение графика с заданными параметрами. Таким спо​собом можно задать вывод сразу нескольких графиков.
После того как SPSS завершит расчеты, связанные с дисперсионным анализом, в окне SPSS Viewer после таблиц появится заданный график. В нашем примере он будет выглядеть так, как показано на рис. 3.21.
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По оси ординат здесь (вертикальная ось) располагаются средние значения крат​ности покупок глазированных сырков каждой из рассматриваемых половозраст​ных групп. При этом на рисунке видно, что в возрастных группах от 36 до 60 лет и старше 60 лет кратность покупок сырков мужчинами и женщинами практически не различается (соответствующие линии близки к параллели), тогда как в других возрастных группах различие между мужчинами и женщинами выражено доста​точно существенно (соответствующие линии перпендикулярны). Так, мужчины младше 18 лет характеризуются существенно меньшей кратностью покупок сыр​ков, чем женщины младше 18 лет. Мужчины в возрасте до 18 лет имеют наимень​шую кратность покупок и по сравнению со всеми другими половозрастными груп​пами. Мужчины в возрасте 19-35 лет характеризуются наивысшей кратностью покупок сырков среди всех возрастных групп мужчин. Можно заметить, что ситу​ация с женщинами в двух рассматриваемых возрастных группах диаметрально противоположная. Мужчины младше 18 лет имеют наименьшую кратность поку​пок; женщины младше 18 лет — наивысшую. Мужчины от 19 до 35 лет имеют наи​высшую кратность покупок; женщины 19-35 лет — наименьшую.
Таким образом, вы видите, что графики в дисперсионном анализе являются весь​ма ценным ресурсом для построения заключений и выводов. Еще одним направ​лением интерпретации является кластеризация респондентов на основании их средних показателей (например, кратности покупок). Так, в нашем примере на основании кратности покупок можно разделить всех респондентов на следующие целевые сегменты:
1.   мужчины младше 18 лет характеризуются наименьшей кратностью покупок сырков;
2.   мужчины старше 36 лет и женщины старше 19 лет характеризуются средней кратностью покупок сырков;
3.  мужчины от 19 до 35 лет и женщины младше 18 лет характеризуются наивыс​шей кратностью покупок сырков.
В целом общая схема интерпретации графиков в дисперсионном анализе состоит из двух этапов. Сначала следует определить категории респондентов, отличающи​еся и не отличающиеся друг от друга. При этом интерпретация графиков всегда происходит только по двум переменным (представленным по горизонтальной оси и в виде отдельных линий). Для установления различия следует смотреть на фор​му данных линий. Если две (или более) линии близки к параллели, следовательно, различия между данными категориями минимальны (незначимы). В противном случае, если линии пересекаются, следует признать различие между ними суще​ственным (значимым).
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Наиболее простым для интерпретации случаем является ситуация, в которой по горизонтальной оси располагается дихотомическая переменная (например, пере​менная Пол). Если линии на отрезке между двумя категориями данной перемен​ной не пересекаются — различий нет; если пересекаются — различия есть. На рис. 3.22 представлен пример максимальных различий (линии пересекаются под прямым углом); на рис. 3.23 — минимальных (линии параллельны).
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Можно сформулировать следующие рекомендации по построению графиков в дис​персионном анализе.
1.   Для горизонтальной оси лучше выбирать дихотомические вопросы.
2.   Если дихотомических переменных нет, следует выбрать переменную с наимень​шим четным количеством категорий и перекодировать данные категории в дихотомию. Для горизонтальной оси следует выбирать именно данную (уже ди​хотомическую) переменную. Данный способ работает далеко не всегда, ведь часто различия между взаимодействиями факторов находятся именно в тех категориях, которые будут перекодированы (сокращены).
При исследовании трехуровневых взаимодействий (ql x q2 x q3) переменную с наи​меньшим числом категорий (лучше дихотомическую) следует поместить в поле Separate Plots в диалоговом окне Univariate (например, ql), а для остальных двух исследуемых переменных (например, q2 и q3) — следовать вышеописанным пра​вилам. Это будет означать, что в результате будут построены отдельные графики по каждой категории переменной ql, где будут показаны двухуровневые взаимо​действия переменных q2 и q3.
В заключение настоящего раздела необходимо особо отметить, что графики вза​имодействий могут эффективно применяться только при числе взаимодействий 2 (ql х q2) или 3 (ql x q2 x q3). При взаимодействиях первого уровня (ql) мы гово​рим уже не о взаимодействиях как таковых, а о главных эффектах (Main effects), то есть о влиянии на зависимую переменную только каждого фактора в отдельности. В таком случае различия между конкретными группами независимой переменной определяются исходя из результатов апостериорных тестов. При числе взаимо​действий более трех сохраняется возможность разбиения данного взаимодействия на несколько взаимодействий второго или третьего уровней и построения затем серии графиков. Однако в этом случае интерпретация данных графиков является практически неразрешимой задачей.
3.2.2. Одномерный дисперсионный анализ с повторными 
измерениями
Одномерный дисперсионный анализ с повторными измерениями (ANOVARM) является расширением одномерного дисперсионного анализа (ANOVA). Цель его заключается в анализе различий между ответами одних и тех же респондентов на одни и те же вопросы в несколько приемов, то есть в течение ряда дискретных временных промежутков.
В качестве примера можно привести панельные исследования, когда одни и те же респонденты (потребители какого-либо продукта) отвечают на одни и те же воп​росы через определенные интервалы времени (скажем, каждый квартал). Одной из основных целей дисперсионного анализа в рассматриваемом случае будет оценка влияния на ответы респондентов временного фактора. Таким образом, в частно​сти, можно установить уровень лояльности к продуктам различных марок: если с течением времени средние оценки продукта марки X существенно не меняются/ возрастают/убывают, следовательно, и отношение респондентов к данной марке сохраняется на прежнем уровне/улучшается/ухудшается. Иными словами, дис​персионный анализ с повторными измерениями может применяться для оценки значимости тенденций.
В маркетинговых исследованиях этот тип статистического анализа находит весь​ма разнообразные применения. Он может применяться не только в процессе ана​лиза баз данных по маркетинговым исследованиям, но и в процессе сбора анкет — для контроля работы интервьюеров. Например, если опрос производится каждый
день в течение недели в одних и тех же местах, можно анализировать средние зна​чения основных переменных, во-первых, по дням недели, а во-вторых, по каждому интервьюеру. Если будут выявлены существенные различия в анкетах интервьюе​ров, то высока вероятность фальсификации (тем интервьюером, анкеты которого наиболее сильно отличаются от остальных).
Необходимо сделать важное отступление. Дело в том, что некоторые источники иногда относят анализ с повторными измерениями к одномерному, а иногда — к многомерному дисперсионному анализу. В справочной системе SPSS не указана явно принадлежность ANOVARM к одной или другой группе статистических ме​тодов. По сути расчетов ANOVARM близок к многомерному дисперсионному ана​лизу, поскольку в качестве зависимой переменной выступают сразу несколько пере​менных, кодирующих ряд временных периодов. Но так как основная задача данного пособия — объяснение практических приемов работы с SPSS для эффективного применения этого программного продукта в маркетинговых исследованиях, мы отдаем предпочтение семантическому толкованию статистических терминов. За​висимые переменные в ANOVARM по смыслу (с точки зрения исследователя) представляют собой фактически одну и ту же переменную, только измеренную многократно. В этой трактовке следует скорее говорить о специфической форме одномерного дисперсионного анализа, в котором зависимая переменная представ​лена набором подпеременных (точно так же, как при кодировании многовариант​ных вопросов; см. раздел 1.4.2). Таким образом, мы придерживаемся точки зрения тех авторов, которые считают ANOVARM видом одномерного дисперсионного анализа (ANOVA).
Итак, в качестве иллюстрации использования одномерного дисперсионного ана​лиза с повторяющимися измерениями рассмотрим следующий пример. Проводится исследование мнений респондентов относительно одежды марки X. Одним из во​просов анкеты является следующий: Поставьте оценку одежды марки X по пятибалль​ной шкале (от 1 — очень плохо до 5 — отлично). Респонденты разделяются на группы по полу и возрасту. Исследование проводится с частотой раз в квартал в течение года. В результате в итоговой базе данных получены три переменные: ql8, ql9 и q20, отражающие уровень оценки респондентами одежды марки X в первом, вто​ром и третьем кварталах, а также две переменные, указывающие пол (q80) и воз​раст (q74) опрошенных. Требуется установить, как меняется общая картина вос​приятия респондентами одежды марки X в течение одного года. Поставленная задача легко решается методом одномерного дисперсионного ана​лиза с повторяющимися измерениями. Откройте диалоговое окно Repeated Measures Define Factor(s) при помощи меню Analyze ► General Linear Model ► Repeated Measures (рис. 3.24). Это диалоговое окно предназначено для формирования временных фак​торов, то есть определения составных переменных, описывающих эти факторы. У нас есть три временных интервала (квартала), поэтому в поле Within-Subject Factor Name напишите название этой составной переменной: кварталы, а в поле Number of Levels — число временных периодов, когда производились измерения (3 квартала). После этого щелкните на кнопке Add, чтобы добавить новую составную перемен​ную в список. Таким способом можно задать сразу несколько составных времен​ных переменных, однако в маркетинговых ис[image: image205.jpg]


следованиях в большинстве случаев ограничиваются только одной.
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Кнопка Measure служит для задания дополнительных измерений временных пе​ременных, но в маркетинговых исследованиях эта функция обычно не использу​ется.
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Щелкните на кнопке Define, и откроется новое диалоговое окно Repeated Measures (рис. 3.25), похожее (как по внешнему виду, так и по своим функциям) на окно Univariate. В этом окне в левом списке всех доступных переменных выберите те, в которых закодированы оценки респондентов в каждый из временных промежут​ков (в нашем случае — ql8, ql9, q20), и последовательно (то есть в порядке возрас​тания периодов) перенесите их в область Within-Subjects Variables (кварталы).
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Теперь в рассматриваемой области определена составная временная переменная, описывающая оценки респондентами одежды марки X в каждый из трех рассмат​риваемых кварталов. Таким образом, область Within-Subjects Variables (кварталы) является аналогом области Dependent Variable в одномерном дисперсионном ана​лизе, только зависимая переменная в нашем случае как бы распадается на три подпеременные, вместе составляющие одно целое. Далее в область Between-Subjects Factor(s) поместите те переменные, которые служат основаниями для различения оценок. В нашем случае это демографические характеристики респондентов: пол (q80) и возраст (q74).
Итак, вы задали все переменные для исследования и можете использовать кноп​ки, расположенные в нижней части этого диалогового окна, — так же, как вы де​лали это при одномерном дисперсионном анализе (см. раздел 3.2.1). В окне Post Нос задайте апостериорные тесты Scheffe (для равных дисперсий) и Tumhale (для неравных дисперсий) для переменных, имеющих более двух категорий (в нашем случае это только q74 — Возраст). В окне Options выберите параметр Homogeneity Tests и в соответствующее поле поместите переменные с двумя категориями, для которых следует рассчитать средние значения (q80 — Пол и все взаимодействия, в которых она участвует). Остальные диалоговые окна аналогичны рассмотрен​ным для одномерного дисперсионного анализа, поэтому мы не приводим их вто​рой раз.
В результате мы выясняем, какой из трех факторов — пол, возраст или время (квар​талы) — определяет различия в оценках одежды марки X. Запустив программу на исполнение щелчком на кнопке ОК, в окне SPSS Viewer вы увидите результаты дисперсионного анализа. В целом они аналогичны результатам, отображаемым при одномерном дисперсионном анализе, однако данные результаты значительно об​ширнее и содержат несколько дополнительных таблиц. Так как настоящее посо​бие посвящено сугубо практическим задачам использования SPSS в маркетинговых исследованиях, мы рассмотрим только ту часть результатов, которая необходима на практике.
[image: image209.jpg]& B (e8]
B a77[a77)
% 78 [a78]
/& REGR facor scare




Итак, первое, что должно привлечь ваше внимание, — это таблица Box's Test of Equality of Covariance Matrices (рис. 3.26). Тестовая статистика Box показывает, существуют ли статистически значимые различия в оценках респондентов в каждом из анали​зируемых периодов. В нашем случае мы видим высокую значимость (Sig. < 0,001), свидетельствующую о том, что оценки респондентами одежды марки X существен​но меняются от квартала к кварталу.
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После анализа результатов теста Box мы смотрим на следующую важную табли​цу — Multivariate Tests (рис. 3.27), позволяющую сделать выводы о том, в какой степени выявленные различия определяются влиянием временного фактора, а также взаимодействием этого фактора с другими переменными, включенными
в анализ. Так, в нашем случае мы видим, что непосредственно временной фактор (кварталы) в значительной степени определяет различия в исследуемых оцен​ках (Sig. < 0,001). Сочетание эффектов времени и пола (Кварталы х q80), а также времени и возраста респондентов (Кварталы х q74) с высокой вероятностью опре​деляют различия в оценках одежды (Sig. = 0,002 и 0,024). А вот тройственное взаимодействие всех анализируемых величин в совокупности не оказывает ни​какого влияния на изучаемую разницу в оценках (Sig. = 0,935). Обратите внима​ние на то, что при интерпретации таблицы Multivariate Tests следует оценивать значимость того или иного фактора всегда на основании теста Pillai's Trace. Имен​но этот тест статистической значимости является наиболее надежным (робастп-ным).
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Мы ответили на два основных вопроса:
1.   изменяются ли статистически значимо оценки респондентами одежды марки X?
2.   чем определяются эти различия: только влиянием временного фактора или так​же влиянием независимых переменных (пола и возраста)?
В результате анализа мы смогли утвердительно ответить на оба вопроса: различия в оценках есть, и они определяются как временем, так и его взаимодействием с полом и возрастом. Дальнейший анализ будет направлен на исследование влия​ния независимых переменных и их взаимодействий по отдельности на оценки респондентов.
Следующие три таблицы: — Mauchly's Test of Sphericity, Tests of Within-Subjects Effects и Tests of Within-Subjects Contrasts — обычно пропускаются, так как они не позволя​ют сделать никаких новых выводов и лишь подтверждают представленные выше результаты. После трех таблиц следуют результаты одномерного дисперсионного анализа для независимых переменных, для которых не производятся повторные измерения, знакомые вам по разделу 3.2.1.
Таблица Levene's Tests of Equality of Error Variances (рис. 3.28) позволяет определить однородность дисперсий в каждый из исследуемых промежутков времени. Так, в нашем случае мы видим, что во всех трех исследуемых кварталах дисперсии одно​родны (Sig. > 0,05).
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Из таблицы Tests of Between-Subjects Effects (рис. 3.29) мы видим, что и пол, и воз​раст респондентов с весьма высокой вероятностью определяют различия в оцен​ках одежды марки X (Sig. < 0,001), а вот их взаимодействие — нет (Sig. = 0,058).
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Теперь нам осталось определить, как именно различаются оценки под влиянием выявленных значимых факторов и их взаимодействий. Во-первых, мы определи-
ли, что на различии в оценках респондентов в каждый из трех анализируемых пе​риодов оказывают влияние пяти эффектов:
■   временной фактор (кварталы);
■   взаимодействие времени с полом;
■   взаимодействие времени с возрастом;
■   пол;
■   возраст.
К сожалению, провести апостериорные тесты для временной переменной SPSS не позволяет, поэтому при определении различий между группами временной переменной приходится ориентироваться исключительно на средние значения (оценки). Возраст является единственной переменной, для которой можно прове​сти стандартные апостериорные тесты (см. далее). Для остальных значимых взаимодействий выводятся средние значения: оценки одежды марки X в каждой рассматриваемой категории респондентов (см. рис. 3.28). Кроме таблиц для дан​ных взаимодействий целесообразно вывести и графики. Это облегчит интерпре​тацию и позволит наглядно определить различия между категориями респон​дентов.
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Завершают вывод результатов одномерного дисперсионного анализа с повторяю​щимися измерениями таблицы апостериорных тестов для переменных с числом категорий более двух1. В нашем случае это две таблицы для переменной Возраст: Multiple Comparisons и Homogeneous Subsets. Первую таблицу мы не приводим из-за ее большого размера, вместо этого приведена дублирующая ее вторая таблица, по​казывающая однородные группы респондентов по оценкам одежды марки X
(рис. 3.30). Из таблицы вы видите, что наивысший уровень оценок достигается в возрастной группе респондентов (в среднем 4,0 балла) младше 25 лет. Респонден​ты старше 25 лет склонны оценивать одежду марки X несколько ниже (в среднем на 3,8 балла).
3.2.3. Многомерный дисперсионный анализ

Многомерный дисперсионный анализ является дальнейшим расширением од​номерного дисперсионного анализа (после рассмотренного в разделе 3.2.2 ANOVARM), предназначенным для одновременного анализа сразу нескольких зависимых и независимых переменных. Процесс проведения многомерного ана​лиза аналогичен рассмотренному выше обычному одномерному дисперсионному анализу, за исключением того, что в данном случае в область для зависимых пере​менных можно поместить сразу несколько переменных, а при интерпретации при​ходится анализировать сразу несколько различий (во всех зависимых перемен​ных).
Давайте рассмотрим процесс проведения многомерного дисперсионного анализа на примере, аналогичном приведённому в разделе 3.2.1 для обычного одномерного дисперсионного анализа, — но в качестве зависимых переменных мы будем рас​сматривать не только кратность покупок глазированных сырков, но и частоту по​купок. В качестве независимых переменных мы возьмем также две переменные: возраст респондентов и количество членов их семей.
Откройте диалоговое окно Multivariate при помощи меню Analyze ► General Linear Model ► Multivariate. Как вы видите на рис. 3.31, оно аналогично окну Univariate. По​местите две зависимые переменные: q5 (Частота покупок) и q6 (Кратность покупок) в область для зависимых переменных Dependent Variables, а переменные q4 (Возраст) и q72 (Количество членов семьи) — в область для независимых переменных Fixed Factor(s). После этого так же, как для одномерного дисперсионного анализа в окне Post Hoc, задайте вывод тестов Scheffe и Tumhale для обеих независимых перемен​ных, а в окне Options отметьте параметр Homogeneity Tests. После этого можно на​чать расчеты, щелкнув на кнопке ОК.
В окне SPSS Viewer появятся результаты многомерного дисперсионного анализа. Первой таблицей, которая должна привлечь ваше внимание, является Box's Test of Equality of Covariance Matrices, представленная на рис. 3.32. В отличие от одномерно​го дисперсионного анализа с повторяющимися измерениями, здесь тест Box дол​жен быть незначимым (как в нашем случае, Sig. = 0,131), так как неравенство дис​персий исследуемых зависимых переменных в многомерном анализе не является положительным фактом. И напротив, равенство дисперсий зависимых перемен​ных является одним из основных условий проведения многомерного дисперсион​ного анализа1.
Таблица Multivariate Tests позволяет сделать выводы относительно влияния не​зависимых переменных в отдельности, а также их взаимодействий на зависимые переменные в целом. Поскольку с практической точки зрения влияние не несет никакой смысловой нагрузки, данная таблица обычно не рассматрива​ется.
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Следующей важной таблицей является тест Levene на равенство дисперсий зави​симых переменных. Как мы помним из описания одномерного дисперсионного анализа, от факта равенства/неравенства дисперсий в дальнейшем зависит выбор конкретного апостериорного теста: Scheffe или Tumhale. Как вы видите на рис. 3.33, в нашем случае дисперсии равны у обеих зависимых переменных, поэтому далее мы будем опираться на результаты теста Scheffe.
Таблица Tests of Between-Subjects Effects (рис. 3.34) позволяет установить, как каждый эффект влияет на каждую зависимую переменную в отдельности. В от​личие от таблицы Multivariate Tests, рассматриваемая таблица позволяет выяс​нить, на какую конкретно зависимую переменную влияет та или иная незави​симая переменная и их комбинации. В нашем случае мы видим, что частота покупок определяет различия между категориями переменной q4 Возраст (Sig. = 0,045), а кратность покупок — в категориях переменной q72 Количество членов семьи (Sig. < 0,001).
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И наконец, последнее, что важно при практической интерпретации результатов многомерного дисперсионного анализа: какие группы каждой из рассматриваемых независимых переменных различаются на основании средних значений зависи​мых переменных. Это позволяют определить апостериорные тесты (в нашем слу​чае Scheffe). Они рассчитываются для каждой комбинации зависимая перемен​ная/ независимая переменная для всех значений индексов i. Эти таблицы по своему виду аналогичны рассмотренным в предыдущих разделах, посвященных диспер​сионному анализу.
Мы не приводим полностью результаты апостериорных тестов из-за их большого объема.
На рис. 3.35 представлены результирующие таблицы Homogenous Subsets, по ко​торым можно сделать выводы относительно различий между отдельными кате​гориями независимых переменных на основании обеих рассматриваемых зави​симых переменных. Также в этих таблицах вы видите однородные кластеры респондентов, различающиеся частотой и кратностью покупок глазированных сырков.
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Итак, в данной главе мы рассмотрели статистические методы, применяемые для анализа различий между целевыми группами респондентов. Несмотря на то что данные методы (особенно обобщенная линейная модель) достаточно сложны для изучения, их применение позволяет поднять аналитическую работу на существен​но более высокий уровень.
Глава 4 Ассоциативный анализ
Ассоциативный анализ служит для выявления связей между переменными. Применительно к маркетинговым исследовани​ям данная группа статистических процедур позволяет ответить на вопросы типа:

■   Влияет ли на частоту посещения магазина уровень дохо​дов покупателей?

■   Как связаны между собой пол респондентов и желание ку​пить мотоцикл?

■   Как влияет на покупательское поведение потребителей су​хих строительных смесей род занятий респондентов?

То есть при помощи ассоциативного анализа становится воз​можным анализировать вопросы анкеты не только по отдель​ности, а в зависимости от других вопросов. Этот вид анализа иногда называют построением разрезов, поскольку он позво​ляет определить не только наличие связи между вопросами анкеты, но и силу связи между переменными и то, каким обра​зом ведет себя одна переменная при изменении другой (воз​растает или убывает).

В процессе ассоциативного анализа выявляются следующие типы зависимостей.

■   Немонотонные зависимости свидетельствуют только о на​личии определенной связи между двумя переменными, но не позволяют судить о направлении или силе связи. При​мер немонотонной зависимости: мужчины в основном по​купают рыбные консервы в продовольственных магазинах, а женщины — на рынках.

■   Монотонные зависимости — это зависимости, по которым можно узнать не только наличие, но и направление связи. Пример монотонной зависимости: мужчины покупают пиво чаще, чем женщины. Монотонные зависимости бывают двух видов:

возрастающие — первая переменная возрастает при возра​стании второй;

убывающие — первая переменная убывает при возрастании второй.

■   Линейные зависимости характеризуются уравнением функции у = а + Ьх (гра​фик линейной функции). Связь между двумя переменными в данном случае является линейной, то есть на основании этой зависимости мы можем сказать, насколько изменится одна переменная при изменении второй.

■   Нелинейные. Примерами нелинейных связей между двумя переменными яв​ляются: экспоненциальная, логарифмическая, степенная, полиномиальная за​висимости — то есть в данном случае связь присутствует и изменяется по како​му-либо известному математическому закону.

Зависимости, выявленные в результате ассоциативного анализа, можно охаракте​ризовать тремя аспектами.

■   По наличию — определенная (систематическая) связь между двумя перемен​ными есть.

■   По направлению — связь является убывающей или возрастающей.

■   По силе — можно определить, насколько тесно связаны между собой две пере​менные, то есть насколько значима данная зависимость.

Между переменными с номинальной шкалой может быть установлена только не​монотонная зависимость, характеризуемая только наличием связи. Для перемен​ных, имеющих порядковую или интервальную шкалу, данное ограничение не дей​ствует — для них можно определить и направление, и силу связи.

4.1. Перекрестные распределения и 
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Перекрестные распределения служат для выявления различных типов зависимо​стей между двумя и более переменными. Например, если требуется установить, где покупают сгущенное молоко мужчины и женщины, следует воспользоваться таблицами перекрестных распределений (таблицами сопряженности, или кросста-буляции). На основании перекрестных распределений можно установить не толь​ко наличие зависимости (немонотонной или монотонной) между переменными, но, в большинстве случаев, ее тип (линейная или нелинейная) и направление (возрастающая или убывающая)1. Установленная при помощи перекрестного рас​пределения зависимость может оказаться незначимой из-за малого размера вы​борки или по другим причинам. Статистическую значимость выявленной зависи​мости позволяет определить критерий 
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В табл. 4.1 представлены основные характеристики переменных, участвующих в анализе.

Несмотря на то что перекрестные табуляции можно строить по переменным, име​ющим любой тип шкалы, необходимо иметь в виду, что большое количество категорий (вариантов ответа) анализировать трудно. Даже если анализ выявит значимую зависимость, при наличии большого числа категорий переменных ис​следователю будет сложно понять, каким именно образом связаны данные пере​менные.

Таблица 4.1. Основные характеристики переменных, участвующих в перекрестных распределениях

	Перекрестные распределения

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	От двух до десяти
	Любой
	От двух до десяти
	Любой


Также следует отметить, что наибольшую эффективность кросстабуляционный ана​лиз показывает на номинальных и порядковых переменных. Для интервальных пе​ременных больше подходит корреляционный анализ, рассматриваемый в разделе 4.2.

И наконец, последним ограничением применения перекрестных распределений для анализа зависимостей между переменными является тот факт, что различные ста​тистические тесты (такие как 
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) могут быть использованы только при анализе одновариантных переменных. Статистические тесты, применяемые для анализа зависимостей, предназначены только для двух переменных. При наличии допол​нительных слоев или уровней кросстабуляционной таблицы статистический ана​лиз производится для каждого уровня отдельно, при этом на каждом уровне он работает только с двумя переменными. Для многовариантных переменных SPSS содержит возможность отдельного построения кросстабуляции — выявить нали​чие и направление связи в данном случае можно только визуально.

Далее в этой главе мы покажем, как строить перекрестные распределения и анали​зировать зависимости для одновариантных и многовариантных переменных.

4.1.1. Перекрестные распределения для одновариантных вопросов и 
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Давайте рассмотрим перекрестные распределения для одновариантных вопросов на следующем примере.
ПРИМЕР----------------------------------------------------------------------------------------------

Исходные данные:

В результате маркетингового исследования, посвященного исследованию потребительских предпочтений посетителей развлекательного центра, оказалось, что средняя частота посе​щения центра составляет приблизительно 12 раз в месяц. Также были получены данные о распределении среди посетителей центра мужчин и женщин различных возрастных групп. В ходе подготовительного этапа анализа были сформированы, в частности, три одновариантные переменные:

1)   частота посещения центра (q25);

2)   возраст респондентов (ql8);

3)   пол респондентов (q23). Требуется:

1.    Построить перекрестное распределение частоты посещения развлекательного центра в разрезе возраста и пола респондентов. Рассчитать среднюю частоту посещения цент​ра различными целевыми группами потребителей.

2.    Определить, влияет ли на частоту посещения центра возраст потребителей. Установить статистическую значимость зависимости между частотой посещения и возрастом.
---------------------------------------------------------------------------------------------------------------------
Из условия первой задачи следует, что мы должны построить перекрестное рас​пределение сразу по трем переменным: q25 в зависимости от ql8 и q23 (то есть трехуровневое). Для решения задачи воспользуемся меню Analyze ► Descriptive Sta​tistics ► Crosstabs. В открывшемся диалоговом окне (рис. 4.1) из левого списка, со​держащего все доступные переменные, выберите те, которые будут расположены в строках результирующей таблицы, и те, которые будут расположены в столбцах. Поместите зависимую переменную q25 Частота посещения в область Rows (вариан​ты ответа на вопрос о частоте посещения будут расположены в строках таблицы), а независимую переменную ql8 Возраст — в область Columns (возрастные группы будут расположены в столбцах таблицы). Осталась еще одна независимая пере​менная q23 Пол. Поместите ее в область Layer (уровень или слой таблицы).

Обратите внимание, что всегда, когда обратное не обусловлено задачами исследо​вания, рекомендуется размещать переменные с малым количеством вариантов от​вета в слоях. Это позволит уменьшить размерность результирующей таблицы. Мы можем задать и большее количество измерений таблицы, щелкая на кнопке Next в области Layer и добавляя релевантные переменные. Максимальное количество сло​ев, которое можно задать, щелкая на кнопке Next, — 8. Следовательно, максимально возможное количество измерений перекрестной таблицы по одновариантным воп​росам — 10(10 = 8 слоев + 1 строковая переменная + 1 столбцовая переменная).
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В диалоговом окне Crosstabs в область каждого измерения (Rows, Columns, Layer) можно поместить сразу несколько переменных. Максимальное число переменных, которые можно поместить в области Rows и Columns, — 76; для каждого из восьми возможных уровней Layer — 6. Если задано по одной переменной в строке и столб​це (как в нашем случае), все дополнительно указанные слои будут отображаться в одной и той же таблице. Ситуация будет отличаться, если мы укажем несколько переменных для строк, столбцов и слоев в одних и тех же областях (не щелкая на кнопке Next для задания нескольких слоев) перекрестной таблицы. В этом случае будут построены отдельные таблицы для каждой пары строковых и столбцовых переменных.
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Теперь, когда вы указали все переменные для анализа, для построения перекрест​ных распределений можно щелкнуть на кнопке ОК. Однако сначала давайте рас​смотрим некоторые другие полезные функции диалогового окна Crosstabs. Щелкни​те на кнопке Cells. Отрывшееся диалоговое окно Cell Display (рис. 4.2) предназначено для задания значений, выводимых в кросстабуляционной таблице. По умолчанию SPSS в каждой ячейке таблицы выводит только количество респондентов (пара​метр Observed). Область Percentages позволяет организовать вывод в ячейках таб​лицы процентов по строкам (Rows), столбцам (Columns), а также от общего числа респондентов, ответивших одновременно на все вопросы, по которым строится перекрестное распределение (Частота посещения, Возраст и Пол) (Total).

Чтобы проиллюстрировать наш пример (расчет средних частот покупки), выве​дем проценты по вопросу Частота посещения внутри каждой возрастной и половой группы респондентов, отметив параметр Columns и проценты по всем возрастным группам в целом (Total). Также оставим выбранный по умолчанию вывод наблю​даемых частот (Observed). После этого можно закрыть окно Cell Display, щелкнув на кнопке Continue.

Следующее диалоговое окно, которое мы рассмотрим, — это Table Format, вызывае​мое при помощи кнопки Format (рис. 4.3). В нем можно выбрать тип сортировки вариантов ответа строковой переменной: возрастающая или убывающая (по алфа​виту). Оставьте выбранный по умолчанию вариант Ascending (возрастающая) и щелкните на кнопке Continue, чтобы закрыть окно. После этого запустите процеду​ру построения перекрестных распределений, щелкнув на кнопке О К в главном ди​алоговом окне Crosstabs. В главном диалоговом окне процедуры есть и другие по​лезные (Ьункпии: мы оассмотоим их ниже.

После этого в окне SPSS Viewer будет выведена требуемая таблица перекрестного распределения (рис. 4.4). В ячейках данной таблицы находятся искомые частоты

посещения развлекательного центра каждой из анализируемых целевых групп опрошенных. Например, первая ячейка показывает, что 5 (строка Count) респон​дентов-мужчин в возрасте от 18 до 25 лет посещают развлекательный центр каж​дый день. Это составляет 8,1% (подстрока % within Возраст) от общего количества мужчин в возрасте от 18 до 25 лет, ответивших на три предложенных вопроса, или 1,5% (подстрока % of Total) от общего числа мужчин, ответивших на вопросы (это число 333, оно представлено на пересечении строки и столбца Total в первой части таблицы Мужчины).

Строка Total показывает, сколько всего мужчин из каждой возрастной группы от​ветили на вопрос о частоте посещения центра (в нашем случае 62 респондента-мужчины в возрасте от 18 до 25 лет). Столбец Total показывает, сколько всего муж​чин, посещающих развлекательный центр с различной частотой, ответили на вопрос о возрасте (в нашем случае 15 респондентов-мужчин, посещающих центр каждый день).

Вторая часть таблицы Женщины построена аналогичным образом. Как вы видите, 15,8% женщин в возрасте от 41 до 45 лет посещают развлекательный центр 1-2 раза в месяц.

На основании представленной таблицы перекрестного распределения вы можете рассчитать вручную средневзвешенные частоты посещения респондентами развле​кательного центра в зависимости от их пола и возраста. Для этого скопируйте ана​лизируемую таблицу в Microsoft Excel, щелкнув на ней правой кнопкой мыши в окне SPSS Viewer и выбрав пункт Сору (не Copy Objects !). Окончательный вид по​лученного распределения представлен в табл. 4.2.
Таблица 4.2. Средневзвешенные частоты посещения развлекательного центра в зависимости от пола и возраста респондентов (раз в месяц)

	Пол
	Возраст
	
	
	
	
	
	
	

	
	ОТ 18 до 25 лет
	От 26 до 30 лет
	От 31 до 35 лет
	От 36 до 40 лет
	От 41 до 45 лет
	От 46 до 50 лет
	От 51 до 55 лет
	Старше 55

	Мужчины
	12
	12
	12
	12
	13
	13
	9
	10

	Женщины
	11
	12
	14
	12
	10
	12
	11
	12


Из представленной таблицы следует, что средняя частота посещения развлекатель​ного центра различными половозрастными группами респондентов несколько раз​личается. Однако, исходя только из визуальных предположений, нельзя утверж​дать то, что частота посещения центра действительно зависит от пола и возраста. Для этого любая выявленная закономерность должна удовлетворять условию ста​тистической значимости. Определить, значима ли выявленная нами зависимость, позволяют статистические тесты, выполняемые при построении перекрестных рас​пределений.

Далее мы покажем, как решается второй пункт нашей задачи (условие см. выше), то есть как ответить на вопрос: «Действительно ли существует статистически зна​чимая зависимость между тремя анализируемыми переменными или показанные в табл. 4.2 различия в частотах посещения центра вызваны влиянием случайных факторов (то есть как таковой зависимости нет)?».

Выявить статистическую значимость зависимостей между переменными позволя​ют критерий 
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 и сопутствующие тесты. Исследуем нашу зависимость между час​тотой посещения развлекательного центра, полом и возрастом респондентов на предмет статистической значимости. Для этого вновь откройте диалоговое окно Crosstabs. В этом окне остались две не рассмотренные нами кнопки: Exact и Statistics — именно они позволяют исследовать значимость перекрестных распределений. По умолчанию SPSS определяет статистическую значимость только на основании асимптотического метода. Одной из разновидностей данного метода и является 
[image: image22.wmf]2

c

. Данный критерий используется наиболее часто в маркетинговых исследовани​ях. Однако применение асимптотического критерия 
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 накладывает на данные, содержащиеся в анализируемой перекрестной таблице, существенные ограниче​ния, которые подробно описаны ниже.

Так, важнейшим требованием к исследуемым данным является достаточно боль​шие значения в ячейках таблицы. При наличии небольших по размеру выборок или при построении разрезов третьего и более уровня данное условие является недостижимым. Исходя из опыта анализа данных в маркетинговых исследовани​ях, можно утверждать, что подобные ситуации встречаются достаточно часто. В свя​зи с этим в случае несоответствия имеющихся данных общепринятому критерию 
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 следует воспользоваться другими статистическими методами.

Сначала на примере перекрестного распределения по трем переменным рассмотрим использование наиболее популярного статистического метода установления стати​стической значимости зависимостей — критерия 
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. Для того чтобы организовать наряду с перекрестной таблицей вывод соответствующих статистик, в главном диа​логовом окне Crosstabs щелкните на кнопке Statistics (рис. 4.5). В открывшемся диа-

логовом окне выберите параметр Chi-square 
[image: image26.wmf]2

c

). Это позволит впоследствии опреде​лить, имеется ли определенная связь между исследуемыми переменными.

При анализе зависимостей, кроме обнаружения наличия связи, также можно оп​ределить, насколько сильно выражена данная зависимость (установить силу связи). Сделать это позволяют релевантные статистические тесты, применяемые отдель​но для каждого из трех типов переменных, участвующих в анализе. Для номиналь​ных переменных следует применять один из тестов, представленных в области Nominal. Наиболее универсальным и часто применяемым методом является V Cra​mer's. Для порядковых переменных следует применять один из методов, представ​ленных в области Ordinal. Мы рекомендуем использовать наиболее универсальный метод: Gamma. Теоретически этот же метод можно применять и для интервальных переменных, однако все же для них рекомендуется использовать более релевант​ную процедуру корреляционного анализа.

Далее рассмотрим, как применять перечисленные статистические методы на приме​ре нашей задачи с двумя порядковыми переменными Частота посещения развлека​тельного центра и Возраст. Для этого выберите параметр Gamma и закройте описываемое окно, щелкнув на кнопке Continue. Запустите процедуру построения перекрестных распределений, щелкнув на кнопке ОК в главном диалоговом окне Crosstabs.

В окне SPSS Viewer появится уже рассмотренная выше таблица перекрестного распределения трех переменных: Частота посещения, Возраст и Пол. Но, в отличие от предыдущего случая, ниже будут отображены две таблицы, из которых можно уз​нать о наличии, силе и направлении (только для порядковых и интервальных пере​менных) связи между анализируемыми переменными. Рассмотрим их по порядку.

В первой таблице, Chi-Square Tests, выводятся результаты расчета критерия 
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 (строка Pearson Chi-Square) и некоторых других статистик (рис. 4.6). Необходимо отметить, что расчет всех статистических процедур производится для каждого варианта пе​ременной, расположенной в слоях (в нашем случае Пол) по отдельности (то есть отдельно для целевых групп мужчин и женщин). Данное обстоятельство уже было отмечено выше.

В нашем примере для респондентов-мужчин величина критерия 
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 — 56,048, одна​ко для практических целей важна не столько сама величина, столько ее значимость, представленная в столбце Asymp. Sig. (2-sided). Именно из условия статистической значимости критерия 
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 следует статистическая значимость всей зависимости. В нашем примере значимость анализируемого критерия и для муж​чин, и для женщин достаточно высока (0,001 и 0,014 соответственно), что позволяет сделать предварительный вывод о том, что между частотой посещения развлека​тельного центра и возрастом для каждой половой группы респондентов существу​ет определенная статистически значимая зависимость. Тем не менее одной значи​мости критерия 
[image: image30.wmf]2

c

 недостаточно, чтобы с уверенностью утверждать о наличии значимой зависимости между тремя анализируемыми переменными. Для этого необходимо, чтобы выполнялись следующие два критерия.

Процент ячеек, в которых ожидаемые значения1 (Expected counts) меньше или равны 5, должен быть менее или равным 20 %. Это значение отображается в при​мечании «а» в первой строке после таблицы Chi-Square Tests. На практике приемле​мая доля ожидаемых частот меньше 5 может отклоняться от 20 % (в пределах +5 %). При наличии ярко выраженной зависимости можно считать такую зависимость статистически значимой. Также всегда необходимо иметь в виду практические со​ображения (и это относится ко всем без исключения статистическим процедурам). Если ожидаемые частоты меньше 5 у переменных, представляющих малую прак​тическую значимость для исследователя, — значит, можно не принимать в расчет рассматриваемый критерий и признать зависимость значимой по практическим соображениям. Как видно на рис. 4.58, в нашем случае 55 % ячеек имеют ожидае​мые значения меньше 5 (при этом минимальное ожидаемое значение 0,32). Следо​вательно, несмотря на то что критерий 
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 является статистически значимым, он не удовлетворяет рассматриваемому дополнительному условию.

Суммы по строкам и столбцам должны быть больше 0. В нашем случае данное условие удовлетворяется.

Еще одной не рассмотренной статистикой в таблице Chi-Square Tests является тест Mantel-Hanzel (строка Linear-by-Lf near Association). Его значимость позволяет сде​лать вывод о наличии линейной зависимости между неноминальными перемен​ными. Если величина данного теста статистически значима, следовательно, между строковой и столбцовой переменными есть линейная зависимость. В нашем слу​чае (рис. 4.6) линейная зависимость между возрастом и частотой посещения раз​влекательного центра существует только в целевой группе респондентов-женщин. Про мужчин подобное сказать нельзя.

После того как мы установили наличие зависимости между тремя анализируе​мыми переменными (при этом между возрастом и частотой посещения для рес​пондентов-женщин существует и линейная зависимость), можно приступить к анализу таблицы Symmetric Measures (рис. 4.7), чтобы определить силу выяв​ленной связи.

Для порядковых переменных (как в нашем случае) определить силу связи позво​ляет критерий Gamma. Этот показатель может варьироваться в интервале от -1 (мак​симально разнонаправленная зависимость) до 1 (полная зависимость); значение О показывает полное отсутствие зависимости. Значение критерия Gamma представ​лено в столбце Value таблицы Symmetric Measures. В нашем случае в группе респон​дентов-мужчин имеется лишь весьма слабая положительная зависимость (Gamma = 0,080). Столбец Approx. Sig. свидетельствует о том, что данная зависимость еще и статистически незначима. Обратная ситуация в группе респондентов-женщин: для них установлена слабая, но статистически значимая положительная зависимость между возрастом и частотой посещения развлекательного центра.
Если в перекрестном анализе участвуют номинальные переменные, силу (но не направление) связи позволяет определить критерий Cramer's V. Отображение этого критерия можно установить в диалоговом окне Statistics при помощи параметра Phi and Cramer's V (см. рис. 4.5).

Давайте рассчитаем данный критерий для наших переменных. Результаты расче​тов представлены на рис. 4.8. В целом, критерий Cramer's V может варьироваться в пределах от 0 до 1, где 0 показывает отсутствие связи между исследуемыми переменными, а 1 — полную зависимость. В нашем случае и для мужчин, и для женщин есть статистически значимые (как показывает столбец Approx. Sig.) слабые зависи​мости (для мужчин Cramer's V = 0,205; для женщин = 0,176). Необходимо отме​тить, что значение 1 для теста Cramer's V является практически недостижимым, поэтому значения 0,8-0,9 следует считать весьма высокими.


Итак, мы определили, что между тремя анализируемыми переменными — возра​стом, полом и частотой посещения респондентами развлекательного центра — есть слабые, но статистически значимые зависимости. Вместе с тем было уста​новлено, что больше половины (55 %) ячеек в перекрестной таблице имеют ожи​даемые частоты меньше 5 — из чего следует вывод о неприменимости теста 
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 и сопутствующих асимптотических тестов (Gamma и Cramer's V) в нашем случае. В принципе мы ответили на второй пункт задачи (условие см. выше) и можем сказать, что различия, выявленные в ходе перекрестного анализа (см. табл. 4.2), действительно имеют место и являются статистически значимыми. Однако доб​росовестный аналитик в такой ситуации все же попытается доказать истинность сделанных выводов.

Когда анализируемые данные не удовлетворяют требованиям, предъявляемым асимптотическими методами (как, например, в нашем случае 
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), есть другая воз​можность установить статистическую значимость исследуемой зависимости. Это позволяют сделать точные (Exact) тесты.

Откройте главное диалоговое окно перекрестного анализа Crosstabs (см. рис. 4.1), щелкнув на кнопке Exact. В появившемся диалоговом окне Exact Tests (рис. 4.9) по умолчанию установлен расчет только асимптотических критериев. Данное диало​говое окно позволяет провести расчеты по двум неасимптотическим методам: Monte-Carlo и Exact, причем последний метод не рекомендуется использовать в практичес​ких целях, так как он занимает много времени. Для практических целей следует применять метод Monte-Carlo с установленным по умолчанию количеством выбо​рок (10 000). Доверительный уровень 99 % практически всегда является слишком высоким, поэтому измените его на 95 %, что соответствует доверительному уров​ню при расчете статистической ошибки выборки для маркетинговых исследова​ний (см. раздел 1.2). Все остальные параметры диалогового окна Crosstabs аналогичны указанным в предыдущем примере. Теперь можно запустить проце​дуру построения перекрестных распределений.

После завершения всех необходимых расчетов в окне SPSS Viewer будут выведе​ны результаты. Их структура аналогична рассмотренной выше, за исключением того, что таблицы Chi-Square Tests и Symmetric Measures расширены за счет результа​тов теста Monte-Carlo. Единственным практическим результатом данного теста является рассчитанная статистическая значимость критериев, указанных в диало​говом окне Statistics (см. рис. 4.5).

На рис. 4.10 представлена таблица Chi-Square Tests с результатами теста Monte-Carlo. Искомые значения статистической значимости представлены в столбце Monte Carlo Sig. (2-sided) в подстолбце Sig.. В подстолбцах Lower Bound и Upper Bound показаны, соответственно, нижний и верхний пределы, в которых варьируется значение стати​стической значимости Sig.. Так, в нашем случае критерий 
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 действительно свиде​тельствует о наличии статистически значимой зависимости между полом, возрас​том и частотой посещения развлекательного центра — это следует из весьма высокой значимости теста Monte-Carlo (0,001 — для мужчин и 0,012 — для женщин). В 95 % случаев данное значение не выходит за рамки статистической значимости (например, для мужчин оно варьируется в пределах от 0,001 до 0,002). Также из таблицы мы ви​дим, что выявленная связь является линейной только для целевой группы респонден​тов-женщин. Таким образом, для нашего случая все предварительные выводы, сде​ланные нами в таблице Chi-Square Tests, подтвердились результатами теста Monte-Carlo.


Теперь рассмотрим таблицу Symmetric Measures (рис. 4.11), на основании которой мы сделали выводы о силе выявленной зависимости. Результаты теста Monte-Carlo и в данном случае подтверждают выводы асимптотического метода: между часто​той посещения центра и возрастом в целевой группе респондентов-женщин выяв​лена слабая статистически значимая зависимость. Для мужчин зависимость ста​тистически незначима.

Таким образом, мы выяснили, что между частотой посещения развлекательного центра и возрастом респондентов-женщин существует статистически значимая зависимость, характеризующаяся слабой положительной линейностью. Для рес​пондентов-мужчин возраст и частота посещения центра также связаны статисти​чески значимой зависимостью, однако сделать точный вывод о характере данной зависимости не представляется возможным.

Вернемся к табл. 4.2 и покажем, как интерпретировать представленные в ней дан​ные. На основании проведенных расчетов можно утверждать, что мужчины в воз​расте старше 51 года посещают развлекательный центр реже всего (примерно 2 раза в неделю). Наиболее частыми посетителями развлекательного центра являются мужчины в возрасте младше 50 лет (примерно 3 раза в месяц). В целевой группе женщин можно выделить три группы. Наиболее частыми посетителями являются женщины в возрасте 31-35 лет (примерно 4 раза в неделю). Среднюю группу (при​мерно 3 раза в неделю) составляют женщины младше 30 лет, от 36 до 40 лет и стар​ше 46 лет. И наконец, группу респондентов-женщин, посещающих центр реже все​го, составляет возрастная группа от 41 до 45 лет.

4.1.2. Перекрестные распределения для многовариантных вопросов

Как уже было сказано выше (см. раздел 3.2), все статистические процедуры при​менимы только для одновариантных вопросов. На практике установить статисти​ческую зависимость в многовариантных вопросах можно только двумя способами.

■ Визуально. В этом случае аналитик должен самостоятельно (на основании опыта или опираясь на другие данные, выявленные в ходе исследования) попытаться сделать заключение о значимости различий между двумя переменными. На​пример, если мужчины покупают сметану в упаковке в 4 раза чаще, чем женщи​ны, и при этом число респондентов, ответивших на данный вопрос, достаточно велико (скажем, 100 человек), можно сделать вывод о статистической значимо​сти данного различия.

■   Можно рассматривать многовариантный вопрос как несколько дихотомических переменных с вариантами ответа «есть/нет» и строить по ним стандартные пе​рекрестные распределения (при помощи процедуры Crosstabs). На практике в подавляющем большинстве случаев именно данный способ является оптималь​ным. Тем не менее необходимо отметить, что дихотомические переменные, яв​ляющиеся вариантами ответа на многовариантный вопрос, могут принимать участие даже в корреляционном анализе в качестве порядковых переменных (см. раздел 4.2).

Кроме существенных ограничений при установлении статистических зависимо​стей между многовариантными переменными, их анализ осложнен также и тем, что результаты перекрестных распределений по многовариантным вопросам SPSS выводит только в виде простого текста (plain text)1.
Ниже мы проиллюстрируем процесс построения перекрестных распределений по многовариантным переменным на примере двух многовариантных вопросов из маркетингового исследования московского рынка сметаны. Первый вопрос Где Вы покупаете сметану? (q7) с вариантами ответа:

■   продмаг (q7_l);
■   рынок (q7_2);
■   супермаркет (q7_3);
■   палатка (q7_4);
■   универсам (q7_5).
Второй вопрос Какую сметану Вы предпочитаете? с вариантами ответа:

■   в упаковке (ql6_l);
■   развесную (ql6_2).
Как было сказано выше в разделе 2.2.2, чтобы строить распределения (линейные или перекрестные) по многовариантным переменным, сначала их нужно сформи​ровать. Мы не будем возвращаться к процедуре создания многовариантных пере​менных при помощи меню Analyze ► Multiple Response ► Define Sets; этот процесс опи​сан в разделе 2.2.2. Давайте исходить из того, что вы самостоятельно сформировали две многовариантные переменные, назовем их q7 (Место покупки сметаны) и ql6 (Наи​более предпочтительная для респондентов упаковка сметаны). Теперь можно заняться построением перекрестного распределения по этим вопросам, то есть ответить на вопрос: «Зависят ли предпочтения респондентов в отношении сметаны (упако​ванной или развесной) от места совершения покупки?».

Построение перекрестного распределения по многовариантным вопросам осуще​ствляется при помощи меню Analyze ► Multiple Response ► Crosstabs. В открывшемся диалоговом окне (рис. 4.12) слева вы видите два списка переменных. В верхнем находятся все доступные переменные из файла данных (включая и дихотомиче​ские переменные — варианты ответа на анализируемые многовариантные вопро​сы). Нижний список содержит только сформированные нами многовариантные переменные ($q7 и $ql6). В перекрестном анализе могут принимать участие как

многовариантные переменные, так и другие доступные одновариантные перемен​ные. Как для кросстабуляций (см. раздел 4.1.1), для перекрестных таблиц можно задать несколько измерений (максимум три) при помощи введения одного допол​нительного слоя (область Layer). Имейте в виду, что при построении перекрестных таблиц, переменные, находящиеся в областях Row(s), Column(s) и Layer(s), перекре​щиваются по тройкам последовательно.

Итак, поместите в область Row(s) переменную Место покупки сметаны (q7), а в об​ласть Column(s) — переменную Предпочтения сметаны (ql6). В область Layer(s) поме​стите переменную Пол (q3).
Как вы поняли, мы будем рассматривать трехмерное перекрестное распределение. Обратите внимание на то, что при внесении в одну из трех областей переменной из верхнего левого списка (всех доступных переменных в базе данных) после имени этой переменной появляется строка символов вида (? ?) и становится доступной кнопка Define Ranges. Это подсказывает нам, что следует ввести границы измене​ния одновариантной переменной. Выделите переменную q3 в поле Layer(s) и щелк​ните на кнопке Define Ranges.
На экране появится новое диалоговое окно Define Variable Ranges (рис. 4.13). В нем в соответствующих полях следует указать минимальное Minimum и максималь​ное Maximum значения, которые может принимать данная переменная. В нашем случае пол респондентов может быть либо мужским (код 1), либо женским (код 2). Поэтому введите 1 в качестве минимального значения, а 2 — в качестве макси​мального и щелкните на кнопке Continue для того, чтобы закрыть это диалоговое окно.

Необходимо отметить, что переменные, участвующие в рассматриваемом статис​тическом анализе, для которых указываются интервалы допустимых значений, должны принимать только целые значения (дробные SPSS будет игнорировать). Это связано с ограничением при использовании в кросстабуляциях по многовари​антным вопросам переменных с интервальной шкалой. Такие переменные могут использоваться, только если они принимают целые значения.

Щелкните на кнопке Options. Открывшееся диалоговое окно (рис. 4.14) позво​ляет указать, нужно ли выводить проценты (по строкам — Row, по столбцам — Column или общие — Total), а также определить, что является базой для расчета процентов: количество респондентов (Cases) или количество ответов на вопрос (Responses)1.


Давайте выведем проценты по строкам (то есть доли респондентов, предпочитаю​щих разный вид сметаны в каждом из пяти рассматриваемых типов торговых то​чек). Оставьте выбранный по умолчанию параметр Cases в области Percentages Based on — это позволит вам рассчитать проценты от общего числа респондентов (гис​тограмма), а не от количества ответов на вопрос (сектограмма). Щелкните на кнопке Continue для того, чтобы закрыть диалоговое окно, и запустите процедуру построе​ния перекрестного распределения при помощи щелчка на кнопке О К в главном диалоговом окне программы.

В окне SPSS Viewer будет выведена перекрестная таблица с результатами рас​четов. Обратите внимание, что таблица разбита на две части: первая содержит результаты построения перекрестного распределения предпочтений сметаны и места покупки для мужчин (рис. 4.15), а вторая — для женщин (рис. 4.16). Та​ким образом, можно сказать, что собственно построения перекрестного распре​деления по трем заданным переменным (включая переменную Пол) не проис​ходит.

Переменная, указанная в качестве слоя (Layer), не отображается в таблице. Вместо этого ее значение (для каждого из вариантов ответа, в нашем случае — мужчины и женщины) отображается в верхней части каждой кросстабуляции как текст Category = 1 Мужчины (для мужчин) и Category = 2 Женщины (для женщин).



В нижней части под всеми таблицами расположены две строки, содержащие ин​формацию об общих параметрах построения перекрестных распределений. Так, в нашем случае мы видим, что все проценты, представленные в таблицах, рассчита​ны от общего числа респондентов (Percents and totals based on respondents). Во вто​рой строке отражаются:

■   количество результативных анкет (то есть анкет, в которых респонденты отве​тили на три вопроса) — 940 valid cases;
■   количество анкет, не включенных в анализ (респонденты не дали ответа хотя бы на один из трех вопросов), — 63 missing cases.
Общий размер выборки равен сумме результативных и исключенных анкет: 1003 = 940 + 63. В таблицах приведены результаты построения перекрестного распределе​ния предпочтений респондентов по типу сметаны в зависимости от места покупки. Необходимо отметить, что проценты в ячейках таблицы отражают доли покупате​лей, предпочитающих сметану в упаковке и развесную для каждого из рассматрива​емых мест покупки. Например, 75,5 % мужчин, покупающих сметану в продоволь​ственных магазинах, предпочитают сметану в упаковке, а 24,5 % — развесную1.

Проценты в строке Column Total отражают доли респондентов, предпочитающих сметану в упаковке или развесную, от общего числа респондентов (в нашем случае мужского или женского пола), ответивших на рассматриваемые вопросы. Напри​мер, 79 % мужчин, ответивших на рассматриваемые вопросы, предпочитают упа​кованную сметану, а 21 % — развесную.

Проценты в столбце Row Total отражают доли респондентов, покупающих сметану в различных торговых точках. На рис. 4.15 вы видите, что 51,9 % мужчин, ответив​ших на рассматриваемые вопросы, покупают сметану в продовольственных магази​нах. Значения на пересечении строки Column Total и столбца Row Total показывают общее количество респондентов мужского пола, ответивших на вопросы о пред​почтениях сметаны и месте покупки (как и всегда, в абсолютных и относительных величинах). В нашем случае на рассматриваемые вопросы ответил 181 мужчина. Обратите внимание, что длинные таблицы, выводимые в виде текста, могут по умолчанию не отражаться полностью в окне SPSS Viewer. Чтобы убедиться, что вы видите таблицу целиком, дважды щелкните мышью на ней. Откроется специ​альная область с возможностью прокрутки, в которой вы можете увидеть все пост​роенные таблицы.

4.2. Корреляционный анализ

Корреляционный анализ предназначен для выявления наличия, а также опреде​ления направления и силы линейной связи между несколькими переменными, имеющими интервальный или порядковый тип шкалы. Необходимо отметить, что дихотомические переменные также могут принимать участие в корреляционном анализе. С точки зрения SPSS они рассматриваются как порядковые переменные.

В табл. 4.3 представлены основные характеристики переменных, участвующих в анализе.
Таблица 4.3. Основные характеристики переменных, участвующих в корреляционном анализе

	Корреляционный анализ

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	_
	_
	Любое
	Интервальная

	
	
	
	Порядковая

	
	
	
	Дихотомическая


Наличие, направление и силу линейной связи отражают коэффициенты корреля​ции. Они варьируются от -1 до +1.

■   -1 соответствует абсолютно разнонаправленной зависимости (с возрастанием одной переменной другая убывает);

■   +1 отражает полное соответствие между переменными (то есть они, по сути, являются одним и тем же);

■   0 показывает полное отсутствие всякой связи.

Для удобства интерпретации корреляций применяются семантические интерва​лы, причем при анализе данных в маркетинговых исследованиях обычно исполь​зуются следующие градации (табл. 4.4).
Таблица 4.4. Градации коэффициентов корреляции

	Значение коэффициента корреляции
	Характеристика силы линейной связи

	От ±0,81 до ±1,00
	Сильная

	От ±0,61 до ±0,80
	Умеренная (средняя)

	От ±0,41 до ±0,60
	Слабая

	От ±0,21 до ±0,40
	Очень слабая

	От ±0,00 до ±0,20
	Нет корреляции


Существует два основных типа коэффициентов корреляции, рассчитываемых в за​висимости от вида шкалы переменных, участвующих в анализе.

1.   Для переменных с интервальной шкалой применяется коэффициент корреля​ции Пирсона. Он позволяет охарактеризовать линейную связь между двумя пе​ременными по указанным параметрам (табл. 4.4): наличию (есть/нет), направле​нию (убывает/возрастает) и силе (очень слабая/слабая/умеренная/сильная).

2.   Если хотя бы одна из пары исследуемых переменных имеет порядковую или дихотомическую шкалу, используются ранговые коэффициенты корреляции Спирмана или Кендала. Чаще всего эти коэффициенты применяются в марке​тинговых исследованиях в тех случаях, когда необходимо установить степень соответствия двух ранжированных списков. Например, если имеются схемы выбора какого-либо продукта различными целевыми группами респондентов (в виде ранжированных по важности параметров) и необходимо установить, насколько точно они соответствуют друг другу (или различаются).

Ниже мы рассмотрим перечисленные типы коэффициентов корреляции более под​робно на практических примерах из маркетинговых исследований.

4.2.1. Исследование линейных корреляций по Пирсону, Спирману и Кендалу
Сначала мы рассмотрим пример применения коэффициента корреляции Пирсо​на. Предположим, что у нас есть ответы респондентов на следующие два вопроса. Каков Ваш среднемесячный доход в расчете на одного члена семьи? с вариантами ответа:

■   до $100;

■   от $ 100 до $ 300;

■   от $ 300 до $ 600;

■   от $ 600 до $ 1000;

■   от $ 1000 до $ 1500;

■   свыше $1500.

Как часто Вы посещаете рестораны? с вариантами ответа:

■   более 1 раза в день;

■   примерно 1 раз в день;

■   2-3 раза в неделю;

■   примерно 1 раз в неделю;

■   2-3 раза в месяц;

■   примерно 1 раз в месяц;

■   реже 1 раза в месяц.

В результате ввода в компьютер заполненных анкет респондентов были получены две переменные: q3 (первый вопрос) и q28 (второй вопрос). Необходимо устано​вить, зависит ли частота посещения ресторанов от дохода респондентов, и если да, то каким образом. В связи с тем, что в ходе опроса при ответе на каждый вопрос респондентам предлагалось на выбор несколько вариантов ответа, тип шкалы у полученных переменных получился порядковым (в файле данных есть только коды ответов, но не сами числовые значения, отражающие частоту посещения рестора​на или уровень дохода).

Далее мы рассмотрим не только как использовать коэффициент корреляции Пир​сона, но также как использовать данный коэффициент для анализа квазипорядко​вых переменных. Дело в том, что некоторые переменные, хотя они и закодированы как порядковые, по сути являются интервальными (как в нашем случае). Это де​лается специально, чтобы, с одной стороны, увеличить долю респондентов, от​ветивших на вопрос, а с другой стороны, уменьшить число возможных ошибок при вводе в компьютер текстовых полей (для открытых вопросов). Интервалы также полезны при анализе, поскольку нет необходимости кодировать текстовые (или интервальные) переменные, а можно сразу увидеть группы (интервалы) значений. Практика показывает, что подобное составление анкет для маркетинговых иссле​дований является стандартным, поэтому корреляционный анализ редко проводится на изначально интервальных переменных (текстовые поля анкеты).

Для описываемых квазипорядковых переменных следует применять именно ко​эффициент корреляции Пирсона. Использование коэффициентов Спирмана или Кендала в этом случае является некорректным. Более подробно эти два коэффи​циента представлены ниже; пока же в общих чертах о них можно сказать следую​щее. Коэффициенты Спирмана или Кендала показывают только степень соответ​ствия порядка следования вариантов ответа в ранжированных списках (есть отсутствие инверсий). При этом корреляции по Спирману и Кендалу используют​ся в основном, когда элементы ранжированных списков представлены мнемони​ческими, а не числовыми константами. Таким образом, данные коэффициенты не помогут нам в характеристике зависимости между частотой посещения рестора​нов и доходом респондентов. Однако в нашем случае нельзя применять и коэффи​циент корреляции Пирсона, так как в этом случае анализировались бы коды ин​тервалов (1 -6 — в первом вопросе и 1 -7 — во втором), а не действительные ответы респондентов на вопросы1.

Итак, сначала мы должны преобразовать имеющиеся у нас порядковые перемен​ные к интервальному виду. Лучше всего сделать это при помощи замены кодов интервалов (1-6) на средние значения данных интервалов. Например, среднее зна​чение для интервала 3 в переменной q3 — это $ 450 (450 = (300 + 600) / 2). Преоб​разовав обе переменные к данному виду, мы получим следующие интервальные переменные q3_i и q28_i (табл. 4.5)2.
Таблица 4.5. Схема перекодировки порядковых переменных (q3 и q28) в интервальные (q3_i и q28_i)
	Порядковые переменные
	Интервальные переменные

	Каков Ваш среднемесячный доход в расчете на одного члена семьи?

	до $ 100
	$50

	от $ 100 до $ 300
	$200

	от $ 300 до $ 600
	$450

	от $ 600 до $ 1000
	$ 800

	от $ 1000 до $ 1500
	$ 1250

	свыше $ 1500
	$ 1750

	Как часто Вы посещаете рестораны?

	более 1 раза в день
	60 раз в месяц

	примерно 1 раз в день
	30 раз в месяц

	2-3 раза в неделю
	10 раз в месяц

	примерно 1 раз в неделю
	4 раза в месяц

	2-3 раза в месяц
	2,5 раза в месяц

	примерно 1 раз в месяц
	1 раз в месяц

	реже 1 раза в месяц
	0,5 раза в месяц


Теперь мы можем приступить непосредственно к корреляционному анализу (опи​санию зависимости между частотой посещения ресторанов и уровнем дохода). Для этого выберите пункт меню Analyze ► Correlate ► Bivariate. В открывшемся диалого​вом окне (рис. 4.17) выберите в левом списке всех доступных переменных две ин​тересующие нас (q3_i и q28_i) и перенесите их в область Variables. Остальные пара​метры в этом диалоговом окне, установленные по умолчанию, следует оставить неизменными: вывод коэффициентов корреляции Пирсона (параметр Pearson в области Correlation Coefficients) и статистической значимости коэффициентов (па​раметр Two-tailed в области Test of Significance). Кнопка Options не предлагает иссле​дователю каких-либо существенных параметров. Чтобы запустить процедуру по​строения корреляционной таблицы, щелкните на кнопке ОК.

В окне SPSS Viewer появится таблица Correlations с результатами расчетов коэффи​циента корреляции Пирсона и статистической значимости данного коэффициента. Как видно из рис. 4.18, в нашем случае коэффициент корреляции Пирсона между двумя исследуемыми переменными (q3_i и q28_i) равен +0,665, а его статистическая значимость меньше 0,001. Следовательно, можно сделать вывод о том, что между среднемесячным доходом респондентов и частотой посещения ими ресторанов су​ществует статистически значимая умеренная (средняя) линейная возрастающая за​висимость. То есть частота посещения ресторанов в достаточно высокой степени (коэффициент Пирсона = 0,7) зависит от уровня доходов потребителей, причем при росте среднемесячного дохода частота посещения ресторанов линейно возрастает.

Существует возможность проводить корреляционный анализ сразу для нескольких переменных. Для этого необходимо поместить эти переменные в область Variables диалогового окна Bivariate Correlations. В таблице Correlations будут показаны коэф​фициенты корреляции для каждой пары исследуемых переменных.

Теперь рассмотрим процедуру проведения корреляционного анализа при помощи ранговых коэффициентов Спирмана и Кендала. В данных методах одна перемен​ная (эталонная) представлена в виде ранжированной последовательности мнемо​нических категорий, а другой переменной присваиваются ранговые места. Корре​ляционные коэффициенты рассчитываются исходя из количества инверсий, то есть числа нарушений порядка следования рангов по сравнению с первым рядом. В большинстве случаев рекомендуется применять коэффициент корреляции Спирмана. Использование коэффициента Кендала оправдано только в том случае, когда в структуре данных имеются выбросы.


В практике маркетинговых исследований наиболее часто коэффициенты корре​ляции Спирмана применяются для анализа не всей выборочной совокупности рес​пондентов (базы данных в целом), а агрегированных ранжированных перечней, полученных в результате других преобразований1. Приведем пример. Предположим, что в результате опроса посетителей магазинов одежды были по​лучены ответы на следующие два вопроса. Какие факторы для Вас наиболее важны при выборе одежды? с вариантами ответа:

■   Высокое качество одежды.

■   Доступные цены.

■   Широта ассортимента одежды.

■   Близость к дому или работе.

■   Высокое качество обслуживания.

■   Красивый интерьер магазина.

Оцените, пожалуйста, следующие характеристики данного магазина одежды (в котором происходит опрос) по пятибалльной шкале (от 1 — очень плохо до 5 — отлично) с ва​риантами ответа:

■   Высокое качество одежды.

■   Доступные цены.

■   Широта ассортимента одежды.

■   Близость к дому или работе.

■   Высокое качество обслуживания.

■   Красивый интерьер магазина.

■   Ваша общая оценка работы данного магазина.

Над результатами второго вопроса был проведен множественный линейный рег​рессионный анализ. Анализировалось влияние оценок частных параметров всех исследованных магазинов одежды на их общую оценку. В разделе 4.3 подробно рассматривается процедура линейного регрессионного анализа, позволяющая, в частности, построить ранжированный перечень частных параметров по силе их влияния на общую оценку.

Таким образом, были получены два ранжированных списка с одинаковыми катего​риями: две схемы выбора магазина одежды. Затем оба списка были введены в SPSS под кодами, представленными выше: от 1 (наиболее важный фактор) до 6 (наименее важный фактор) (рис. 4.19). На рис. 4.20 представлены данные списки в мнемони​ческой форме. Первый список представлен в переменной sc_l; второй — в sc_2.



Как вы видите на рис. 4.20, две схемы выбора, составленные на основании прямого метода (вопрос 1) и на основании регрессионного анализа (вопрос 2), соответству​ют друг другу не полностью, различаясь в порядке следования первой и второй категорий. Проанализируем эти схемы выбора магазинов одежды на предмет со​ответствия при помощи коэффициента корреляции Спирмана.

Для этого снова откройте диалоговое окно Bi variate Correlations, выбрав пункт меню Analyze ► Correlate ► Bivariate. Перенесите две интересующие нас переменные — Схе​ма №1 (составленная по вопросу 1) и Схема №2 (составленная по вопросу 2) — из левого списка всех доступных переменных в область Variables (рис. 4.21). Отмени​те вывод корреляции Пирсона и вместо него выберите параметр Spearman (корре​ляция Спирмана). После этого начните расчет при помощи щелчка на кнопке ОК.

В окне SPSS Viewer появится таблица Correlations с результатами расчета коэффи​циента ранговой корреляции (Спирмана) по двум анализируемым переменным. Как следует из рис. 4.22, две рассматриваемые схемы выбора различаются несуще​ственно. Данный вывод можно сделать из сильной корреляции между переменны​ми sc_l и sc_2 (коэффициент корреляции Спирмана = 0,9), характеризующейся весьма высокой статистической значимостью (0,005).

В заключение напомним, что ранговый коэффициент корреляции Спирмана (в от​личие от Кендала) может применяться и в качестве аналога корреляции Пирсона при исследовании зависимостей между переменными, не приводимыми к интер​вальному виду и потому не являющимися ранжированными списками. В качестве примера можно привести гипотетический случай, рассмотренный выше, когда анализируется влияние пола респондентов (дихотомическая шкала) на уровень обра​зования (порядковая по сути, но номинальная по виду шкала).

4.2.2. Частные корреляции. Выявление ложных корреляций
На практике иногда возникают ситуации, когда в результате корреляционного ана​лиза обнаруживаются логически необъяснимые, противоречащие объективному опыту исследователя корреляции между двумя переменными (например, оказы​вается, что между уровнем дохода респондентов и количеством детей в семье сущес​твует статистически значимая зависимость). В этом случае говорят о так называе​мой ложной корреляции, исследовать которую помогают частные коэффициенты корреляции.

Рассмотрим процедуру исследования частных корреляций на следующем приме​ре из маркетингового исследования поведения посетителей залов игровых авто​матов. В результате обработки анкет респондентов были, в частности, получены три интервальные переменные:

■   q47 — возраст;

■   q49 — количество членов семьи;

■   q50 — среднемесячный доход на 1 члена семьи.

Над данными переменными был проведен корреляционный анализ (Пирсона), который выявил логически необъяснимую, но статистически значимую зависи​мость между переменными: Доход и Количество членов семьи (рис. 4.23).

Как видно из таблицы, обе рассматриваемые переменные коррелируют с третьей переменной Возраст. В такой ситуации корреляция между уровнем дохода респон​дентов и численностью их семей может объясняться влиянием третьей перемен​ной: возраста респондентов. То есть связанными (коррелирующими), на самом деле, являются пары возраст/уровень дохода и возраст/количество членов семьи. Прове​рим данную гипотезу при помощи частных коэффициентов корреляции.

Откройте диалоговое окно Partial Correlations (меню Analyze ► Correlate ► Partial). В ле​вом списке всех доступных переменных выберите переменные, между которыми обнаружена странная корреляция (q50 Доход и q49 Количество членов семьи), и поместите их в область Variables. Переменную, с которой коррелируют обе исследуе​мые переменные (q47 Возраст), поместите в область Controlling for (рис. 4.24). В этом диалоговом окне больше ничего не изменяйте — просто запустите программу на исполнение, щелкнув на кнопке ОК.

В окне SPSS Viewer появятся результаты расчетов частных коэффициентов кор​реляции (рис. 4.25). В данной таблице первая строка каждой ячейки содержит ко​эффициент корреляции Пирсона, а третья — статистическую значимость данного коэффициента. Из таблицы вы видите, что между количеством членов семьи (q49) и уровнем дохода (q50) больше не наблюдается статистически значимой корреля​ции (Р = 0,520), а коэффициент Пирсона сильно уменьшился (0,0256). Следова​тельно, корреляция, представленная на рис. 4.23, объясняется влиянием третьей переменной Возраст и, таким образом, является ложной.


4.3. Линейный регрессионный анализ и статистическое 
прогнозирование
Линейная регрессия является наиболее часто используемым видом регрессионно​го анализа. Ниже перечислены три основные задачи, решаемые в маркетинговых исследованиях при помощи линейного регрессионного анализа.

1.   Определение того, какие частные параметры продукта оказывают влияние на общее впечатление потребителей от данного продукта. Установление направ​ления и силы данного влияния. Расчет, каким будет значение результирующе​го параметра при тех или иных значениях частных параметров. Например, тре​буется установить, как влияет возраст респондента и его среднемесячный доход на частоту покупок глазированных сырков.

2.   Выявление того, какие частные характеристики продукта влияют на общее впе​чатление потребителей от данного продукта (построение схемы выбора продук​та потребителями). Установление соотношения между различными частными па​раметрами по силе и направлению влияния на общее впечатление. Например, имеются оценки респондентами двух характеристик мебели производителя X — цены и качества, — а также общая оценка мебели данного производителя. Требу​ется установить, какой из двух параметров является наиболее значимым для покупате​лей при выборе производителя мебели и в каком конкретном соотношении находится значимость для покупателей данных двух факторов (параметр Цена в х раз более значим для покупателей при выборе мебели, чем параметр Качество).

3.   Графическое прогнозирование поведения одной переменной в зависимости от изменения другой (используется только для двух переменных). Как правило, целью проведения регрессионного анализа в данном случае является не столько расчет уравнения, сколько построение тренда (то есть аппроксимирующей кри​вой, графически показывающей зависимость между переменными). По полу​ченному уравнению можно предсказать, каким будет значение одной перемен​ной при изменении (увеличении или уменьшении) другой. Например, требуется установить характер зависимости между долей респондентов, осведомленных о раз​личных марках глазированных сырков, и долей респондентов, покупающих данные марки. Также требуется рассчитать, насколько возрастет доля покупателей сырков марки х при увеличении потребительской осведомленности на 10 % (в результате про​ведения рекламной кампании).

В зависимости от типа решаемой задачи выбирается вид линейного регрессионно​го анализа. В большинстве случаев (1 и 2) применяется множественная линейная регрессия, в которой исследуется влияние нескольких независимых переменных на одну зависимую. В случае 3 применима только простая линейная регрессия, в которой участвуют только одна независимая и одна зависимая переменные. Это связано с тем, что основным результатом анализа в случае 3 является линия трен​да, которая может быть логически интерпретирована только в двухмерном про​странстве. В общем случае результатом проведения регрессионного анализа явля​ется построение уравнения регрессии вида: у = а + Ь,х, + Ь2х2 + ... + Ь„хп, позволяющего рассчитать значение зависимой переменной при различных значе​ниях независимых переменных.

В табл. 4.6 представлены основные характеристики переменных, участвующих в анализе.

Таблица 4.6. Основные характеристики переменных, участвующих в линейном регрессионном анализе

	Линейная регрессия

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	Одна
	Интервальная
	Любое
	Интервальная

	
	Порядковая
	
	Порядковая

	
	
	
	Дихотомическая


В связи с тем что и множественная и простая регрессии строятся в SPSS одинако​вым способом, рассмотрим общий случай множественной линейной регрессии как наиболее полно раскрывающий суть описываемого статистического метода. Да​вайте рассмотрим, как построить линию тренда с целью статистического прогно​зирования.

Исходные данные:

В ходе опроса респондентов, летающих одним из трех классов (первым, бизнес- или эко​ном-классом), просили оценить по пятибалльной шкале — от 1 (очень плохо) до 5 (отлич​но) — следующие характеристики сервиса на борту самолетов авиакомпании X: комфор​табельность салона, работа бортпроводников, питание во время полета, цена билетов, спиртные напитки, дорожные наборы, аудиопрограммы, видеопрограммы и пресса. Также респондентам предлагалось поставить общую (итоговую) оценку обслуживания на борту самолетов данной авиакомпании.

Для каждого класса полета требуется:

1)   Выявить наиболее значимые для респондентов параметры обслуживания на борту.

2)   Установить, какое влияние оказывают оценки частных параметров обслуживания на борту на общее впечатление авиапассажиров от полета.

Откройте диалоговое окно Linear Regression при помощи меню Analyze ► Regres​sion ► Linear. Из левого списка выберите зависимую переменную для анализа. Это будет Общая оценка сервиса на борту. Поместите ее в область Dependent. Далее в ле​вом списке выберите независимые переменные для анализа: частные параметры сервиса на борту — и поместите их в область Independent(s).
Существует несколько методов проведения регрессионного анализа: enter, stepwise, forward и backward. He вдаваясь в статистические тонкости, проведем регрессион​ный анализ посредством пошагового метода backward как наиболее универсально​го и релевантного для всех примеров из маркетинговых исследований.

Так как задача анализа содержит требование провести регрессионный анализ в раз​резе трех классов полета, выберите в левом списке переменную, обозначающую класс (q5) и перенесите ее в область Selection Variable. Затем щелкните на кнопке Rule, чтобы задать конкретное значение данной переменной для регрессионного анализа. Следует отметить, что за одну итерацию можно построить регрессию толь​ко в разрезе какого-то одного класса полета. В дальнейшем следует повторить все этапы сначала по количеству классов (3), каждый раз выбирая следующий класс.

Если нет необходимости проводить регрессионный анализ в каком-либо разрезе, оставьте поле Selection Variable пустым.

Итак, на экране открылось диалоговое окно Set Rule, в котором вы должны указать, для какого именно класса полета вы хотите построить регрессионную модель. Выберите экономический класс, закодированный как 3 (рис. 4.26).


В более сложных случаях, когда требуется построить регрессионную модель в раз​резе трех и более переменных, следует воспользоваться условным отбором дан​ных (см. раздел 1.5.1). Например, если кроме класса полета есть еще и необходи​мость раздельного построения регрессионной модели для респондентов (мужчин и женщин), необходимо перед открытием диалогового окна Linear Regression про​извести условный отбор анкет респондентов, являющихся мужчинами. Далее про​водится регрессионный анализ по описываемой схеме. Для построения регрес​сии для женщин следует повторить все этапы сначала: вначале выбрать только анкеты респондентов-женщин и затем уже для них построить регрессионную модель.

Щелкните на кнопке Continue в диалоговом окне Set Rule — вы вновь вернетесь к основному диалоговому окну Linear Regression. Последним шагом перед запуском процедуры построения регрессионной модели является выбор пункта Collinearity Diagnostics в диалоговом окне, появляющемся при щелчке на кнопке Statistics (рис. 4.27). Установление требования провести диагностику наличия коллинеар​ности между независимыми переменными позволяет избежать эффекта мульти-коллинеарности, при котором несколько независимых переменных могут иметь настолько сильную корреляцию, что в регрессионной модели обозначают, в прин​ципе, одно и то же (это неприемлемо).

Теперь основное диалоговое окно Linear Regression примет вид, показанный на рис. 4.28. Щелчок на кнопке О К приведет к запуску процедуры построения линей​ной регрессии.

Рассмотрим основные элементы отчета о построении регрессионной модели (окно SPSS Viewer), содержащие наиболее значимые для исследователя данные. Не​обходимо отметить, что все таблицы, представленные в отчете Output, содержат несколько блоков, соответствующих количеству шагов SPSS при построении модели. На каждом шаге при используемом методе backward из полного списка независимых переменных, введенных в модель изначально, при помощи наимень​ших частных коэффициентов корреляции последовательно исключаются пере​менные — до тех пор, пока соответствующий коэффициент регрессии не оказы​вается незначимым (Sig > 0,05). В нашем примере таблицы состоят из трех блоков (регрессия строилась в три шага). При интерпретации результатов регрессион​ного анализа следует обращать внимание только на последний блок (в нашем случае 3).

Первое, на что следует обратить внимание, — это таблица ANOVA (рис. 4.29). На третьем шаге статистическая значимость (столбец Sig) должна быть меньше или равна 0,05.

Затем следует рассмотреть таблицу Model Summary, содержащую важные сведения о построенной модели (рис. 4.30). Коэффициент детерминации R является харак​теристикой силы общей линейной связи между переменными в регрессионной модели. Он показывает, насколько хорошо выбранные независимые переменные способны определять поведение зависимой переменной. Чем выше коэффициент детерминации (изменяющийся в пределах от 0 до 1), тем лучше выбранные неза​висимые переменные подходят для определения поведения зависимой перемен​ной. Требования к коэффициенту R такие же, как к коэффициенту корреляции (см. табл. 4.4): в общем случае он должен превышать хотя бы 0,5. В нашем примере R = 0,66, что является приемлемым показателем.

Также важной характеристикой регрессионной модели является коэффициент R2, показывающий, какая доля совокупной вариации в зависимой переменной описывается выбранным набором независимых переменных. Величина R2 из​меняется от 0 до 1. Как правило, данный показатель должен превышать 0,5 (чем он выше, тем показательнее построенная регрессионная модель). В нашем при​мере R2 =■ 0,43 — это значит, что регрессионной моделью описано только 43 % случаев (дисперсии в итоговой оценке полета). Таким образом, при интерпре​тации результатов регрессионного анализа следует постоянно иметь в виду су​щественное ограничение: построенная модель справедлива только для 43 % случаев.

Третьим практически значимым показателем, определяющим качество регресси​онной модели, является величина стандартной ошибки расчетов (столбец Std. Error of the Estimate). Данный показатель варьируется в пределах от 0 до 1. Чем он мень​ше, тем надежнее модель (в общем случае показатель должен быть меньше 0,5). В нашем примере ошибка составляет 0,42, что является завышенным, но в целом приемлемым результатом.

На основании таблиц AN OVA и Model Summary можно судить о практической пригод​ности построенной регрессионной модели. Учитывая, что AN OVA показывает весь​ма высокую значимость (менее 0,001), коэффициент детерминации превышает 0,6, а стандартная ошибка расчетов меньше 0,5, можно сделать вывод о том, что с уче​том ограничения модель описывает 43 % совокупной дисперсии, то есть построен​ная регрессионная модель является статистически значимой и практически при​емлемой.

После того как мы констатировали приемлемый уровень качества регрессионной модели, можно приступать к интерпретации ее результатов. Основные практиче​ские результаты регрессии содержатся в таблице Coefficients (рис. 4.31). Под таб​лицей вы можете видеть, какая переменная была зависимой (общая оценка серви​са на борту) и для какого класса полета происходило построение регрессионной модели (эконом-класс). В таблице Coefficients практически значимыми являются четыре показателя: VIF, Beta, В и Std. Error. Рассмотрим последовательно, как их сле​дует интерпретировать.


Прежде всего необходимо исключить возможность возникновения ситуации мультиколлинеарности (см. выше), при которой несколько переменных могут обозна​чать почти одно и то же. Для этого необходимо посмотреть на значение VIF возле каждой независимой переменной. Если величина данного показателя меньше 10 — значит, эффекта мультиколлинеарности не наблюдается и регрессионная модель приемлема для дальнейшей интерпретации. Чем выше этот показатель, тем более связаны между собой переменные. Если какая-либо переменная превышает значение в 10 VIF, следует пересчитать регрессию без этой независимой переменной. В данном примере автоматически уменьшится величина R2 и возрастет величина свободного члена (константы), однако, несмотря на это, новая регрессионная мо​дель будет более практически приемлема, чем первая.

В первом столбце таблицы Coefficients содержатся независимые переменные, со​ставляющие регрессионное уравнение (удовлетворяющие требованию статисти​ческой значимости). В нашем случае в регрессионную модель входят все частные характеристики сервиса на борту самолета, кроме аудиопрограмм. Исключенные переменные содержатся в таблице Excluded Variables (здесь не приводится). Итак, мы можем сделать первый вывод о том, что на общее впечатление авиапассажиров от полета оказывают влияние семь параметров: комфортабельность салона, работа бортпроводников, питание во время полета, спиртные напитки, дорожные наборы, видеопрограммы и пресса.

После того, как мы определили состав параметров, формирующих итоговое впе​чатление от полета, можно определить направление и силу влияния на него каж​дого частного параметра. Это позволяет сделать столбец Beta, содержащий стан​дартизированные 
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- коэффициенты регрессии. Данные коэффициенты также дают возможность сравнить силу влияния параметров между собой. Знак (+ или -) пе​ред 
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-коэффициентом показывает направление связи между независимой и зави​симой переменными. Положительные 
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-коэффициенты свидетельствуют о том, что возрастание величины данного частного параметра увеличивает зависимую пере​менную (в нашем случае все независимые переменные ведут себя подобным обра​зом). Отрицательные коэффициенты означают, что при возрастании данного част​ного параметра общая оценка снижается. Как правило, при определении связи между оценками параметров это свидетельствует об ошибке и означает, например, что выборка слишком мала.

Например, если бы перед 
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- коэффициентом параметра работы бортпроводников стоял знак -, его следовало бы интерпретировать следующим образом: чем хуже работают бортпроводники, тем лучше становится общее впечатление пассажиров от полета. Такая интерпретация является бессмысленной и не отражающей реаль​ного положения вещей, то есть ложной. В таком случае лучше пересчитать регрес​сию без данного параметра; тогда доля вариации в итоговой оценке, описываемой исключенным параметром, будет отнесена на счет константы (увеличивая ее). Соответственно уменьшится и процент совокупной дисперсии, описываемой рег​рессионной моделью (величина R2). Однако это позволит восстановить семанти​ческую релевантность.

Еще раз подчеркнем, что сделанное замечание справедливо для нашего случая (оценки параметров). Отрицательные 
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- коэффициенты могут быть верными и от​ражать семантические реалии в других случаях. Например, когда уменьшение до​хода респондентов приводит к увеличению частоты покупок дешевых товаров. В таблице вы видите, что в наибольшей степени на общее впечатление пассажи​ров от полета влияют два параметра: работа бортпроводников и комфортабель​ность салона (
[image: image40.wmf]b

- коэффициенты по 0,21). Напротив, в наименьшей степени форми​рование итоговой оценки сервиса на борту происходит за счет впечатления от обслуживания спиртными напитками (0,08). При этом два первых параметра ока​зывают почти в три раза более сильное влияние на итоговую оценку полета, чем

спиртные напитки. На основании стандартизированных (3-коэффициентов регрес​сии можно построить рейтинг влияния частных параметров сервиса на борту на общее впечатление авиапассажиров от полета, разделив их на три группы по силе влияния:

■   наиболее значимые параметры;

■   параметры, имеющие среднюю значимость;

■   параметры, имеющие низкую значимость для респондентов (рис. 4.32).

В крайнем правом столбце содержатся 
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- коэффициенты, умноженные на 100, — для облегчения сравнения параметров между собой.

Данный рейтинг также можно интерпретировать и как рейтинг значимости для респондентов различных параметров сервиса на борту (в общем случае — схема выбора). Так, наиболее важными факторами являются первые два (1-2); среднюю значимость для пассажиров имеют следующие три параметра (3-5); относительно малое значение имеют последние два фактора (6-7).

Регрессионный анализ позволяет выявить истинные, глубинные мотивы респон​дентов при формировании общего впечатления о каком-либо продукте. Как пока​зывает практика, такого уровня приближения нельзя достичь обычными метода​ми — например, просто спросив респондентов: Какие факторы из нижеперечисленных оказывают наибольшее влияние на Ваше общее впечатление от полета самолетами нашей авиакомпании?. Кроме того, регрессионный анализ позволяет достаточно точно оце​нить, насколько один параметр более-менее значим для респондентов, чем другой, и на этом основании классифицировать параметры на критические, имеющие сред​нюю значимость и малозначимые.

Столбец В таблицы Coefficients содержит коэффициенты регрессии (нестандарти-зированные). Они служат для формирования собственно регрессионного уравне​ния, по которому можно рассчитать величину зависимой переменной при разных значениях независимых.

Особая строка Constant содержит важную информацию о полученной регрессион​ной модели: значение зависимой переменной при нулевых значениях независимых переменных. Чем выше значение константы, тем хуже подходит выбранный перечень независимых переменных для описания поведения зависимой перемен​ной. В общем случае считается, что константа не должна быть наибольшим коэффи​циентом в регрессионном уравнении (коэффициент хотя бы при одной переменой должен быть больше константы). Однако в практике маркетинговых исследова​ний часто свободный член оказывается больше всех коэффициентов вместе взя​тых. Это связано в основном с относительно малыми размерами выборок, с кото​рыми приходится работать маркетологам, а также с неаккуратным заполнением анкет (некоторые респонденты могут не поставить оценку каким-либо парамет​рам). В нашем случае величина константы меньше 1, что является весьма хоро​шим результатом.

Итак, в результате построения регрессионной модели можно сформировать сле​дующее регрессионное уравнение:

СБ = 0,78 + 0,20К + 0.20Б + 0,08ПП + 0.07С + 0Д0Н + 0,08В + 0Д2П, где

■   СБ — общая оценка сервиса на борту;

■   К — комфортабельность салона;

■   Б — работа бортпроводников;

■   ПП — питание во время полета;

■   С — спиртные напитки;

■   Н — дорожные наборы;

■   В — видеопрограмма;

■   П — пресса.

Последний показатель, на который целесообразно обращать внимание при интер​претации результатов регрессионного анализа, — это стандартная ошибка, рассчи​тываемая для каждого коэффициента в регрессионном уравнении (столбец Std. Error). При 95%-ном доверительном уровне каждый коэффициент может отклоняться от величины В на ±2 х Std.Error. Это означает, что, например, коэффициент при пара​метре Комфортабельность салона (равный 0,202) в 95 % случаев может отклоняться от данного значения на ±2 х 0,016 или на ±0,032. Минимальное значение коэффициен​та будет равно 0,202 - 0,032 = 0,17; а максимальное - 0,202 + 0,032 = 0,234. Таким образом, в 95 % случаев коэффициент при параметре «комфортабельность салона» варьируется в пределах от 0,17 до 0,234 (при среднем значении 0,202). На этом интерпретация результатов регрессионного анализа может считаться за​вершенной. В нашем случае следует повторить все шаги еще раз: сначала для биз​нес -, потом для эконом-класса.

Теперь давайте рассмотрим другой случай, когда необходимо графически пред​ставить зависимость между двумя переменными (одной зависимой и одной неза​висимой) при помощи регрессионного анализа. Например, если мы примем итого​вую оценку полета авиакомпанией X в 2001 г. за зависимую переменную S,, а тот же показатель в 2000 г. — за независимую переменную So, то для построения урав​нения тренда (или регрессионного уравнения) нужно будет определить парамет​ры соотношения S, = а + b x So. Построив данное уравнение, также можно построить регрессионную прямую и, зная исходную итоговую оценку полета, спрогнози​ровать величину данного параметра на следующий год.

Эту операцию следует начать с построения регрессионного уравнения. Для этого повторите все вышеописанные шаги для двух переменных: зависимой Итоговая оценка 2001 и независимой Итоговая оценка 2000. Вы получите коэффициенты, при помощи которых можно в дальнейшем строить линию тренда (как в SPSS, так и любыми другими средствами). В нашем случае полученное регрессионное уравне​ние имеет вид: S{ = 0,18 + 0,81 х So. Теперь построим уравнение линии тренда в SPSS.
Диалоговое окно Linear Regression имеет встроенное средство для построения гра​фиков — кнопку Plots. Однако это средство, к сожалению, не позволяет на одном графике построить две переменные: S, и So- Для того чтобы построить тренд, необ​ходимо использовать меню Graphs ► Scatter. На экране появится диалоговое окно Scatterplot (рис. 4.32), которое служит для выбора типа диаграммы. Выберите вид Simple. Максимально возможное число независимых переменных, которое можно изобразить графически, — 2. Поэтому при необходимости графического построе​ния зависимости одной переменной (зависимой) от двух независимых (например, если бы в нашем распоряжении были данные не по двум, а по трем годам), в окне Scatterplot следует выбрать 3-D. Схема построения трехмерной диаграммы рассея​ния не имеет существенных отличий от описываемого способа построения двух​мерной диаграммы.

После щелчка на кнопке Define на экране появится новое диалоговое окно, пред​ставленное на рис. 4.34. Поместите в поле Y Axis зависимую переменную (Итоговая оценка 2001), а в поле X Axis — независимую (Итоговая оценка 2000). Щелкните на кнопке 0 К, что приведет к построению диаграммы рассеяния.

Для того чтобы построить линию тренда, дважды щелкните мышью на получен​ной диаграмме; откроется окно SPSS Chart Editor. В этом окне выберите пункт меню Chart ► Options; далее пункт Total в области Fit Line; щелкните на кнопке Fit Options. Откроется диалоговое окно Fit Line, выберите в нем тип аппроксимирующей ли​нии (в нашем случае Linear regression) и пункт Display R-square in legend. После за​крытия окна SPSS Chart Editor в окне SPSS Viewer появится линейный тренд, ап​проксимирующий наши наблюдения по методу наименьших квадратов. Также на диаграмме будет отражаться величина R2, которая, как было сказано выше, обо​значает долю совокупной вариации, описываемой данной моделью (рис. 4.35). В на​шем примере она равна 53 %.

С линейным регрессионным анализом связано множество интегральных показателей, рассчитываемых на основании коэффициентов регрессии (чаще всего стандартизированных). В качестве примера приведем расчет коэффициента потребительской привлекательности продукта/марки (Consumer Attractiveness), или коэффициента СА.



Этот коэффициент вводится в маркетинговых исследованиях для удобства сравне​ния привлекательности для респондентов анализируемых продуктов/марок. В анке​те должны присутствовать вопросы типа Оцените представленные параметры продукта/ марки X, в которых респондентам предлагается дать свои оценки частным параметрам продукта или марки X, скажем, по пятибалльной шкале (от 1 — очень плохо до 5 — отлично). В конце списка оцениваемых частных параметров респонденты должны поставить итоговую оценку продукту/марке X. При анализе полученных в ходе опро​са ответов респондентов на основании оценок респондентов формируются:

■   матрица средневзвешенных оценок по параметрам продукта/марки;

■   список стандартизированных 
[image: image42.wmf]b

 - коэффициентов регрессии (оценка влияния частных параметров продукта/марки X на его/ее общую оценку).

Далее коэффициент СА рассчитывается по следующей формуле:
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где n — число параметров, формирующих итоговую оценку продукта или марки:
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 - — значимость для респондентов параметра с индексом i (стандартизированный 
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-коэффициент регрессии, оценивающей влияние частных параметров на общую оценку продукта/марки, подробнее см. выше); 
[image: image47.wmf]i

m

 — уровень средневзвешенной оценки продукта/марки по параметру с индексом i (при наличии пятибалльной шкалы):
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 = 2               при высоком уровне оценки (средневзвешенный балл ≥ 4,5)
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 = 1               при среднем уровне оценки (средневзвешенный балл ≥4,0 и < 4,5)
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 = -1             при низком уровне оценки (средневзвешенный балл ≥3,0 и < 4,0)
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m

 = -2             при неудовлетворительной оценке (средневзвешенный балл < 3,0)

Рассчитанный для каждого конкурирующего продукта/марки коэффициент СА показывает его/ее относительную позицию в структуре потребительских предпоч​тений. Данный интегральный показатель учитывает уровень оценок по каждому параметру, скорректированный на их значимость. При этом он может изменяться в пределах от -1 (наихудшая относительная позиция среди всех рассматриваемых продуктов/марок) до 1 (наилучшее положение); 0 означает, что данный продукт/ марка ничем особенным не выделяется в глазах респондентов.

Итогом расчета коэффициента СА является рейтинг конкурентов по данному по​казателю. На основании рейтинга можно сделать важные выводы относительно лидерства и аутсайдерства конкретных продуктов/марок на потребительском рынке.

Мы завершаем рассмотрение ассоциативного анализа. Данная группа статисти​ческих методов применяется в отечественных компаниях в настоящее время дос​таточно широко (особенно это касается перекрестных распределений). Вместе с тем хотелось бы подчеркнуть, что только лишь перекрестными распределениями ассоциативные методы не ограничиваются. Для проведения действительно глубо​кого анализа следует расширить спектр применяемых методик за счет методов, описанных в настоящей главе.
Глава 5. Классификационный анализ
Цель классификационного анализа — классификация респон​дентов и/или переменных по определенным целевым группам. Наиболее распространенными примерами использования клас​сификационного анализа в маркетинговых исследованиях яв​ляются:
■   сегментирование респондентов по заранее известным (ло​гистическая регрессия и дискриминантный анализ) или не известным (факторный и кластерный анализ) целевым группам;
■   классификация переменных по макрокатегориям, то есть сокращение их числа до нескольких значимых групп (фак​торный и кластерный анализ).
Далее в разделе мы рассмотрим эти статистические методики в указанном порядке, а также приведем примеры задач из прак​тики маркетинговых исследований, решаемых с помощью классификационного анализа.
5.1. Логистическая регрессия и дискриминантный анализ
Логистическая регрессия и дискриминантный анализ приме​няются в том случае, когда необходимо классифицировать (сег​ментировать) респондентов по целевым группам, которые, в свою очередь, представлены уровнями (вариантами ответа) одной одновариантной переменной.
Примером задачи, решаемой при помощи этих статистических методов, может служить задача классифицировать респонден​тов по двум группам — покупающие горчицу и не покупаю​щие горчицу — на основании их социально-демографических характеристик (пол, возраст, доход, количество членов семьи и т. п.). Как вы видите, в процедурах логистической регрессии и дискриминантного анализа присутствуют переменные — критерии сегментирования и одна переменная, кодирующая целевые группы, на которые следует разделить респондентов на основании критериев сегментирования.
Необходимо отметить, что спектр возможностей применения логистической регрессии уже, чем для дискриминантного анализа, поэтому использование дискриминантного анализа в качестве универсального метода предпочтительнее. Боле того, рекомендуется всегда начинать классификационное исследование именно с дискриминантного анализа, а не с логистической регрессии, — и применять последнюю в случае неуверенности в результатах дискриминантного анализа. Это связано, в частности, с тем, что при применении методов логистической регрессии еле дует четко представлять, какой тип имеют зависимая и независимые переменные и, исходя из этого, выбирать одну из трех возможных процедур логистической регрессии: бинарную, мультиномиальную или порядковую. При дискриминантном анализе мы всегда имеем дело только с одной статистической процедурой, в которой принимают участие одна категориальная зависимая переменная и несколько независимых переменных с любым типом шкалы. Таким образом, дискриминантный анализ является более универсальной методикой (что особенно важно для исследователей, имеющих незначительный опыт в статистическом анализе дан​ных).
В разделах 5.1.1 и 5.1.2 мы на конкретных примерах покажем, как молено использо​вать процедуры логистической регрессии и дискриминантного анализа в марке​тинговых исследованиях. При этом мы увидим, что, несмотря на преимущества универсального дискриминантного анализа, логистическая регрессия в некоторых случаях дает наивысшую четкость классификации.
5.1.1. Бинарная и мультиномиальная логистические регрессии
В настоящем разделе мы рассмотрим два основных типа логистической регрес​сии — бинарную и мультиномиальную, а также дадим общий обзор порядковой логистической регрессии. Цель статистического анализа при применении мето​дов логистической регрессии — определить вероятность того, что тот или иной респондент (на основании определенных характеристик) попадет в ту или иную целевую группу. На практике описываемые методы, согласно значениям одной или нескольких независимых переменных (факторов), позволяют классифици​ровать респондентов по двум (бинарная) или более (мультиномиальная) груп​пам, которые выражаются уровнями (вариантами ответа) какой-либо одной пе​ременной.
Например, имеются ответы респондентов на вопрос Интересно ли Вам предложение о покупке земельного участка недалеко от Москвы? с вариантами ответа Да и Нет. Тре​буется выяснить, какие факторы в наибольшей степени определяют решение по​тенциальных покупателей о приобретении земельного участка. Для этого респон​дентам задается ряд вопросов с просьбой указать, какие элементы инфраструктуры им необходимы на данном участке, какое расстояние от Москвы является для них оптимальным, каков должен быть размер данного участка, должен ли на участке быть дом и т. п. Используя в данном случае метод бинарной логистической ре​грессии, можно классифицировать всех респондентов по двум целевым группам: заинтересованные в покупке земельного участка (потенциальные покупатели) и не заинтересованные. Также для каждого респондента в выборке будет рассчитана вероятность попадания в ту или иную группу.
Различие между рассматриваемыми двумя методами логистической регрессии за​ключаются в количестве категорий и типе зависимой переменной, а также типе независимых переменных. Так, в случае бинарной логистической регрессии ис​следуется зависимость дихотомической переменной от одной или нескольких независимых переменных, имеющих любой тип шкалы. Мультиномиальная ло​гистическая регрессия является разновидностью бинарной, в которой зависимая переменная имеет более двух категорий. Независимые переменные должны отно​ситься либо к номинальной, либо к порядковой шкале.
Еще в версии SPSS 11-12 был введен новый метод логистической регрессии: по​рядковая. Он используется в том случае, когда зависимая переменная относится к порядковой шкале. Причем независимые переменные должны быть либо номи​нальными, либо порядковыми. Мультиномиальный логистический регрессионный анализ является наиболее универсальным и, в целом, способен заменить собой два других метода. Однако наиболее качественное приближение статистических мо​делей может быть достигнуто только при использовании именно трех описывае​мых методов: для каждого случая — свой. В табл. 5.1 систематизированы основные характеристики переменных, участвующих в рассматриваемых трех типах логис​тического регрессионного анализа.
Таблица 5.1. Основные характеристики переменных, участвующих в анализе
	Бинарная логистическая регрессия

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	Она
	Дихотомическая
	Любое
	Любой

	Мультиноминальная логическая регрессия

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	Одна
	Номинальная 
Порядковая
	Любое
	Номинальная 
Порядковая

	Порядковая логистическая регрессия

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	Одна
	Порядковая
	Любое
	Номинальная 
Порядковая


Необходимо отметить, что ранее в SPSS отсутствовала стандартная возможность проведения специализированного логистического регрессионного анализа для за​висимых переменных с порядковой шкалой. Для любых переменных с числом ка​тегорий больше двух применялся мультиномиальный регрессионный анализ. Дело в том, что недавно введенная в практику анализа порядковая логистическая ре​грессия имеет некоторые особенности, учитывающие именно специфику поряд​ковой шкалы (связанных упорядоченных категорий). Однако в настоящем посо​бии порядковая логистическая регрессия не рассматривается отдельно — в первую, очередь из-за того, что она не обладает какими-либо существенными преимуществами над мультиномиальным методом. Вы можете спокойно применять мульти​номиальную регрессию и в случае номинальной, и в случае порядковой зависимой переменной. Если вы все же решите провести порядковый логистический регрес​сионный анализ, вы без труда в нем разберетесь, так как данный процесс практи​чески не отличается от построения мультиномиальной логистической регрессии.
Далее мы рассмотрим примеры проведения статистического анализа с использо​ванием логистической регрессии отдельно для бинарной и мультиномиальной ло​гистической регрессии.
Начнем с наиболее простого случая — бинарной логистической регрессии. Пред​положим, в ходе маркетингового исследования проводится оценка востребован​ности выпускников одного из московских вузов. В анкете респондентам в числе прочих задаются три вопроса:
■   Работаете ли вы? (ql);
■   В каком году Вы окончили вуз? (q21);
■   Каков был Ваш средний балл при выпуске из вуза? (aver), а также уточняется пол опрошенных (q22).
В ходе логистического анализа мы оценим влияние независимых переменных q21, q22 и aver на зависимую переменную ql. Другими словами, мы попытаемся пред​сказать трудоустройство выпускников вуза на основании пола, года окончания вуза и среднего балла, полученного за годы обучения.
Для того чтобы задать параметры построения регрессионной модели при помощи бинарного логистического метода, воспользуемся меню Analyze ► Regression ► Binary Logistic. В открывшемся диалоговом окне Logistic Regression (рис. 5.1) выберите в левом списке всех доступных переменных зависимую (в нашем случае ql) и поме​стите ее в поле Dependent. Затем в область Covariates поместите исследуемые неза​висимые переменные (q21, q22, aver) и выберите метод их включения в регрессион​ный анализ. При числе независимых переменных больше двух следует выбрать не установленный по умолчанию метод одновременного включения всех переменных (Enter), а один из пошаговых. Наиболее часто используемым пошаговым методом является Backward:LR. Кнопка Select позволяет включить в анализ не всех респон​дентов из выборочной совокупности, а только отдельную целевую группу.


Кнопкой Categorical следует воспользоваться, если в качестве одной из независи​мых переменных выступает номинальная переменная с числом категорий больше двух. В данном случае в диалоговом окне Define Categorical Variables (рис. 5.2) следу​ет поместить в область Categorical Covariates такую переменную (в нашем случае таких переменных нет). Далее следует выбрать в раскрывающемся списке Contrast пункт Deviation и щелкнуть на кнопке Change. В результате из каждой номиналь​ной переменной будет создано несколько дихотомических переменных (по числу категорий исходной переменной).

При помощи кнопки Save в главном диалоговом окне анализа (рис. 5.3) можно за​дать создание новых переменных, содержащих значения, рассчитанные в ходе ре​грессионного анализа. Так давайте создадим две новые переменные, содержащие:
■   принадлежность к определенной группе классификации (параметр Group mem​bership);
■   вероятность попадания респондента в каждую из двух рассматриваемых групп (параметр Probabilities).

Кнопка Options не предоставляет исследователю никаких важных возможностей, поэтому ее можно не использовать. После щелчка на кнопке О К в главном диалого​вом окне Logistic Regression в окне SPSS Viewer будут выведены результаты бинар​ного логистического регрессионного анализа.
Далее мы рассмотрим наиболее существенные для маркетингового анализа резуль​таты. В таблице Omnibus Tests of Model Coefficients отображаются результаты оценки
качества приближения статистической модели (рис. 5.4). Поскольку мы задали пошаговый метод, мы должны смотреть на результаты последнего шага (в нашем случае Step 2). Положительным результатом считается возрастание величины Chi-square при переходе на каждый следующий шаг (строка Step) при высоком уровне значимости (Sig. < 0,05). Качество всей модели оценивается на основании статис​тической значимости в строке Model. В нашем случае на втором шаге получена от​рицательная величина Chi-square, однако она не является значимой (Sig. = 0,913), к тому же общая значимость всей модели весьма высока (Sig. < 0,001). Поэтому построенную модель следует признать значимой и практически пригодной.

Следующая таблица Model Summary (рис. 5.5) позволяет оценить долю совокупной дисперсии, описываемой построенной моделью (величина R Square). Рекомендует​ся использовать величину Nagelkerke. В нашем случае эта величина мала (лишь 6 %). Положительным результатом можно считать величину Nagelkerke R Square, превышающую 0,50.


Далее следуют результаты классификации (таблица Classification Table, рис. 5.6), в которой реально наблюдаемые показатели принадлежности к той или иной из двух исследуемых групп сопоставляются с предсказанными на основе логистичес​кой регрессионной модели. В нашем случае из строки Overall Percentage мы видим, что построенная модель позволяет корректно классифицировать 80,4 % респон​дентов. Также можно сделать соответствующие выводы о корректности класси​фикации для каждой из двух рассматриваемых групп.
Из следующей таблицы (рис. 5.7) можно выяснить статистическую значимость не​зависимых переменных, включенных в анализ (в нашем случае q22 и aver), а также нестандартизированные регрессионные коэффициенты, являющиеся коэффициен​тами регрессионной функции. На основании этих коэффициентов (включая константу Constant) вы можете спрогнозировать принадлежность к определенной груп​пе каждого конкретного респондента в выборке. Это делается следующим образом.


Например, выпускник вуза получил средний балл 3,3 (aver = 3,3); это женщина (q22 = 2). В таком случае уравнение регрессии будет выглядеть следующим обра​зом:
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а вероятность для рассматриваемого респондента оказаться в одной из анализиру​емых групп классификации (это всегда группа зависимой переменной, имеющая больший код, в нашем случае 2 — Не работают) будет рассчитываться по формуле:
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Таким образом, женщина со средним баллом 3,3 имеет достаточно высокие шансы оказаться безработной (68 %).
Теперь рассмотрим пример проведения мультиномиальной логистической регрес​сии. В качестве исходных данных мы будем использовать три независимые пере​менные из предыдущего примера, а в качестве зависимой — переменную q24 Зара​ботная плата с пятью категориями, кодирующими интервалы зарплаты.
Откройте диалоговое окно Multinomial Logistic Regression при помощи меню Analyze ► Regression ► Multinomial Logistic (рис. 5.8). В поле для зависимой переменной поме​стите переменную q24, а в область для зависимых переменных — q21, q22 и aver.
Кнопка Model позволяет задать конкретный тип модели (полнофакторная, основ​ные эффекты или пользовательская), однако для маркетинговых исследований мы советуем ничего не менять в окне Model.
При помощи кнопки Statistics вызывается одноименное диалоговое окно (рис. 5.9). В нем следует оставить выбранные по умолчанию три параметра: Summary statistics, Likelihood ratio test и Parameter estimates, а также выбрать еще один пункт — Cell Probabilities.




Кнопка Criteria не предоставляет маркетологам существенных для решения их за​дач функций, поэтому используется редко.
При помощи кнопки Save (рис. 5.10) можно задать новые переменные, содержа​щие принадлежность к определенной классификационной группе (параметр Pre​dicted category) и вероятность попадания в данные категории (параметр Predicted probabilities membership).
После щелчка на кнопке 0К в главном диалоговом окне Multinomial Logistic Regression в окне SPSS Viewer появятся результаты расчетов. Первая таблица, содержащая важные для нас сведения, — это Model Fitting Information, показанная на рис. 5.11. Высокая статистическая значимость построенной модели (Sig. < 0,001) свидетель​ствует о ее высоком качестве и пригодности для решения практических задач.
Вторая значимая таблица Pseudo R-Square предоставляет возможность оценить долю совокупной дисперсии в зависимой переменной, объясняемой выбранными для анализа независимыми переменными (по тесту Nagelkerke). В нашем случае по​строенная модель объясняет 15 % совокупной дисперсии (рис. 5.12).
Таблица Likelihood Ratio Tests (рис. 5.13) позволяет сделать выводы относительно статистической значимости каждой из зависимых переменных, входящих в по​строенную модель. В нашем случае все три исследуемые переменные оказывают весьма значимое влияние на зависимую переменную (Sig. < 0,05).








Следующая таблица, Parameter Estimates (рис. 5.14), отражает нестандартизированные регрессионные коэффициенты, на основании которых происходит построение регрессионного уравнения. Также для каждого сочетания анализируемых переменных рассчитана статистическая значимость их влияния на зависимую переменную. В дальнейшем рассчитать вероятность попадания того или иного респондента в одну из исследуемых групп зависимой переменной можно по вы​шеприведенной формуле (показана при обсуждении бинарной логистической рег​рессии).
Однако в маркетинговых исследованиях чаще всего возникает необходимость классифицировать по группам не отдельных респондентов, а целые целевые группы. Для этого служит таблица Observed and Predicted Frequencies, представ​ленная на рис. 5.15. В столбце Percentage ► Predicted показаны вероятности по​падания каждой исследуемой целевой группы респондентов в ту или иную ка​тегорию зависимой переменной. Так, например, мы видим, что 20 % мужчин, окончивших ВУЗ в 2001 г. и получивших средний балл 3,0, зарабатывают до $ 400 в месяц.


5.1.2. Дискриминантный анализ
Дискриминантный анализ является более универсальной статистической про​цедурой по сравнению с рассмотренными выше методами логистической регрес​сии. Основным результатом проведения дискриминантного анализа являются (также как для логистической регрессии) рассчитанные вероятности попадания каждого респондента в ту или иную группу, а также переменная, кодирующая при​надлежность их к данным группам. Наряду с этой информацией по результатам дискриминантного анализа можно составить уравнение дискриминантной функции.
В табл. 5.2 приведены основные характеристики переменных, участвующих в дис-криминантном анализе.
Таблица 5.2. Основные характеристики переменных, участвующих в анализе
	Дискриминантный анализ

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	Одна
	Номинальная 
Порядковая
	Любое
	Любой


При выборе зависимой переменной для дискриминантного анализа следует помнить, что увеличение числа категорий в ней практически всегда влечет уменьшение каче​ства статистической модели, то есть ее точности и надежности. Поэтому рекоменду​ется использовать в качестве зависимых переменные с малым количеством катего​рий (или преобразовывать существующие переменные к данному виду).
Для описания процесса проведения дискриминантного анализа применим следу​ющие исходные данные. Проводится маркетинговое исследование потенциально​го спроса на услуги нового развлекательного комплекса. Респонденты в ходе оп​роса отвечают на вопрос Будете ли Вы посещать новый комплекс? (q26) с вариантами ответа Да и Нет. В качестве независимых переменных, характеризующих респон​дентов, выделены:
■  возраст (ql8);
■  род занятий (ql9);
■  среднемесячный доход (q20);
■  количество членов семьи (q21);
■  среднемесячные расходы на досуг (q22);
■  пол (q23).
В результате дискриминантного анализа мы разделим респондентов на посетите​лей и не посетителей нового центра на основании выделенных социально-демо​графических характеристик опрошенных.
Откройте диалоговое окно Discriminant Analysis при помощи меню Analyze ► Classify ► Discriminant (рис. 5.16). Поместите переменную q26 в поле для зависимых перемен​ных Grouping Variable, а анализируемые независимые переменные — в область In​dependents. Выберите пошаговый метод ввода независимых переменных в модель (параметр Use stepwise method).

Далее щелкните на кнопке Define Range для определения границ изменения зави​симой переменной q26 (рис. 5.17). В нашем случае минимальным значением (Mi​nimum) является 1, а максимальным (Maximum) — 2.
При помощи диалогового окна Statistics, активизируемого одноименной кнопкой, следует задать вывод результатов одномерного дисперсионного анализа (параметр
Univariate ANOVA), теста Box (параметр Box's M), а также нестандартизированых ко​эффициентов регрессии (параметр Unstandardized) (рис. 5.18).



В следующем диалоговом окне, Stepwise Method, вызываемом при помощи кнопки Method, следует выбрать параметр Use probability of F (рис. 5.19). Активизация дан​ного параметра позволяет проводить введение переменных в регрессионную мо​дель более гибко по сравнению с абсолютным значением F-статистики (параметр, выбранный по умолчанию).
В следующем диалоговом окне, Classification, нас интересует только один параметр — Summary Table (рис. 5.20),
Наконец, при помощи кнопки Save можно создать в исходном файле данных но​вые переменные, содержащие для каждого респондента в выборке прогнозируе​мую принадлежность к группе (параметр Predicted group membership) и вероятность попадания каждого респондента в данные группы (параметр Probabilities of group membership; см. рис. 5.21).
После выполнения вышеописанных шагов щелкните на кнопке 0К, чтобы запус​тить программу дискриминантного анализа на исполнение. После окончания рас​четов в окне SPSS Viewer будут выведены результаты расчетов.
Первой важной для нас таблицей является Tests of Equality of Group Means (рис. 5.22). Она показывает, насколько значимо выбранные независимые переменные разде​ляют выборочную совокупность респондентов на исследуемые группы. В нашем случае получены весьма значимые результаты для всех исследуемых переменных (Sig. < 0,05). Это свидетельствует о том, что на их основании исследуемые группы зависимой переменной существенно различаются.
Следующая таблица, Test Results, показывает результаты теста Box на значимость различия между категориями исследуемой зависимой переменной (рис. 5.23). В на​шем случае данный тест показывает весьма высокую вероятность того, что данные различия являются статистически значимыми (Sig. < 0,001).







Таблица Variables in the Analysis показывает, какие независимые переменные оказа​лись включенными в итоговую дискриминантную модель на последнем шаге ана​лиза (напомним, что мы выбрали пошаговый метод включения переменных в мо​дель). В нашем случае последним шагом является шаг 4. На четвертом шаге у нас остались четыре независимые переменные из шести (рис. 5.24).

Таблица Eigenvalues позволяет оценить качество разделения респондентов на за​данные группы зависимой переменной (рис. 5.25). Соответствующий вывод можно сделать исходя из корреляционного коэффициента (столбец Canonical Correlation). В нашем случае данный коэффициент примерно равен 0,5, что свидетельствует о неудовлетворительном результате.
Еще одним важным показателем в этой таблице является собственное значение дискриминантной функции (столбец Eigenvalue). В общем случае большие значе​ния Eigenvalues указывают на высокую точность подобранной дискриминантной функции. В нашем случае рассматриваемое собственное значение весьма мало, что является негативным фактом. Необходимо отметить, что при наличии у зависи​мой переменной более двух категорий в ходе дискриминантного анализа строится несколько дискриминантных функций (по количеству категорий зависимой пере​менной минус 1).
Следующая таблица (рис. 5.26) также позволяет оценить качество приближения дискриминантной модели. В нашем случае статистическая значимость (Sig. < 0,001)
указывает на существенные различия между средними значениями дискриминантных функций в двух исследуемых группах зависимой переменной.



Следующие две таблицы (рис. 5.27 и 5.28) позволяют оценить, насколько отдельные независимые переменные, применяемые в дискриминантной функции, коррели​руют с ее стандартизированными коэффициентами. В первой таблице приводятся стандартизированные коэффициенты, а во второй — корреляционные коэффици​енты. При помощи стандартизированных коэффициентов, кроме всего прочего, можно непосредственно сравнивать относительный вклад каждой независимой переменной в различение двух исследуемых групп. Например, мы видим, что воз​раст респондентов влияет на их желание/нежелание посещать новый центр в 1,3 ра​за сильнее, чем род занятий.
Далее следуют коэффициенты дискриминантной функции (нестандартизирован-ные), на основании которых и строится дискриминантное уравнение, по форме похожее на уравнение регрессии (рис. 5.29). Это просто множители при соответ​ствующих переменных. С учетом константы уравнение дискриминантной функ​ции имеет вид:
Z=-0,845 + 0,207 × Возраст + 0,198 × Род_занятий - 0,289 × Кол-во_членов_семьи - 0,285 × Среднемесячные_расходы_на_досуг
Теперь на основании данного уравнения молено рассчитать вероятность, с которой та или иная социально-демографическая целевая группа респондентов будет по​сещать новый центр. Подставив в дискриминантное уравнение соответствующие значения, можно сделать вывод о том, что студенты в возрасте 20 лет, проживаю​щие одни и расходующие на свой досуг $ 50 в месяц, скорее всего, будут посещать новый развлекательный центр (вероятность 79 %)'.
Таблица, представленная на рис. 5.30, показывает средние значения дискриминант​ной функции в каждой анализируемой группе зависимой переменной.






Завершает вывод результатов дискриминантного анализа таблица Classification Results, в последней строке которой содержится информация о точности построен​ной модели (рис. 5.31). В нашем случае мы видим, что 77,7 % респондентов были корректно отнесены к одной из двух исследуемых групп (77,7% of original grouped cases correctly classified). Результаты оценки корректности классификации варьи​руются в пределах от 50 % до 100 %, поэтому полученный нами результат — при​мерно 78 % — можно считать удовлетворительным.

5.2. Факторный и кластерный анализ
Кластерный и факторный анализы преследуют ту же цель, что и рассмотренные в предыдущем разделе методы логистической регрессии и дискриминантного анализа: классифицировать переменные и/или категории респондентов по однород​ным группам (сегментам, кластерам). Однако между этими методами существует одно серьезное различие. При дискриминантном анализе и логистической регрес​сии у нас заранее есть некая зависимая (результирующая) переменная с двумя или более вариантами ответа (уровнями, категориями). Задача анализа в данном слу​чае состоит в классификации имеющихся категорий респондентов (возрастных, половых и других) по этим уровням результирующей переменной. Эти два стати​стических метода позволяют сегментировать выборку на заранее известные целе​вые группы. При кластерном и факторном анализе ситуация иная: кластеры (сег​менты, категории), на которые следует разделить выборку, заранее не известны. Задачей статистического анализа в данном случае будет не только формирование максимально однородных сегментов, но и выделение кластеров, по которым будет производиться сегментирование. Приведем пример релевантного задания для фак​торного (кластерного) анализа.
Исходные данные:
Респондентам (пассажирам международных рейсов авиакомпании X) в ходе опроса пред​лагалось 24 утверждения, по которыми они должны были выразить степень своего согла​сия либо несогласия по десятибалльной шкале — от 1 (совершенно не согласен) до 10 (абсолютно согласен). Предложенные утверждения описывают текущую конкурентную по​зицию рассматриваемой компании на международном рынке авиаперевозок. В результа​те опроса и последующих подготовительных этапов к статистическому анализу (см. раз​дел 3) был получен массив из 24 одновариантных переменных (ql-q24) с кодами ответов соответственно от 1 до 10 (интервальная шкала).

ql. Авиакомпания X обладает репутацией компании, превосходно обслуживающей пассажиров.
q2.   Авиакомпания X может конкурировать с лучшими авиакомпаниями мира.
q3.  Я верю, что у авиакомпании X есть перспективное будущее в мировой авиации.
q4.  Я знаю, какой будет стратегия развития авиакомпании X в будущем.
q5.   Я горжусь тем, что работаю в авиакомпании X.
q6.   Внутри авиакомпании X хорошее взаимодействие между подразделениями.
q7. Каждый сотрудник авиакомпании прикладывает все усилия для того, чтобы обес​печить ее успех.
q8. Сейчас авиакомпания X быстро улучшается.
q9. Нам предстоит долгий путь, прежде чем мы сможем претендовать на то, чтобы
называться авиакомпанией мирового класса. 
qlO. Авиакомпания X действительно заботится о пассажирах.
qll. Среди сотрудников авиакомпании имеет место высокая степень удовлетворен​ности работой.
ql2. Я верю, что менеджеры высшего звена прикладывают все усилия для достиже​ния успеха авиакомпании.
ql3. Мне нравится, как в настоящее время авиакомпания X представлена визуально широкой общественности (в плане цветовой гаммы и фирменного стиля).
ql4. Авиакомпания X — лицо России.
ql5. Мы выглядим «вчерашним днем» по сравнению с другими авиакомпаниями.
ql6. Обслуживание авиакомпании Х является последовательным и узнаваемым во всем мире.
ql7. Я бы не хотел, чтобы авиакомпания X менялась.
ql8. Авиакомпании X необходимо меняться для того, чтобы использовать в полной мере имеющийся потенциал.
ql9. Я думаю, что авиакомпании X необходимо представить себя в визуальном плане более современно.
q20. Изменения в авиакомпании X будут позитивным моментом. q21. Авиакомпания X — эффективная авиакомпания.
q22. Я бы хотел, чтобы имидж авиакомпании X улучшился с точки зрения иностран​ных пассажиров.
q23. Авиакомпания X — лучше, чем многие о ней думают.
q24. Важно, чтобы люди во всем мире знали, что мы — российская авиакомпания. Требуется:
Выявить схожие (то есть тесно коррелирующие между собой) утверждения и разделить их на несколько однородных групп, описывающих различные аспекты (макропараметры)

конкурентной позиции авиакомпании X на рынке. Другими словами, выделить группы схо​жих по значению параметров авиакомпании, характеризующих ее состояние на рынке с различных сторон.

Данную задачу невозможно решить методами логистической регрессии или дискриминантного анализа, так как у нас нет зависимой (результирующей) перемен​ной: есть только массив, на первый взгляд, независимых равнозначных парамет​ров. Поставленную цель можно достичь при помощи либо факторного анализа, либо кластерного. Однако прежде, чем мы приступим к решению, следует сказать несколько слов об основных характерных чертах и различиях между этими двумя статистическими методами, предназначенными для решения схожих задач. 
Факторный анализ позволяет разделить массив переменных на малое число групп, которые называются факторами. Классификация производится на основании кри​терия корреляции между переменными. В один фактор объединяются несколько переменных, тесно коррелирующих между собой и не коррелирующих или слабо коррелирующих с другими переменными, составляющими другие факторы. Таким образом, в результате факторного анализа мы получаем из несистематизирован​ного массива данных несколько макропеременных, описывающих различные ха​рактеристики продукта компании (или другого исследуемого объекта). Основная сложность при проведении факторного анализа заключается в необходимости ра​ционально интерпретировать полученные макрокатегории с точки зрения здраво​го смысла (применительно к целям и специфике конкретного исследования). Дан​ная проблема не имеет универсального решения и подлежит отдельному анализу в каждом конкретном случае. Ниже мы продемонстрируем пример интерпретации результатов факторного анализа. Именно сложность интерпретации результатов является существенным ограничением рассматриваемой статистической методи​ки, так как из-за невозможности логического описания полученных категорий иногда приходится вообще отказаться от ее использования.
Еще одним ограничением применения факторного анализа является ситуация, когда одна и та же переменная относится сразу к двум или более факторам, то есть перемен​ную нельзя однозначно классифицировать. В таком случае следует либо отказаться от использования факторного анализа и попытаться применить другие статистические методики (например, кластерный анализ), либо заново пересчитать факторную мо​дель без данной переменной, а затем вручную отнести неоднозначную переменную к тому или иному фактору на основании логических соображений.
Далее приведены основные примеры использования факторного анализа в марке​тинговых исследованиях.
Сегментирование рынка. Факторный анализ применяется для выявления агрегат​ных переменных, являющихся основанием для сегментирования потребителей. Например, потребители плавленых сыров могут характеризоваться различной степенью значимости, которую они видят в исследуемых характеристиках данного продукта (респондентов просят оценить по пятибалльной шкале важность несколь​ких характеристик плавленых сыров: срок хранения, калорийность, процент жир​ности и т. д.). Здесь факторный анализ позволит выявить целевые сегменты по​требителей на основании значимости для них различных групп факторов:
■   покупатели, ориентирующиеся при выборе плавленого сыра преимущественно на ценовые факторы (стоимость, скидки);
■   покупатели, ориентирующиеся на качество исследуемого продукта (срок хра​нения, состав ингредиентов, вкус);
■   покупатели, выбирающие сыр в основном по внешнему виду (дизайн упаковки).
В целом следует отметить, что в настоящее время все большую популярность сре​ди исследователей приобретают методы сегментирования потребителей на осно​вании их психографических характеристик. Для этого в анкету включается доста​точно большое количество высказываний (порядка 100-150), характеризующих различные стороны жизненного стиля респондентов. Респонденты должны выра​зить свое согласие или несогласие с данными высказываниями по шкале Лайкерта (согласен — скорее согласен — ни то ни другое — скорее не согласен — не согласен). В дальнейшем на основании ответов респондентов формируются однородные це​левые сегменты (обычно порядка 10).
Изучение продукта и бенчмаркинг продукта. В данном случае факторный анализ помогает выявить агрегатные параметры продукта, влияющие на выбор потреби​теля. Например, различные марки шоколадных конфет могут быть оценены по следующим макрокатегориям: качество (ингредиенты, вкус), полезность для здо​ровья (наличие сахара, калорийность) и цена.
Рекламные и медиа-исследования. Факторный анализ может использоваться для выявления скрытых мотивов поведения потребителей при восприятии рекламы.
Ценообразование. Факторный анализ используется для выявления особенностей поведения потребителей, чувствительных к цене. Например, данная категория рес​пондентов может характеризоваться повышенным вниманием к ценовым факто​рам при выборе продукта, низкими доходами, большой численностью семьи и т. д.
Кластерный анализ является аналогом факторного анализа в том-смысле, что он так же, как и факторный анализ, позволяет выделить факторы (кластеры), объеди​няющие статистически схожие переменные. Однако в данном случае переменные классифицируются не на основании степени тесноты корреляционной связи, а на основании более сложных статистических процедур (наиболее часто использует​ся метод исследования расстояний между переменными в кластерах). Ниже мы продемонстрируем действие обеих анализируемых статистических методик на одном массиве данных (см. выше).
Несмотря на имеющуюся возможность классифицировать переменные кластерный анализ чаще всего применяется для кластеризации групп респондентов (то есть уровней или категорий переменных)1. Данная возможность позволяет, например,
провести пробное (при неизвестных целевых группах) сегментирование целевых покупателей какого-либо продукта. Сформированные в результате кластерного ана​лиза целевые группы респондентов обладают схожим поведением (то есть взаи​мозависимостями) своих характеристик. В качестве примера успешной кластери​зации можно привести разбиение респондентов на две группы:
■   женщины в возрасте старше 45 лет;
■   все мужчины и женщины младше 45 лет.
При использовании рассматриваемой статистической методики для кластериза​ции респондентов можно совмещать кластерный и факторный анализ, причем в данном случае факторный анализ будет предшествовать кластерному. Часто это делается для того, чтобы сократить количество переменных, участвующих в клас​терном анализе (при большом числе этих переменных). Так, можно сначала выде​лить среди большого числа переменных макропараметры, а затем сегментировать респондентов уже на основании данных факторов.
Теперь у вас сложилось общее представление о методах факторного и кластерного анализа, и мы можем приступить к описанию их практического применения. Вос​пользуемся условием задачи про анализ текущей конкурентной позиции авиаком​пании X. Эта задача поможет нам также сравнить действие данных статистических методик на одной и той же выборке. Для описания кластерного анализа, применя​емого для кластеризации респондентов, мы будем использовать другой пример из практики маркетинговых исследований. Так как для классификации переменных факторный анализ все же применяется чаще, чем кластерный (это сложилось ис​торически и, кроме того, оправдано меньшими усилиями, затрачиваемыми на про​ведение факторного анализа), в разделе 5.2.2 основное внимание будет уделено описанию действия кластерного анализа для классификации респондентов (выде​ления целевых групп потребителей). Сравнение действия двух статистических методов при классификации переменных мы предложим уже в заключении разде​ла 5.2.2.
В качестве примеров практического применения кластерного анализа в маркетин​говых исследованиях можно указать все те же случаи, что и при факторном анали​зе (если кластерный анализ используется для классификации переменных). В слу​чае применения кластерного анализа для классификации конкретных групп респондентов он предоставляет исследователю гораздо более гибкие возможности и в большем числе областей маркетинговых исследований по сравнению с фактор​ным анализом. Это преимущество кластерного анализа обусловлено тем, что он анализирует не переменные в целом, а конкретные категории респондентов (на​пример, различные половозрастные, доходные и другие группы покупателей). Та​ким образом, можно сделать важный вывод относительно факторного и кластер​ного анализов. Целью факторного анализа является сокращение числа переменных, участвующих в анализе (выделение релевантных макрокатегорий переменных), а целью кластерного — классификация респондентов на целевые группы на основа​нии их существенных характеристик.
Из всего сказанного становится понятно, почему оба типа статистического ана​лиза иногда используются в паре: факторный анализ определяет состав макро​переменных (например, для сегментирования потребителей), а кластерный на основании выделенных существенных характеристик респондентов производит формирование целевых сегментов. Применение факторного и кластерного анализов в паре оправдано в основном в тех случаях, когда изначально респон​денты оцениваются по большому числу параметров и проведение кластерного анализа непосредственно над данным (большим) набором переменных пред​ставляется затруднительным или даже практически невозможным. Отметим, что для проведения факторного и кластерного анализов в паре следует сначала провести факторный анализ, сохранив полученные факторные рейтинги, а за​тем проводить кластерный анализ на основании полученных групп перемен​ных. Более подробно парное использование факторного и кластерного анали​зов будет показано в разделе 5.2.2.
В табл. 5.3 представлены основные характеристики переменных, участвующих в факторном и кластерном анализах.
Таблица 5.3. Основные характеристики переменных, участвующих в факторном и кластерном анализах
	Факторный анализ

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	Нет
	-
	Любое
	Любой

	Кластерный анализ

	Зависимые переменные
	Независимые переменные

	Количество
	Тип
	Количество
	Тип

	Нет
	-
	Любое
	Любой


5.2.1. Факторный анализ
Итак, из условия представленной выше задачи следует, что у нас есть массив дан​ных, состоящий из 24 независимых переменных (утверждений), в различных ас​пектах описывающих текущее состояние авиакомпании X на международном рынке авиаперевозок. Основной задачей проводимого факторного анализа является груп​пировка схожих по смыслу утверждений в макрокатегории с целью сократить чис​ло переменных и оптимизировать структуру данных.
При помощи меню Analyze ►Data Reduction ► Factor вызовите окно Factor Analysis. Пе​ренесите из левого списка в правый переменные для анализа (ql-q24), как показа​но на рис. 5.32. Поле Selection Variable позволяет выбрать переменную, в разрезе которой будет проводиться анализ (например, класс полета). В нашем случае ос​тавьте это поле Пустым.
Щелкните на кнопке Descriptives и в открывшемся диалоговом окне (рис. 5.33) вы​берите пункт КМО and Barlett's test of sphericity. Это позволит определить, насколько имеющиеся данные пригодны для факторного анализа. Окно Descriptives позволя​ет вывести и другие необходимые описательные статистики. Однако в большин​стве примеров из маркетинговых исследований эти возможности, как правило, не используются.



Закройте окно Descriptives, щелкнув на кнопке Continue. Далее откройте окно Extraction (рис. 5.34), щелкнув на соответствующей кнопке в главном диалоговом окне Factor Analysis. Это окно предназначено для выбора метода формирования факторной модели; выполните в нем следующие действия.


Во-первых, в поле Method выберите метод извлечения (формирования) факторов. Общая рекомендация по выбору метода состоит в следующем. Необходимо выби​рать тот метод извлечения факторов, который позволяет однозначно классифицировать как можно больше переменных. Таким образом, основные соображения здесь — число классифицированных факторов и однозначность классификации (то есть каждая переменная должна принадлежать только одному фактору). Как вы увидите ниже, установленный по умолчанию в SPSS метод Principal components в нашем случае позволяет однозначно классифицировать 22 переменные из 24 име​ющихся (92 %), что является весьма хорошим показателем. На основании имею​щегося опыта автор может утверждать, что хорошим результатом факторного ана​лиза является доля однозначно классифицированных переменных не менее 90 %. Выберите метод Principal components. Данный метод является наиболее подходя​щим для решения большинства задач маркетинговых исследований при помощи факторного анализа.
Во-вторых, укажите количество образуемых факторов (группа Extract). По умол​чанию установлен метод определения количества извлекаемых факторов на осно​вании значений характеристических чисел (Eigenvalues over). He вдаваясь в стати​стические тонкости, отметим, что характеристические числа используются SPSS для определения количественного и качественного состава извлекаемых факто​ров. При предустановленном значении данного показателя , равном 1, количество образуемых факторов будет равно количеству переменных, значение характерис​тических чисел для которых больше или равно 1.
Также существует возможность вручную указать программе, сколько факторов необходимо извлекать (Number of factors). Эта возможность предусмотрена в SPSS для того, чтобы при слишком большом количестве переменных с характеристи​ческим числом больше 1 вручную сократить число факторов. Большое число фак​торов трудно интерпретировать, поэтому если методом характеристических чисел не удается извлечь приемлемое для интерпретации число факторов (чем меньше, тем лучше), следует самостоятельно указать программе число факторов. Эта зада​ча решается аналитиком в каждом конкретном случае индивидуально. В качестве одного из вариантов решения можно рекомендовать увеличить число eigenvalue с предустановленного значения 1, скажем, до 1,5 или более. Это поможет, если по​лучено большое число факторов с характеристическим числом, приблизительно равным 1, и несколько (2-3 и более) факторов — с характеристическим числом более 1,5 или другого значения. Также при ручном определении количества фак​торов аналитик может принять релевантное решение, основываясь на своем опыте или на каких-либо иных предположениях. И наконец, необходимо отметить, что при ручном указании числа извлекаемых факторов иногда количество однознач​но классифицированных переменных оказывается меньше, чем при методе экст​ракции по величине характеристических чисел. Однако данный негативный мо​мент нивелируется возросшей наглядностью результатов факторного анализа — ведь это позволяет освободиться от факторов, в которых нет переменных со значи​мым коэффициентом корреляции (в нашем случае 0,5).
Закройте диалоговое окно Extraction, щелкнув на кнопке Continue. Выберите тип ротации матрицы коэффициентов (кнопка Rotation в главном диалоговом окне Factor Analysis). Ротация коэффициентной матрицы производится для того, чтобы мак​симально приблизить факторную модель к идеалу: возможности однозначно клас​сифицировать все переменные. В диалоговом окне Rotation (рис. 5.35) выберите конкретный метод ротации. В большинстве случаев наиболее приемлемым вари​антом является метод Varimax. Он облегчает интерпретацию факторов, минимизируя количество переменных с высокими факторными нагрузками. Выберите этот тип ротации и закройте диалоговое окно, щелкнув на кнопке Continue.

Далее откройте диалоговое окно Factor Scores (рис. 5.36), щелкнув на кнопке Scores. Это окно служит для создания в исходном файле данных новых переменных, ко​торые в дальнейшем позволят отнести каждого респондента к определенной груп​пе (фактору). Число вновь создаваемых переменных равно числу извлеченных факторов. Ниже мы покажем, каким образом использовать данные переменные. Выберите в диалоговом окне Factor Scores параметр Save as variables, а в качестве метода определения значений для этих новых переменных — регрессионную мо​дель Regression. После этого закройте диалоговое окно, щелкнув на кнопке Continue.

Последним этапом перед запуском процедуры факторного анализа является вы​бор некоторых дополнительных параметров (кнопка Options). В открывшемся ди​алоговом окне (рис. 5.37) выберите два пункта: Sorted by size и Suppress absolute values less than. Первая опция позволяет вывести переменные, входящие в каждый фак​тор, в порядке убывания их факторных коэффициентов (величины вклада пере​менной в формирование фактора). Вторая оказывается весьма полезна, так как облегчает задачу однозначной интерпретации полученных факторов. Указанное в соответствующем поле значение данного параметра (в нашем случае 0,5) отсекает переменные с факторными коэффициентами менее данного значения. Это позво​ляет упростить ротированную матрицу факторов, поскольку из нее исчезают не​значимые переменные, входящие в каждый извлеченный фактор. Если вы не за​действуете данный параметр, для каждой переменной будет отображен факторный коэффициент по каждому фактору, что излишне перегрузит факторную модель и затруднит ее восприятие исследователями.
Параметр Suppress absolute values less than вводится, чтобы облегчить практическую интерпретацию результатов факторного анализа. Так как факторные коэффици​енты в результирующей ротированной матрице коэффициентов являются коэф​фициентами корреляции между соответствующими переменными и факто​рами, в большинстве практических случаев целесообразно устанавливать начальное значение отсечения незначимых переменных на уровне 0,5. Если в результате фак​торного анализа окажется, что число классифицированных переменных менее при​емлемого (например, если структура данных не вполне подходит для факторного анализа; см. ниже), можно пересчитать факторную модель с меньшим значением отсечения (например, 0,4). В обратной ситуации, если переменная входит в не​сколько факторов, можно предложить повысить уровень экстракции с 0,5 до 0,6. Это позволит устранить переменные, входящие сразу в несколько факторов, уве​личив практическую пригодность результатов факторного анализа.
Итак, указав все необходимые параметры в окне Options, закройте его (кнопка Continue) и запустите процедуру факторного анализа при помощи щелчка на кноп​ке 0К в главном диалоговом окне Factor Analysis.

После того как программа произведет все необходимые расчеты, откроется окно SPSS Viewer с результатами построения факторной модели. Первое, что нас инте​ресует, — это пригодность имеющихся данных для факторного анализа в целом. Посмотрим на таблицу КМО and Barlett's Test (рис. 5.38). В ней есть два интересую​щих нас показателя: тест КМО и значимость теста Barlett. Результаты теста КМО позволяют сделать вывод относительно общей пригодности имеющихся данных для факторного анализа, то есть насколько хорошо построенная факторная модель описывает структуру ответов респондентов на анализируемые вопросы. Результа​ты данного теста варьируются в интервале от 0 (факторная модель абсолютно не​применима) до 1 (факторная модель идеально описывает структуру данных). Фак​торный анализ следует считать пригодным, если КМО находится в пределах от 0,5 до 1. В нашем случае этот показатель равен 0,9, что является весьма хорошим ре​зультатом.
Barlett's test of sphericity проверяет гипотезу о том, что переменные, участвующие в факторном анализе, некоррелированы между собой. Если данный тест дает по​ложительный результат (переменные некоррелированы), факторный анализ сле​дует признать непригодным использовать другие статистические методы (на​пример, кластерный анализ). Статистикой, определяющей пригодность факторного анализа по тесту Barlett, является значимость (строка Sig.). При приемлемом уровне
значимости (ниже 0,05) факторный анализ считается пригодным для анализа ис​следуемой выборочной совокупности. В нашем случае рассматриваемый тест по​казывает весьма низкую значимость (менее 0,001), из чего следует вывод о приме​нимости факторного анализа.
Итак, на основании тестов КМО и Barlett мы пришли к выводу, что имеющиеся у нас данные практически идеально подходят для исследования при помощи фак​торного анализа.

Следующим шагом в интерпретации результатов факторного анализа является рассмотрение результирующей ротированной матрицы факторных коэффициен​тов: таблицы Rotated Component Matrix (рис. 5.39). Данная таблица является основ​ным результатом факторного анализа. В ней отражаются результаты классифика​ции переменных по факторам. В нашем случае при помощи автоматического метода определения количества факторов (на основании характеристических чисел боль​ше 1) была построена практически приемлемая факторная модель, в которой 22 из 24 переменных удалось однозначно классифицировать по небольшому числу фак​торов (5). Данный результат может считаться хорошим.
С неклассифицированными переменными можно поступить следующим образом. Необходимо просто пересчитать факторную модель, удалив в диалоговом окне Options ранее установленное значение отсечения 0,5. Далее будет построена фак​торная матрица (рис. 5.40), в которой аналитику предстоит самостоятельно опре​делить принадлежность неклассифицированных переменных к тому или иному фактору на основании критерия наибольшего коэффициента корреляции между переменными и пятью факторами. В нашем случае вы видите, что переменная ql6 в наибольшей степени коррелирует с фактором 1 (факторный коэффициент 0,468) и, следовательно, должна быть отнесена к данному фактору, а переменная q24 — с фактором 4 (0,474).
После того как мы однозначно классифицировали все переменные, вернемся к таб​лице на рис. 5.40. Мы получили пять групп переменных (факторов), описываю​щих текущую конкурентную позицию авиакомпании X с пяти различных сторон. Вот эти группы.
Фактор 1
q2. Авиакомпания X может конкурировать с лучшими авиакомпаниями мира. q3. Я верю, что у авиакомпании X есть перспективное будущее в мировой авиации. q23. Авиакомпания X — лучше, чем многие о ней думают. q!4. Авиакомпания X — лицо России.

qlO. Авиакомпания Х действительно заботится о пассажирах.
ql. Авиакомпания X обладает репутацией компаний, превосходно обслуживающей пасса​жиров.
q21. Авиакомпания X — эффективная авиакомпания. q5. Я горжусь тем, что работаю в авиакомпании X.
ql6. Обслуживание авиакомпании X является последовательным и узнаваемым во всем мире.
Фактор 2
ql2. Я верю, что менеджеры высшего звена прикладывают все усилия для достижения успеха авиакомпании.
qll. Среди сотрудников авиакомпании имеет место высокая степень удовлетворенности работой.
q6. Внутри авиакомпании X хорошее взаимодействие между подразделениями.


q8. Сейчас авиакомпания X быстро улучшается.
q7. Каждый сотрудник авиакомпании прикладывает все усилия для того, чтобы обеспе​чить ее успех.
q4. Я знаю, какой будет стратегия развития авиакомпании X в будущем.
Фактор 3
ql7. Я бы не хотел, чтобы авиакомпания X менялась.
q20. Изменения в авиакомпании X будут позитивным моментом.
ql8. Авиакомпании X необходимо меняться для того, чтобы использовать в полной мере имеющийся потенциал.
Фактор 4
q9. Нам предстоит долгий путь, прежде чем мы сможем претендовать на то, чтобы назы​ваться авиакомпанией мирового класса.
q22. Я бы хотел, чтобы имидж авиакомпании X улучшился с точки зрения иностранных пассажиров.
q24. Важно, чтобы люди во всем мире знали, что мы — российская авиакомпания.
Фактор 5
ql9. Я думаю, что авиакомпании X необходимо представить себя в визуальном плане бо​лее современно.
ql3. Мне нравится, как в настоящее время авиакомпания X представлена визуально широ​кой общественности (в плане цветовой гаммы и фирменного стиля).
ql5. Мы выглядим «вчерашним днем» по сравнению с другими авиакомпаниями.
Наиболее сложной задачей при проведении факторного анализа является интер​претация полученных факторов. Здесь не существует какого-либо универсально​го решения: в каждом конкретном случае, аналитик использует имеющийся прак​тический опыт для того, чтобы понять, почему факторная модель относит ту или иную переменную к данному конкретному фактору. Бывают случаи (особенно при малом числе хорошо формализованных переменных), когда образованные факто​ры являются очевидными и различия между переменными видны невооруженным глазом. В такой ситуации можно обойтись без факторного анализа и разбить пере​менные на группы вручную. Однако эффективность и мощь факторного анализа проявляются в сложных и нетривиальных случаях, когда переменные нельзя зара​нее классифицировать, а их формулировки запутаны. Тогда большой исследова​тельский интерес будет вызывать классификация переменных именно на основа​нии мнений респондентов, что позволит выявить то, как сами опрошенные поняли тот или иной вопрос.
Приводим рекомендации, которые помогут вам при затруднении интерпретиро​вать результаты факторного анализа.
Когда это возможно и приемлемо для целей исследования, следует формализо​вать переменные до проведения факторного анализа. Это позволит аналитику за​ранее сделать предположения о разделении совокупности имеющихся перемен​ных на группы. Задача исследователя при интерпретации результатов факторной матрицы в данном случае упростится, так как он уже не будет начинать «с чистого листа». Его задача сведется к проверке ранее выдвинутых гипотез о принадлежно​сти той или иной переменной к конкретной группе.
Иногда возникают случаи, когда переменная, отнесенная SPSS к конкретному фактору, логически никак не связана с остальными переменными, составляющи​ми тот же фактор. Можно пересчитать факторную модель без отсечения незначи​мых коэффициентов (как в примере на рис. 5.40) и посмотреть, с каким еще факто​ром данная нелогичная переменная коррелирует практически с той же силой, как с фактором, к которому она была отнесена автоматически. Например, переменная Z имеет коэффициент корреляции с фактором 1, равный 0,505, а с фактором 2 она коррелирует с коэффициентом 0,491. SPSS автоматически относит данную пере​менную к тому фактору, с которым выявлена наибольшая корреляция, не учиты​вая при этом, что с другим фактором данная переменная коррелирует практически с той же силой. Именно в такой ситуации (при небольшой разнице в коэффициен​тах корреляции) можно попробовать отнести переменную Z к фактору 2, и если это окажется логичным, рассматривать ее в группе переменных из второго фактора.
Можно вручную сократить число извлекаемых факторов, что облегчит задачу ис​следователя при интерпретации результатов факторного анализа. Однако необхо​димо иметь в виду, что такое сокращение снизит гибкость факторной модели и даже может привести к ситуации, когда переменные будут ложно разделены на неверные, с практической точки зрения, группы. Также снижение числа извлекае​мых факторов неизбежно снизит и долю однозначно классифицированных факто​ров.
В качестве варианта предыдущего решения можно предложить объединить два или более факторов с небольшими количествами входящих в них переменных. Такая группировка, с одной стороны, позволит снизить число интерпретируемых факто​ров, а с другой — облегчит понимание малочисленных факторов.
Если исследователь зашел в тупик и никакие средства не помогают объяснить при​надлежность той или иной переменной к конкретному фактору, остается приме​нить другую статистическую процедуру (например, кластерный анализ).
Вернемся к нашим пяти факторам. Задача их описания и объяснения представля​ется не очень сложной. Так, можно заметить, что утверждения, входящие в первый фактор (q2, q3, q23, ql4, qlO, ql, q21, q5 и ql6), являются общими, то есть касаются всей авиакомпании и описывают отношение к ней со стороны авиапассажиров. Единственное исключение составила переменная q5, имеющая отношение скорее ко второму фактору. Коэффициент корреляции с фактором 2 — 0,355 (см. рис. 5.40), что позволяет отнести его в данную группу из соображений логики. Фактор 2 (ql2, qll, q6, q8, q7 и q4) описывает отношение к авиакомпании X со стороны сотрудни​ков. Третий фактор (ql7, q20 и ql8) описывает отношение респондентов к измене​ниям в авиакомпании (в него попали все утверждения, имеющие корень «мен» — от слова «изменение»). Четвертый фактор (q9, q22 и q24) описывает отношение респондентов к имиджу авиакомпании. Наконец, пятый фактор (ql9, ql3 и ql5) объединяет утверждения, характеризующие отношение респондентов к визуаль​ному образу авиакомпании X.
Таким образом, мы получили пять групп утверждений, описывающих текущую конкурентную позицию компании X на международном рынке авиаперевозок. На основании проведенного интерпретационного (семантического) анализа можно присвоить данным группам (факторам) следующие определения.
■   Фактор 1 характеризует общее положение авиакомпании X в глазах ее клиентов.
■   Фактор 2 характеризует внутреннее состояние авиакомпании X с точки зрения ее сотрудников.
■   Фактор 3 характеризует изменения, происходящие в авиакомпании X.
■   Фактор 4 характеризует имидж авиакомпании X.
■   Фактор 5 характеризует визуальный образ авиакомпании X.
После того как мы успешно интерпретировали все полученные факторы, можно считать факторный анализ завершенным и удавшимся. Далее мы покажем, как можно использовать результаты факторного анализа для построения разрезов.
Вспомним о том, что мы сохранили факторные рейтинги (то есть принадлежность каждого респондента к определенному фактору) в исходном файле данных в виде новых переменных. Эти переменные имеют имена типа: facX_Y, где X — это номер фактора, a Y — порядковый номер факторной модели. Если мы строили факторную модель дважды и в результате в первый раз было извлечено три фактора, а во второй — два, имена переменных будут следующими:
■   facl_l, fac2_l, fac3_l (для трех факторов из первой построенной модели);
■   facl_2, fac2_2 (для двух факторов из второй модели).
В нашем случае будет создано пять новых переменных (по числу извлеченных фак​торов). Эти факторные рейтинги в дальнейшем могут использоваться, например, для построения разрезов. Так, если необходимо выяснить, каким образом респон​денты — мужчины и женщины — оценивают различные стороны деятельности авиа​компании X, это можно сделать при помощи анализа факторных рейтингов.
Наиболее частый способ использования факторных рейтингов в дальнейших рас​четах — это ранжирование и последующее разделение вновь созданных перемен​ных, обозначающих извлеченные факторы, на четыре квартиля (25%-проценти-ля). Такой подход позволяет создать новые переменные с порядковой шкалой, описывающие четыре уровня каждого фактора. В нашем случае для утверждений, составляющих фактор 2, такими уровнями будут: не согласен (состояние внутрен​них дел компании не удовлетворяет сотрудников), скорее не согласен (оценка внут​ренней ситуации в компании ниже среднего), скорее согласен (оценка выше сред​него), согласен (оценка отлично).
Чтобы создать переменные, по которым далее будут группироваться респонденты, вызовите меню Transform ► Rank Cases. В открывшемся диалоговом окне (рис. 5.41) из левого списка выберите переменную, содержащую факторные рейтинги для фактора 2 (fac2_l), и поместите ее в поле Variables. Далее в области Assign Rank I to выберите пункт Smallest value, в нашем случае это означает, что первую группу (не согласен) составят респонденты, оценивающие состояние внутренних дел авиаком​пании как плохое. Соответственно группы 2, 3 и 4 будут определены для катего​рий скорее не согласен, скорее согласен и согласен соответственно.

Щелкните на Rank Types ► Types, отмените установленный по умолчанию параметр Rank и вместо него выберите Ntiles с предустановленным числом групп, равным 4 (рис. 5.42). Щелкните на кнопке Continue и затем в главном диалоговом окне на ОК. Данная процедура создаст в файле данных новую переменную nfac2_l (2 означает второй фактор), распределяющую респондентов на четыре группы.


Все респонденты в выборке характеризуются положительным, скорее положитель​ным, скорее отрицательным или отрицательным отношением к текущему состоя​нию дел в авиакомпании X. Для повышения наглядности рекомендуется присво​ить метки каждому из выделенных четырех уровней; можно переименовать и саму переменную. Теперь вы можете проводить перекрестный анализ при помощи но​вой порядковой переменной, а также строить другие статистические модели, пре​дусмотренные в SPSS. Ниже будет показано, как использовать результаты постро​ения факторной модели в кластерном анализе.
Для иллюстрации возможностей практического использования новой переменной проведем перекрестный анализ влияния пола респондентов на их оценку текуще​го состояния дел в авиакомпании X (рис. 5.43). Как следует из представленной таблицы, респонденты-мужчины в целом склонны ставить более низкие оценки рассматриваемому параметру авиакомпании по сравнению с женщинами. Так, в структуре оценок очень плохо, плохо и удовлетворительно доля мужчин преобладает; в оценках очень хорошо, напротив, преобладают женщины. При переходе в каждую следующую (более высокую) категорию оценок доля мужчин равномерно убыва​ет, а доля женщин, соответственно, возрастает. Тест %2 показывает, что выявлен​ная зависимость является статистически значимой.


5.2.2. Иерархический кластерный анализ
В статистике существует два основных типа кластерного анализа (оба представле​ны в SPSS): иерархический и осуществляемый методом k-средних. В первом случае автоматизированная статистическая процедура самостоятельно определяет опти​мальное число кластеров и ряд других параметров, необходимых для кластерного
анализа. Второй тип анализа имеет существенные ограничения по практической применимости — для него необходимо самостоятельно определять и точное количе​ство выделяемых кластеров, и начальные значения центров каждого кластера (цен​троиды), и некоторые другие статистики. При анализе методом k-средних данные проблемы решаются предварительным проведением иерархического кластерного анализа и затем на основании его результатов расчетом кластерной модели по мето​ду k-средних, что в большинстве случаев не только не упрощает, а наоборот, услож​няет работу исследователя (в особенности неподготовленного).
В целом можно сказать, что в связи с тем, что иерархический кластерный анализ весьма требователен к аппаратным ресурсам компьютера, кластерный анализ по методу k-средних введен в SPSS для обработки очень больших массивов данных, состоящих из многих тысяч наблюдений (респондентов), в условиях недостаточ​ной мощности компьютерного оборудования1. Размеры выборок, используемых в маркетинговых исследованиях, в большинстве случаев не превышают четыре ты​сячи респондентов. Практика маркетинговых исследований показывает, что именно первый тип кластерного анализа — иерархический — рекомендуется для исполь​зования во всех случаях как наиболее релевантный, универсальный и точный. Вместе с тем необходимо подчеркнуть, что при проведении кластерного анализа важным является отбор релевантных переменных. Данное замечание очень суще​ственно, так как включение в анализ нескольких или даже одной нерелевантной переменной способно привести к неудаче всей статистической процедуры.
Описание методики проведения кластерного анализа мы проведем на следующем примере из практики маркетинговых исследований.
Исходные данные:

В ходе исследования было опрошено 745 авиапассажиров, летавших одной из 22 россий​ских и зарубежных авиакомпаний. Авиапассажиров просили оценить по пятибалльной шкале — от 1 (очень плохо) до 5 (отлично) — семь параметров работы наземного персо​нала авиакомпаний в процессе регистрации пассажиров на рейс: вежливость, професси​онализм, оперативность, готовность помочь, регулирование очереди, внешний вид, работа персонала в целом.

Требуется:

Сегментировать исследуемые авиакомпании по уровню воспринимаемого авиапассажи​рами качества работы наземного персонала.
Итак, у нас есть файл данных, который состоит из семи интервальных перемен​ных, обозначающих оценки качества работы наземного персонала различных авиа​компаний (ql3-ql9), представленные в единой пятибалльной шкале. Файл данных содержит одновариантную переменную q4, указывающую выбранные респонден​тами авиакомпании (всего 22 наименования). Проведем кластерный анализ и опре​делим, на какие целевые группы можно разделить данные авиакомпании.
Иерархический кластерный анализ проводится в два этапа. Результат первого эта​па — число кластеров (целевых сегментов), на которые следует разделить иссле​дуемую выборку респондентов. Процедура кластерного анализа как таковая не
может самостоятельно определить оптимальное число кластеров. Она может только подсказать искомое число. Поскольку задача определения оптимального числа сегментов является ключевой, она обычно решается на отдельном этапе анализа. На втором этапе производится собственно кластеризация наблюдений по тому числу кластеров, которое было определено в ходе первого этапа анализа. Теперь рассмотрим эти шаги кластерного анализа по порядку.
Процедура кластерного анализа запускается при помощи меню Analyze ► Classify ► Hierarchical Cluster. В открывшемся диалоговом окне из левого списка всех имею​щихся в файле данных переменных выберите переменные, являющиеся критерия​ми сегментирования. В нашем случае их семь, и обозначают они оценки параметров работы наземного персонала ql3-ql9 (рис. 5.44). В принципе указания совокупно​сти критериев сегментирования будет вполне достаточно для выполнения перво​го этапа кластерного анализа.

По умолчанию кроме таблицы с результатами формирования кластеров, на ос​новании которой мы определим их оптимальное число, SPSS выводит также специальную перевернутую гистограмму icicle, помогающую, по замыслу со​здателей программы, определить оптимальное количество кластеров; вывод ди​аграмм осуществляется кнопкой Plots (рис. 5.45). Однако если оставить дан​ный параметр установленным, мы потратим много времени на обработку даже сравнительно небольшого файла данных. Кроме icicle в окне Plots можно выб​рать более быструю линейчатую диаграмму Dendogram. Она представляет со​бой горизонтальные столбики, отражающие процесс формирования кластеров. Теоретически при небольшом (до 50-100) количестве респондентов данная диаграмма действительно помогает выбрать оптимальное решение относительно требуемого числа кластеров. Однако практически во всех примерах из марке​тинговых исследований размер выборки превышает это значение. Дендограмма становится совершенно бесполезной, так как даже при относительно неболь​шом числе наблюдений представляет собой очень длинную последовательность номеров строк исходного файла данных, соединенных между собой горизон​тальными и вертикальными линиями. Большинство учебников по SPSS содер​жат примеры кластерного анализа именно на таких искусственных, малых вы​борках. В настоящем пособии мы показываем, как наиболее эффективно работать с SPSS в практических условиях и на примере реальных маркетинго​вых исследований.


Как мы установили, для практических целей ни Icicle, ни Dendogram не пригодны. Поэтому в главном диалоговом окне Hierarchical Cluster Analysis рекомендуется не выводить диаграммы, отменив выбранный по умолчанию параметр Plots в области Display, как показано на рис. 5.44. Теперь все готово для выполнения первого этапа кластерного анализа. Запустите процедуру, щелкнув на кнопке ОК.
Через некоторое время в окне SPSS Viewer появятся результаты. Как было сказа​но выше, единственным значимым для нас итогом первого этапа анализа будет таблица Average Linkage (Between Groups), представленная на рис. 5.46. На основа​нии этой таблицы мы должны определить оптимальное число кластеров. Необхо​димо заметить, что единого универсального метода определения оптимального числа кластеров не существует. В каждом конкретном случае исследователь дол​жен сам определить это число.
Исходя из имеющегося опыта, автор предлагает следующую схему данного про​цесса. Прежде всего, попробуем применить наиболее распространенный стандарт​ный метод для определения числа кластеров. По таблице Average Linkage (Between Groups) следует определить, на каком шаге процесса формирования кластеров (ко​лонка Stage) происходит первый сравнительно большой скачок коэффициента аг​ломерации (колонка Coefficients). Данный скачок означает, что до него в кластеры объединялись наблюдения, находящиеся на достаточно малых расстояниях друг от друга (в нашем случае респонденты со схожим уровнем оценок по анализируе​мым параметрам), а начиная с этого этапа происходит объединение более далеких наблюдений.
В нашем случае коэффициенты плавно возрастают от 0 до 7,452, то есть разница между коэффициентами на шагах с первого по 728 была мала (например, между 728 и 727 шагами — 0,534). Начиная с 729 шага происходит первый существенный скачок коэффициента: с 7,452 до 10,364 (на 2,912). Шаг, на котором происходит первый скачок коэффициента, — 729. Теперь, чтобы определить оптимальное ко-
личество кластеров, необходимо вычесть полученное значение из общего числа наблюдений (размера выборки). Общий размер выборки в нашем случае состав​ляет 745 человек; следовательно, оптимальное количество кластеров составляет 745-729 = 16.


Мы получили достаточно большое число кластеров, которое в дальнейшем будет сложно интерпретировать. Поэтому теперь следует исследовать полученные клас​теры и определить, какие из них являются значимыми, а какие нужно попытаться сократить. Данная задача решается на втором этапе кластерного анализа.
Откройте главное диалоговое окно процедуры кластерного анализа (меню Analyze ► Classify ► Hierarchical Cluster). В поле для анализируемых переменных у нас уже есть семь параметров. Щелкните на кнопке Save. Открывшееся диалоговое окно (рис. 5.47) позволяет создать в исходном файле данных новую переменную, рас​пределяющую респондентов на целевые группы. Выберите параметр Single Solution и укажите в соответствующем поле необходимое количество кластеров — 16 (опре​делено на первом этапе кластерного анализа). Щелкнув на кнопке Continue, верни​тесь в главное диалоговое окно, в котором щелкните на кнопке ОК, чтобы запустить процедуру кластерного анализа.
Прежде чем продолжить описание процесса кластерного анализа, необходимо при​вести краткое описание других параметров. Среди них есть как полезные возмож​ности, так и фактически лишние (с точки зрения практических маркетинговых исследований). Так, например, главное диалоговое окно Hierarchial Cluster Analysis содержит поле Label Cases by, в которое при желании можно поместить текстовую переменную, идентифицирующую респондентов. В нашем случае для этих целей может служить переменная q4, кодирующая выбранные респондентами авиаком​пании. На практике сложно придумать рациональное объяснение использованию поля Label Cases by, поэтому можно спокойно всегда оставлять его пустым.


Нечасто при проведении кластерного анализа используется диалоговое окно Sta​tistics, вызываемое одноименной кнопкой в главном диалоговом окне. Оно позво​ляет организовать вывод в окне SPSS Viewer таблицы Cluster Membership, в которой каждому респонденту в исходном файле данных сопоставляется номер кластера. Данная таблица при достаточно большом количестве респондентов (практически во всех примерах маркетинговых исследований) становится совершенно бесполез​ной, так как представляет собой длинную последовательность пар значений «но​мер респондента/номер кластера», в таком виде не поддающуюся интерпретации. Технически цель кластерного анализа всегда состоит в образовании в файле дан​ных дополнительной переменной, отражающей разделение респондентов на целе​вые группы (при помощи щелчка на кнопке Save в главном диалоговом окне клас​терного анализа). Эта переменная в совокупности с номерами респондентов и есть таблица Cluster Membership. Единственный практически полезный параметр в окне Statistics — вывод таблицы Average Linkage (Between Groups), однако он уже установ​лен по умолчанию. Таким образом, использование кнопки Statistics и вывод отдель​ной таблицы Cluster Membership в окне SPSS Viewer является нецелесообразным.
Про кнопку Plots уже было сказано выше: ее следует дезактивизировать, отменив параметр Plots в главном диалоговом окне кластерного анализа.
Кроме этих редко используемых возможностей процедуры кластерного анализа, SPSS предлагает и весьма полезные параметры. Среди них прежде всего кнопка Save, позволяющая создать в исходном файле данных новую переменную, распре​деляющую респондентов по кластерам. Также в главном диалоговом окне суще​ствует область для выбора объекта кластеризации: респондентов или переменных. Об этой возможности говорилось выше в разделе 5.4. В первом случае кластерный анализ используется в основном для сегментирования респондентов по некото​рым критериям; во втором цель проведения кластерного анализа аналогична фак​торному анализу: классификация (сокращение числа) переменных.
Как видно из рис. 5.44, единственной не рассмотренной возможностью кластерно​го анализа является кнопка выбора метода проведения статистической процедуры Method. Эксперименты с данным Параметром позволяют добиться большей точно​сти при определении оптимального числа кластеров. Общий вид этого диалогово​го окна с параметрами, установленными по умолчанию, представлен на рис. 5.48.

Первое, что устанавливается в данном окне, — это метод формирования кластеров (то есть объединения наблюдений). Среди всех возможных вариантов статисти​ческих методик, предлагаемых SPSS, следует выбирать либо установленный по умолчанию метод Between-groups linkage, либо процедуру Ward (Ward's method). Первый метод используется чаще ввиду его универсальности и относительной простоты статистической процедуры, на которой он основан. При использовании этого метода расстояние между кластерами вычисляется как среднее значение рас​стояний между всеми возможными парами наблюдений, причем в каждой итера​ции принимает участие одно наблюдение из одного кластера, а второе — из друго​го. Информация, необходимая для расчетов расстояния между наблюдениями, находится на основании всех теоретически возможных пар наблюдений. Метод Ward более сложен для понимания и используется реже. Он состоит из множества этапов и основан на усреднении значений всех переменных для каждого наблюде​ния и последующем суммировании квадратов расстояний от вычисленных сред​них до каждого наблюдения. Для решения практических задач маркетинговых ис​следований мы рекомендуем всегда использовать метод Between-groups linkage, установленный по умолчанию.
После выбора статистической процедуры кластеризации следует выбрать метод для вычисления расстояний между наблюдениями (область Measure в диалоговом окне Method). Существуют различные методы определения расстояний для трех типов переменных, участвующих в кластерном анализе (критериев сегментирова​ния). Эти переменные могут иметь интервальную (Interval), номинальную (Counts) или дихотомическую (Binary) шкалу. Дихотомическая шкала (Binary) подразуме​вает только переменные, отражающие наступление/ненаступление какого-либо события (купил/не купил, да/нет и т. д.). Другие типы дихотомических перемен​ных (например, мужчина/женщина) следует рассматривать и анализировать как номинальные (Counts).
Наиболее часто используемым методом определения расстояний для интервальных переменных является квадрат евклидова расстояния (Squared Euclidean Distance), устанавливаемый по умолчанию. Именно этот метод зарекомендовал себя в марке​тинговых исследованиях как наиболее точный и универсальный. Однако для дихотомических переменных, где наблюдения представлены только двумя значениями (например, 0 и 1), данный метод не подходит. Дело в том, что он учитывает только взаимодействия между наблюдениями типа: X = 1,Y = 0 и X = 0, Y=l (где X и Y — переменные) и не учитывает другие типы взаимодействий. Наиболее комплексной мерой расстояния, учитывающей все важные типы взаимодействий между двумя дихотомическими переменными, является метод Лямбда (Lambda). Мы рекоменду​ем применять именно данный метод ввиду его универсальности. Однако существу​ют и другие методы, например Shape, Hamann или Anderbergs's D.
При указании метода определения расстояний для дихотомических переменных в соответствующем поле необходимо указать конкретные значения, которые мо​гут принимать исследуемые дихотомические переменные: в поле Present — коди​ровку ответа Да, а в поле Absent — Нет. Названия полей присутствует и отсутствует ассоциированы с тем, что в группе методов Binary предполагается использовать только дихотомические переменные, отражающие наступление/ненаступление какого-либо события. Для двух типов переменных Interval и Binary существует не​сколько методов определения расстояния. Для переменных с номинальным типом шкалы SPSS предлагает всего два метода: 
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 (Chi-square measure) и 
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 (Phi-square measure). Мы рекомендуем использовать первый метод как наиболее распростра​ненный.
В диалоговом окне Method есть область Transform Values, в которой находится поле Standardize. Данное поле применяется в том случае, когда в кластерном анализе при​нимают участие переменные с различным типом шкалы (например, интервальные и номинальные). Для того чтобы использовать эти переменные в кластерном анализе, следует провести стандартизацию, приводящую их к единому типу шкалы — интер​вальному. Самым распространенным методом стандартизации переменных являет​ся 2-стандартизация (Zscores): все переменные приводятся к единому диапазону зна​чений от -3 до +3 и после преобразования являются интервальными.
Так как все оптимальные методы (кластеризации и определения расстояний) ус​тановлены по умолчанию, целесообразно использовать диалоговое окно Method только для указания типа анализируемых переменных, а также для указания необ​ходимости произвести 2-стандартизацию переменных.
Итак, мы описали все основные возможности, предоставляемые SPSS для прове​дения кластерного анализа. Вернемся к описанию кластерного анализа, проводи​мого с целью сегментирования авиакомпаний. Напомним, что мы остановились на шестнадцатикластерном решении и создали в исходном файле данных новую пе​ременную clul6_l, распределяющую все анализируемые авиакомпании по кластерам.
Чтобы установить, насколько верно мы определили оптимальное число класте​ров, построим линейное распределение переменной clul6_l (меню Analyze ► Des​criptive Statistics ► Frequencies). Как видно на рис. 5.49, в кластерах с номерами 5-16 число респондентов составляет от 1 до 7. Наряду с вышеописанным универсаль​ным методом определения оптимального количества кластеров (на основании раз​ности между общим числом респондентов и первым скачком коэффициента агломе​рации) существует также дополнительная рекомендация: размер кластеров должен быть статистически значимым и практически приемлемым. При нашем размере выборки такое критическое значение можно установить хотя бы на уровне 10. Мы видим, что под данное условие попадают лишь кластеры с номерами 1-4. Поэтому
теперь необходимо пересчитать процедуру кластерного анализа с выводом четы-рехкластерного решения (будет создана новая переменная du4_l).

Построив линейное распределение по вновь созданной переменной du4_l, мы уви​дим, что только в двух кластерах (1 и 2) число респондентов является практически значимым. Нам необходимо снова перестроить кластерную модель — теперь для двухкластерного решения. После этого построим распределение по переменной du2_l (рис. 5.50). Как вы видите из таблицы, двухкластерное решение имеет статистичес​ки и практически значимое число респондентов в каждом из двух сформированных кластеров: в кластере 1 — 695 респондентов; в кластере 2 — 40. Итак, мы определили оптимальное число кластеров для нашей задачи и провели собственно сегментиро​вание респондентов по семи избранным критериям. Теперь можно считать основ​ную цель нашей задачи достигнутой и приступать к завершающему этапу кластер​ного анализа — интерпретации полученных целевых групп (сегментов).


Полученное решение несколько отличается от тех, которые вы, может быть, виде​ли в учебных пособиях по SPSS. Даже в наиболее практически ориентированных учебниках приведены искусственные примеры, где в результате кластеризации получаются идеальные целевые группы респондентов. В некоторых случаях (5) авторы даже прямо указывают на искусственное происхождение примеров. В на​стоящем пособии мы применим в качестве иллюстрации действия кластерного анализа реальный пример из практического маркетингового исследования, не от​личающийся идеальными пропорциями. Это позволит нам показать наиболее рас​пространенные трудности проведения кластерного анализа, а также оптимальные методы их устранения.
Перед тем как приступить к интерпретации полученных кластеров, давайте под​ведем итоги. У нас получилась следующая схема определения оптимального чис​ла кластеров.
■   На этапе 1 мы определяем количество кластеров на основании математическо​го метода, основанного на коэффициенте агломерации.
■   На этапе 2 мы проводим кластеризацию респондентов по полученному числу кластеров и затем строим линейное распределение по образованной новой пе​ременной (clul6_l). Здесь также следует определить, сколько кластеров состо​ят из статистически значимого количества респондентов. В общем случае реко​мендуется устанавливать минимально значимую численность кластеров на уровне не менее 10 респондентов.
■   Если все кластеры удовлетворяют данному критерию, переходим к завершаю​щему этапу кластерного анализа: интерпретации кластеров. Если есть класте​ры с незначимым числом составляющих их наблюдений, устанавливаем, сколько кластеров состоят из значимого количества респондентов.
■   Пересчитываем процедуру кластерного анализа, указав в диалоговом окне Save число кластеров, состоящих из значимого количества наблюдений.
■   Строим линейное распределение по новой переменной.
Такая последовательность действий повторяется до тех пор, пока не будет найде​но решение, в котором все кластеры будут состоять из статистически значимого числа респондентов. После этого можно переходить к завершающему этапу клас​терного анализа — интерпретации кластеров.
Необходимо особо отметить, что критерий практической и статистической значи​мости численности кластеров не является единственным критерием, по которому можно определить оптимальное число кластеров. Исследователь может самостоя​тельно, на основании имеющегося у него опыта предложить число кластеров (усло​вие значимости должно удовлетворяться). Другим вариантом является довольно распространенная ситуация, когда в целях исследования заранее ставится усло​вие сегментировать респондентов по заданному числу целевых групп. В этом слу​чае необходимо просто один раз провести иерархический кластерный анализ с со​хранением требуемого числа кластеров и затем пытаться интерпретировать то, что получится.
Для того чтобы описать полученные целевые сегменты, следует воспользоваться процедурой сравнения средних значений исследуемых переменных (кластерных центроидов). Мы сравним средние значения семи рассматриваемых критериев сег​ментирования в каждом из двух полученных кластеров.
Процедура сравнения средних значений вызывается при помощи меню Analyze ► Compare Means ► Means. В открывшемся диалоговом окне (рис. 5.51) из левого спис​ка выберите семь переменных, избранных в качестве критериев сегментирования (ql3-ql9), и перенесите их в поле для зависимых переменных Dependent List. Затем переменную сШ2_1, отражающую разделение респондентов на кластеры при оконча​тельном (двухкластерном) решении задачи, переместите из левого списка в поле для независимых переменных Independent List. После этого щелкните на кнопке Options.

Откроется диалоговое окно Options, выберите в нем необходимые статистики для сравнения кластеров (рис. 5.52). Для этого в поле Cell Statistics оставьте только вывод средних значений Mean, удалив из него другие установленные по умолчанию ста​тистики. Закройте диалоговое окно Options щелчком на кнопке Continue. Наконец, из главного диалогового окна Means запустите процедуру сравнения средних зна​чений (кнопка ОК).

В открывшемся окне SPSS Viewer появятся результаты работы статистичес​кой процедуры сравнения средних значений. Нас интересует таблица Report (рис. 5.53). Из нее можно увидеть, на каком основании SPSS разделила респон​дентов на два кластера. Таким критерием в нашем случае служит уровень оце​нок по анализируемым параметрам. Кластер 1 состоит из респондентов, для которых средние оценки по всем критериям сегментирования находятся на срав​нительно высоком уровне (4,40 балла и выше). Кластер 2 включает респонден​тов, оценивших рассматриваемые критерии сегментирования достаточно низ​ко (3,35 балла и ниже). Таким образом, можно сделать вывод о том, что 93,3 % респондентов, сформировавшие кластер 1, оценили анализируемые авиаком​пании по всем параметрам в целом хорошо; 5,4 % — достаточно низко; 1,3 % — затруднились ответить (см. рис. 5.50). Из рис. 5.53 можно также сделать вывод о том, какой уровень оценок для каждого из рассматриваемых параметров в от​дельности является высоким, а какой — низким (причем данный вывод будет сделан со стороны респондентов, что позволяет добиться высокой точности классификации). Из таблицы Report можно видеть, что для переменной Регули​рование очереди высоким считается уровень средней оценки 4,40, а для пара​метра Внешний вид — 4.72.


Может оказаться, что в аналогичном случае по параметру X высокой оценкой счи​тается 4,5, а по параметру Y — только 3,9. Это не будет ошибкой кластеризации, а напротив, позволит сделать важный вывод относительно значимости для респон​дентов рассматриваемых параметров. Так, для параметра Y уже 3,9 балла является хорошей оценкой, тогда как к параметру X респонденты предъявляют более стро​гие требования.
Мы идентифицировали два значимых кластера, различающиеся по уровню сред​них оценок по критериям сегментирования. Теперь можно присвоить метки полу​ченным кластерам: для 1 — Авиакомпании, удовлетворяющие требованиям респонден​тов (по семи анализируемым критериям); для 2 — Авиакомпании, не удовлетворяющие требованиям респондентов. Теперь можно посмотреть, какие конкретно авиакомпа​нии (закодированные в переменной q4) удовлетворяют требованиям респонден​тов, а какие — нет по критериям сегментирования. Для этого следует построить перекрестное распределение переменной q4 (анализируемые авиакомпании) в за​висимости от кластеризующей переменной clu2_l. Результаты такого перекрест​ного анализа представлены на рис. 5.54.
По этой таблице можно сделать следующие выводы относительно членства иссле​дуемых авиакомпаний в выделенных целевых сегментах.
1. Авиакомпании, полностью удовлетворяющие требованиям всех клиентов по параметру работы наземного персонала (входят только в один первый клас​тер):
■   Внуковские авиалинии;
■   American Airlines;
■   Continental;
■   Delta Airlines;
■   Air France;
■   Alitalia;
■   Austrian Airlines;
■   British Airways;
■   Swiss Air;
■   KLM;
■   Lufthansa;
■   SAS;
■   Korean Airlines;
■   Japan Airlines.
2.   Авиакомпании, удовлетворяющие требованиям большинства своих клиентов по параметру работы наземного персонала (большая часть респондентов, лета​ющих данными авиакомпаниями, удовлетворены работой наземного персонала):
■   Трансаэро.
3.   Авиакомпании, не удовлетворяющие требованиям большинства своих клиен​тов по параметру работы наземного персонала (большая часть респондентов, летающих данными авиакомпаниями, не удовлетворены работой наземного пер​сонала):
■   Домодедовские авиалинии;
■   Пулково;
■   Сибирь;
■   Уральские авиалинии;
■   Самарские авиалинии;
■   KrasAir;
■   Finnair.
Таким образом, получено три целевых сегмента авиакомпаний по уровню средних оценок, характеризующиеся различной степенью удовлетворенности респонден​тов работой наземного персонала:
1.   наиболее привлекательные для пассажиров авиакомпании по уровню работы наземного персонала (14);
2.   скорее привлекательные авиакомпании (1);
3.   скорее непривлекательные авиакомпании (7).
Мы успешно завершили все этапы кластерного анализа и сегментировали авиа​компании по семи выделенным критериям.
Теперь приведем описание методики кластерного анализа в паре с факторным. Используем условие задачи из раздела 5.2.1 (факторный анализ). Как уже было сказано, в задачах сегментирования при большом числе переменных целесообраз​но предварять кластерный анализ факторным. Это делается для сокращения ко​личества критериев сегментирования до наиболее значимых. В нашем случае в исходном файле данных у нас есть 24 переменные. В результате факторного ана​лиза нам удалось сократить их число до 5. Теперь это число факторов может эф​фективно применяться для кластерного анализа, а сами факторы — использовать​ся в качестве критериев сегментирования.
Если перед нами стоит задача сегментировать респондентов по их оценке различ​ных аспектов текущей конкурентной позиции авиакомпании X, можно провести иерархический кластерный анализ по выделенным пяти критериям (переменные nfacl_l-nfac5_l). В нашем случае переменные оценивались по разным шкалам. Например, оценка 1 для утверждения Я бы не хотел, чтобы авиакомпания менялась и такая же оценка утверждению Изменения в авиакомпании будут позитивным момен​том диаметрально противоположны по смыслу. В первом случае 1 балл (совершен​но не согласен) означает, что респондент приветствует изменения в авиакомпании; во втором случае оценка в 1 балл свидетельствует о том, что респондент отвергает изменения в авиакомпании. При интерпретации кластеров у нас неизбежно воз​никнут трудности, так как такие противоположные по смыслу переменные могут
попасть в один и тот же фактор. Таким образом, для целей сегментирования реко​мендуется сначала привести в соответствие шкалы исследуемых переменных, а за​тем пересчитать факторную модель. И уже далее проводить кластерный анализ над полученными в результате факторного анализа переменными-факторами. Мы не будем снова подробно описывать процедуры факторного и кластерного анализа (это было сделано выше в соответствующих разделах). Отметим лишь, что при такой методике в результате у нас получилось три целевые группы авиапассажи​ров, различающихся по уровню оценок выделенным факторам (то есть группам переменных): низшая, средняя и высшая.
Весьма полезным применением кластерного анализа является разделение на груп​пы частотных таблиц. Предположим, у нас есть линейное распределение ответов на вопрос Какие марки антивирусов установлены в Вашей организации?. Для форми​рования выводов по данному распределению необходимо разделить марки анти​вирусов на несколько групп (обычно 2-3). Чтобы разделить все марки на три группы (наиболее популярные марки, средняя популярность и непопулярные марки), лучше всего воспользоваться кластерным анализом, хотя, как правило, исследователи разделяют элементы частотных таблиц на глаз, основываясь на субъективных соображениях. В противоположность такому подходу кластерный анализ позволяет научно обосновать выполненную группировку. Для этого сле​дует ввести значения каждого параметра в SPSS (эти значения целесообразно выражать в процентах) и затем выполнить кластерный анализ для этих данных. Сохранив кластерное решение для необходимого количества групп (в нашем слу​чае 3) в виде новой переменной, мы получим статистически обоснованную груп​пировку.
Заключительную часть этого раздела мы посвятим описанию применения клас​терного анализа для классификации переменных и сравнения его результатов с результатами факторного анализа, проведенного в разделе 5.2.1. Для этого мы вновь воспользуемся условием задачи про оценку текущей позиции авиакомпа​нии X на рынке авиаперевозок. Методика проведения кластерного анализа прак​тически полностью повторяет описанную выше (когда сегментировались респон​денты).
Итак, в исходном файле данных у нас есть 24 переменные, описывающие отноше​ние респондентов к различным аспектам текущей конкурентной позиции авиаком​пании X. Откройте главное диалоговое окно Hierarchical Cluster Analysis и поместите 24 переменные (ql-q24) в поле Variable(s), рис. 5.55. В области Cluster укажите, что вы классифицируете переменные (отметьте параметр Variables). Вы увидите, что кнопка Save стала недоступна — в отличие от факторного, в кластерном анализе нельзя сохранить факторные рейтинги для всех респондентов. Откажитесь от вы​вода диаграмм, дезактивизировав параметр Plots. На первом этапе вам не нужны другие параметры, поэтому просто щелкните на кнопке О К, чтобы запустить про​цедуру кластерного анализа.
В окне SPSS Viewer появилась таблица Agglomeration Schedule, по которой мы оп​ределили оптимальное число кластеров описанным выше методом (рис. 5.56). Пер​вый скачок коэффициента агломерации наблюдается на 20 шаге (с 18834,000 до 21980,967). Исходя из общего числа анализируемых переменных, равного 24, можно вычислить оптимальное число кластеров: 24 - 20 = 4.



При классификации переменных практически и статистически значимым является кластер, состоящий всего из одной переменной. Поэтому, поскольку мы получили приемлемое число кластеров математическим методом, проведение дальнейших проверок не требуется. Вместо этого снова откройте главное диалоговое окно клас​терного анализа (все данные, использованные на предыдущем этапе, сохранились) и щелкните на кнопке Statistics, чтобы организовать вывод классификационной таб​лицы. Вы увидите одноименное диалоговое окно, где необходимо указать число кластеров, на которое необходимо разделить 24 переменные (рис. 5.57). Для этого выбе​рите параметр Single solution и в соответствующем поле укажите требуемое число кластеров: 4. Теперь закройте диалоговое окно Statistics щелчком на кнопке Continue и из главного окна кластерного анализа запустите процедуру на выполнение.

В результате в окне SPSS Viewer появится таблица Cluster Membership, распределя​ющая анализируемые переменные на четыре кластера (рис. 5.58).

По данной таблице можно отнести каждую рассматриваемую переменную в опре​деленный кластер следующим образом.
Кластер 1
ql. Авиакомпания X обладает репутацией компании, превосходно обслуживающей пасса​жиров.
q2. Авиакомпания X может конкурировать с лучшими авиакомпаниями мира.
q3. Я верю, что у авиакомпании X есть перспективное будущее в мировой авиации.
q5. Я горжусь тем, что работаю в авиакомпании X.
q9. Нам предстоит долгий путь, прежде чем мы сможем претендовать на то, чтобы назы​ваться авиакомпанией мирового класса.
qlO. Авиакомпания X действительно заботится о пассажирах.
ql3. Мне нравится, как в настоящее время авиакомпания X представлена визуально ши​рокой общественности (в плане цветовой гаммы и фирменного стиля).
ql4. Авиакомпания X — лицо России.
ql6. Обслуживание авиакомпании X является последовательным и узнаваемым во всем
мире.
ql8. Авиакомпании X необходимо меняться для того, чтобы использовать в полной мере имеющийся потенциал.
ql9. Я думаю, что авиакомпании X необходимо представить себя в визуальном плане бо​лее современно.
q20. Изменения в авиакомпании X будут позитивным моментом. q21. Авиакомпания X — эффективная авиакомпания.
q22. Я бы хотел, чтобы имидж авиакомпании X улучшился с точки зрения иностранных пассажиров.
q23. Авиакомпания X — лучше, чем многие о ней думают.
q24. Важно, чтобы люди во всем мире знали, что мы — российская авиакомпания.
Кластер 2
q4. Я знаю, какой будет стратегия развития авиакомпании X в будущем.
q6. В авиакомпании X хорошее взаимодействие между подразделениями.
q7. Каждый сотрудник авиакомпании прикладывает все усилия для того, чтобы обеспе​чить ее успех.
q8. Сейчас авиакомпания X быстро улучшается.
qll. Среди сотрудников авиакомпании имеет место высокая степень удовлетворенности работой.
ql2. Я верю, что менеджеры высшего звена прикладывают все усилия для достижения успеха авиакомпании.
Кластер 3
ql5. Мы выглядим «вчерашним днем» по сравнению с другими авиакомпаниями.
Кластер 4
ql7. Я бы не хотел, чтобы авиакомпания X менялась.
Сравнив результаты факторного (раздел 5.2.1) и кластерного анализов, вы увиди​те, что они существенно различаются. Кластерный анализ не только предоставля​ет существенно меньшие возможности для кластеризации переменных (например, отсутствие возможности сохранять групповые рейтинги) по сравнению с фактор​ным анализом, но и выдает гораздо менее наглядные результаты. В нашем случае, если кластеры 2, 3 и 4 еще поддаются логической интерпретации1, то кластер 1 содержит совершенно разные по смыслу утверждения. В данной ситуации можно либо попытаться описать кластер 1 как есть, либо перестроить статистическую модель с другим числом кластеров. В последнем случае для поиска оптимального числа кластеров, поддающихся логическому описанию, можно воспользоваться параметром Range of solutions в диалоговом окне Statistics (см. рис. 5.57), указав в соответствующих полях минимальное и максимальное число кластеров (в нашем случае 4 и 6 соответственно). В такой ситуации SPSS перестроит таблицу Cluster Membership для каждого числа кластеров. Задача аналитика в данном случае — по​пытаться подобрать такую классификационную модель, при которой все кластеры будут интерпретироваться однозначно. С целью демонстрации возможностей про​цедуры кластерного анализа для кластеризации переменных мы не будем пере​страивать кластерную модель, а ограничимся лишь сказанным выше.
Необходимо отметить, что, несмотря на кажущуюся простоту проведения клас​терного анализа по сравнению с факторным, практически во всех случаях из мар​кетинговых исследований факторный анализ оказывается быстрее и эффек​тивнее кластерного. Поэтому для классификации (сокращения) переменных мы настоятельно рекомендуем использовать именно факторный анализ и оставить применение кластерного анализа для классификации респондентов.
Классификационный анализ является, пожалуй, одним из наиболее сложных, с точ​ки зрения неподготовленного пользователя, статистических инструментов. С этим связана его весьма малая распространенность в маркетинговых компаниях. Вмес​те с тем именно данная группа статистических методов является и одной из наибо​лее полезных для практиков в области маркетинговых исследований.
	Заключение


SPSS — это мощный современный аналитический инструмент, при помощи кото​рого можно проводить любой тип анализа данных в маркетинговых исследовани​ях. И в то время как построение математических моделей обычно считается пре​рогативой ученых, статистический анализ данных — это задача исследователей. Исследования являются неотъемлемой частью работы маркетологов, поэтому до тех пор, пока будут существовать вопросы, подлежащие решению при помощи маркетингового анализа, будет существовать и потребность в проведении статис​тического анализа данных. Цель настоящего пособия — сделать проведение стати​стического анализа понятным каждому исследователю.
Компания SPSS Inc. разработала целый ряд руководств, в которых подробно опи​сываются выпущенные ею программные продукты. В сумме они насчитывают 5000 страниц, где вы найдете ответ на любой вопрос, связанный с работой практикую​щего исследователя. Однако все эти пособия написаны преимущественно на анг​лийском языке, что является препятствием для многих отечественных маркетоло​гов. Руководства содержат весь объем информации о возможностях SPSS, включая информацию, которая используется редко либо вообще неприменима к маркетин​говым исследованиям. В настоящем же пособии страниц гораздо меньше, и наша задача состояла в том, чтобы рассказать о ключевых моментах применения SPSS именно в маркетинговых исследованиях, с учетом специфических особенностей данного вида профессиональной деятельности. Несмотря на небольшой объем на​стоящего руководства, оно охватывает 95 % всех используемых на практике стати​стических методик. Для изучения оставшихся 5 % методов, редко применяемых в маркетинговых исследованиях, мы рекомендуем обратиться к оригинальным ру​ководствам по SPSS.
	Приложение.

12 полезных советов


Напоследок хочется рассказать о некоторых полезных свойствах программы SPSS, которые существенно облегчат работу с ней.
1.   Несколько файлов (баз данных) SPSS можно объединять, добавляя при этом либо новые переменные, либо новых респондентов.
Чтобы добавить поля (переменные) в базу данных SPSS, подготовьте два файла данных (за один цикл можно объединить только два файла). В обоих файлах — реципиенте (база данных, в которую следует добавить переменные) и доноре (база данных, в которой содержатся добавляемые переменные) — необходи​мо, во-первых, проследить, чтобы имена добавляемых переменных не повто​ряли имя файла-реципиента; во-вторых, создать ключевое поле, то есть пере​менную, уникальным образом идентифицирующую респондентов. Обычно эту роль берет на себя номер анкеты. Отсортируйте оба файла по этой перемен​ной (одинаковым образом: по возрастанию или убыванию). При помощи меню Data ► Merge Files ► Add Variables в открывшемся диалоговом окне выберите эту ключевую переменную; затем выберите параметр Match case on key variables in sorted files; поместите ключевую переменную в поле Key Variables. Щелкните на кнопке ОК, и в файл-реципиент будут добавлены новые переменные из файла-донора (после всех существующих переменных).
Добавление респондентов происходит следующим образом. Убедитесь, что оба файла (реципиент и донор) содержат одинаковые переменные (по имени и типу). Откройте диалоговое окно добавления респондентов при помощи меню Data ► Merge Files ► Add Cases. В нем будут автоматически отобраны и помеще​ны в файл-реципиент только одинаковые переменные. После щелчка на кноп​ке О К изменения вступят в силу: новые респонденты будут добавлены в конец рабочего файла.
2.   Построенные диаграммы можно изменять, дважды щелкнув на них мышью в окне SPSS Viewer. Простые диаграммы, как будет показано в п. 3, содержат лишь базовые возможности форматирования диаграмм (в специальном окне SPSS Chart Editor), тогда как интерактивные диаграммы предоставляют зна​чительный набор средств, аналогичных MS Microsoft Excel.
3.   Графическая подсистема SPSS позволяет строить обычные (Simple) и инте​рактивные (Interactive) диаграммы. Вторые отличаются от первых более ши​рокими возможностями форматирования. Однако какой бы тип диаграммы вы ни выбрали, они все равно не будут иметь такого же привлекательного вида, как диаграммы в Microsoft Excel. Диаграммы, выводимые в качестве дополни​тельного параметра в различных статистических процедурах (меню Analyze), - это только обычные диаграммы. Они предназначены исключительно для ис​пользования в процессе анализа данных аналитиками и не подходят для пре​зентаций. Обычные диаграммы можно строить и отдельно от статистических процедур — при помощи меню Graphs. При этом если, скажем, в Microsoft Excel все диаграммы могут быть «на лету» преобразованы одна в другую, то в SPSS однажды построенная диаграмма может менять только элементы форматиро​вания. Наиболее часто используемые виды диаграмм: Ваг (гистограмма), Line (график), Pie (сектограмма) и Scatter (точечная). Интерактивные диаграммы доступны посредством меню Graphs ► Interactive, которое также содержит че​тыре типа наиболее часто используемых видов диаграмм. Обычные и инте​рактивные диаграммы могут быть как плоскими, так и объемными.
4.   Таблицы в окне SPSS Viewer можно изменять, дважды щелкнув на них мы​шью. Далее выберите в меню Pivot пункт Pivoting Trays. Откроется дополни​тельное окно, с помощью которого можно поменять местами столбцы, ряды и уровни таблицы.
5.   После создания таблиц линейных или перекрестных распределений на их ос​нове можно строить различные диаграммы. Дважды щелкните на таблице мы​шью, чтобы открыть ее. Затем выделите требуемые числовые значения (без названий переменных и вариантов ответа) и щелкните правой кнопкой мыши. В появившемся контекстном меню выберите Create Graph и в нем — требуемый тип диаграммы. После этого, например, будет построена интерактивная диа​грамма.
6.   Меню Analyze ► Custom Tables предоставляет доступ к диалоговым окнам, пред​назначенным для построения одно- и многомерных таблиц. При помощи этих окон вы можете создавать более презентабельные таблицы, чем Frequencies или Crosstabs. Мы рекомендуем использовать диалоговое окно Multiple Response Tables для работы с многовариантными переменными (вместо стандартной процеду​ры Analyze ► Multiple Response).
7.   Часто при работе с SPSS возникает необходимость скопировать результаты работы программы из окна SPSS Viewer в Microsoft Word или Microsoft Excel. Для того чтобы скопировать диаграмму, выделите ее, щелкнув на ней правой кнопкой мыши, и в открывшемся контекстном меню выберите пункт Сору. Таблицы копируются методами, различными для Microsoft Word и Microsoft Excel. Так, чтобы скопировать таблицу в Microsoft Excel, выделите ее правой кнопкой мыши и в открывшемся меню выберите пункт Сору. После этого вставка в Microsoft Excel производится обычным способом. В Microsoft Word вы можете вставить таблицу, во-первых, в виде рисунка (метафайла) — вы​делите ее при помощи правой кнопки мыши и выберите пункт Copy Objects (при этом таблицу нельзя изменять) — и, во-вторых, в виде собственно таб​лицы. Однако если вы просто скопируете и вставите ее в Microsoft Word, таблица потеряет оформление и может стать нечитаемой. Мы рекомендуем вставлять таблицу в Microsoft Word, предварительно скопировав ее в Micro​soft Excel.
8. В любых диалоговых окнах SPSS, так же как и в окне SPSS Viewer, вы можете получить справку по конкретным элементам (кнопкам, полям, статистикам) — для этого щелкните на них правой кнопкой мыши. Чтобы уточнить смысл какой-либо статистики, представленной в объектах SPSS Viewer, сначала нуж​но открыть их двойным щелчком мыши, а затем при помощи правой кнопки мыши получить информацию об интересующей статистике.
9. Весьма мощным средством работы с SPSS для опытных исследователей явля​ется командный синтаксис (Syntax). С его помощью можно, во-первых, авто​матизировать повторяющиеся операции (например, построение 30 регрессий), а во-вторых, получать доступ к статистическим процедурам, не выведенным в основное меню программы (например, MANOVA). Краткое описание команд​ного синтаксиса заняло бы много страниц. Тем не менее даже начинающие аналитики, не имеющие опыта работы с ним, могут достаточно эффективно использовать командный синтаксис, изучая автоматически генерируемые при работе с меню команды. Для того чтобы увидеть внутреннюю команду синтак​сиса при работе с какой-либо статистической процедурой, следует предвари​тельно выбрать в меню Edit ► Options на вкладке Viewer параметр Display commands in the log. После этого все ваши действия будут автоматически отображаться в окне SPSS Viewer в виде простого текста, который можно скопировать в окно Syntax (вызывается при помощи меню File ► New ► Syntax).
10.   Не следует путать программный синтаксис (Syntax) со встроенным языком про​граммирования SPSS (Script). Окно программирования открывается при помо​щи меню File ► New ► Script. Язык программирования SPSS похож на Microsoft Visual Basic for Applications (VBA), однако он содержит отдельные функции, специфичные для работы со структурой базы данных формата SPSS. Встроен​ный язык программирования весьма беден на визуальные средства интерактив​ного пользовательского интерфейса, однако он может с успехом применяться в качестве клиента автоматизации, то есть для интегрирования различных при​ложений, поддерживающих VBA (например, все приложения Microsoft Office) с SPSS. При помощи этого языка можно, например, строить графики в Microsoft Excel или формировать демонстрационные отчеты в Microsoft Word.
11.   Командный синтаксис SPSS обладает многими возможностями полноценного макроязыка. В нем есть переменные, циклы, условные операции и т. д. Однако в некоторых случаях языка синтаксиса оказывается недостаточно. Мы рекомендуем использовать командный синтаксис для операций с матрицей данных, то есть с анкетами респондентов, находящимися в окне Data View. Иными словами, прово​дить такие операции, как чистка базы данных (корректировка пропущенных зна​чений, логической структуры ответов и т. п.), формирование исходного списка переменных в окне Variable View, «подвешивание» меток переменных, а также опе​рации с отдельными ячейками данных (например, копирование-вставка из дру​гих программ). Для операций с результатами расчетов (таблицами, результатами статистических тестов и т. д.), расположенными в окне SPSS Viewer, рекоменду​ется использовать другой встроенный язык программирования SPSS — язык скриптов. Практика показывает, что большинство компаний, занимающихся мар​кетинговыми исследованиями, производят обработку таблиц, построенных в SPSS, в других программах (чаще всего в MS Excel). Ниже мы покажем, как при помо​щи языка скриптов SPSS автоматизировать процесс переноса таблиц из окна SPSS Viewer в MS Excel (для построения диаграмм) и в MS Word.
Мы уже не раз упоминали о слабости графической подсистемы SPSS. В связи с этим исследователи строят диаграммы в MS Excel, копируя их из окна SPSS
Viewer. Этот процесс может стать «узким местом» всего исследования, так как при большом объеме таблиц с линейными и перекрестными распределениями процесс построения диаграмм занимает весьма значительный период време​ни. Давайте посмотрим, как можно легко и быстро автоматизировать данный процесс. Итак, предположим, что у нас есть 100 таблиц с линейными распре​делениями по различным вопросам анкеты. Все эти таблицы находятся в окне SPSS Viewer. Откройте редактор скриптов SPSS при помощи меню File ► New ► Script. Появится диалоговое окно Use Starter Script, которое предлагает использовать текст уже написанной программы в качестве шаблона для наше​го скрипта. Мы будем создавать скрипт самостоятельно, поэтому просто щел​кните на кнопке Отмена. Появится окно редактора скриптов SPSS, содержа​щее полноценную среду разработки (IDE). Слева вы увидите две вкладки — 1 и 2. Мы будем писать скрипт1 на установленной по умолчанию вкладке 1. Скрипты в SPSS пишутся на VBA-совместимом языке Sax Basic. Его возмож​ности в целом более ограничены по сравнению с VBA (а средства разработки диалоговых окон не выдерживают никакой критики). В окне редактора скрип​тов SPSS по умолчанию введены начальная и конечная строки программы:
Sub Main
End Sub
Пользователь не должен изменять эти строки. Весь текст программы записы​вается между данными двумя строками2. Для переноса всего содержимого окна SPSS Viewer в MS Word следует ввести в редакторе скриптов следующий текст (листинг П. 1).
После того как вы введете этот текст в окно редактора скриптов SPSS, запустите его на выполнение при помощи щелчка на кнопке с символом ► на панели инструментов или просто нажав F5. В результате выполнения данной программы будет создан новый документ MS Word, содержащий все таблицы из окна SPSS Viewer.
Для того чтобы перенести все таблицы из окна SPSS Viewer в MS Excel, нуж​но ввести между начальной и конечной строками программы в редакторе син​таксиса следующий текст (листинг П.2).
В результате выполнения данной программы будет создана новая рабочая кни​га MS Excel, в которой на каждой вкладке будет одна таблица из окна SPSS Viewer. Далее можно написать макрос (например, на VBA) для построения диаграмм на основании таблиц, содержащихся в MS Excel.
12. И наконец, последнее. Согласно статистической теории, чтобы сделать возмож​ным применение большинства статистических процедур, данные должны под​чиняться закону нормального распределения. Если это не так, теоретически вместо стандартных тестов следует проводить непараметрические тесты. На практике (в маркетинговых исследованиях) данные оказываются нормально распределены редко. Более того, многие исследователи просто игнорируют дан​ный теоретический постулат, считая данные, не подчиняющиеся нормальному распределению, выбросами (случайными значениями). Данная техника действи​тельно оправдывает себя во многих примерах маркетинговых исследований, когда от абсолютной точности построенных статистических моделей ровным счетом ничего не зависит. Ведь исследователей в большинстве случаев интере​сует лишь общее направление различий, связей и т. п. В этом и заключается спе​цифика маркетинговых исследований: нас не интересует, как ведет себя каж​дый респондент в выборке, — нам интересно знать, как ведут себя целевые группы. В частности, по этой причине в настоящем пособии мы не приводили проверку данных на нормальное распределение в качестве обязательного предваритель​ного этапа статистического анализа. Если вас все же заинтересует форма рас​пределения данных, это легко выяснить при помощи критерия Колмогорова-Смирнова. Откройте соответствующее диалоговое окно при помощи меню Analyze ► Nonparametric Tests ► 1-Sample K-S. На рис. П.1 показан общий вид данного окна.
Для того чтобы протестировать какую-либо переменную на нормальность рас​пределения, перенесите ее из левого списка всех доступных переменных в об​ласть для тестируемых переменных Test Variable List. Затем выберите тип распре​деления, на соответствие которому вы собираетесь проводить тестирование. По умолчанию выбран только тест на нормальное распределение (Normal). Также можно провести тест на распределение Пуассона (Poisson), равномерное (Uniform) и экспоненциальное распределение (Exponential). Как в тесте %2 (см. раздел 4.1), тесты на вид распределения можно проводить асимптотическими методами и точными методами (Exact). Точные методы могут применяться в тех случаях, когда асимптотические методы неприменимы (например, при малых размерах выборки). Мы рекомендуем всегда проверять результаты асимптотических ме​тодов при помощи точных. Вывод точных тестов на вид распределения осуще​ствляется при помощи кнопки Exact. Вид соответствующего диалогового окна аналогичен виду окна для теста %2. Напомним, что в нем следует выбрать пара​метр Monte-Carlo и указать доверительный уровень 95 %.




В результатах данного теста (окно SPSS Viewer) наше внимание должна привлечь значимость тестовой характеристики: асимптотическая (строка Asymp. Sig. (2-tai-led)) и точная (строка Monte Carlo Sig.). На рис. П.2 представлен общий вид выводи​мых результатов при тесте на нормальное распределение. Так как нулевая (исход​ная) гипотеза для тестирования состоит в наличии нормального распределения, вероятность (статистическая значимость) менее 0,05 означает, что исследуемая переменная не подчиняется закону нормального распределения. Таким образом, значимая тестовая величина означает отсутствие, а незначимая — наличие иссле​дуемого распределения.
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Рис. В.1. Принципиальная схема проведения полевого маркетингового исследования
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Рис. В.2. Классификация основных методов статистического анализа в процессе его проведения в маркетинговых исследованиях








Рис 1.1 Общая схема построения файла данных SPSS





Рис. 1.2. Таблицы данных, подходящие для импорта в SPSS: таблица MS Access








Рис. 1.5 Таблицы данных, подходящие для импорта SPSS: текстовый файл с разделителями





Рис. 1.5 Диалоговое окно Database Wizard





Рис. 1.7. Диалоговое окно Администратор источников данных ODBC





Рис. 1.8. Диалоговое окно Создание нового источника данных





Рис. 1.9. Диалоговое окно Установка драйвера ODBC для Paradox








Рис. 1.10. Диалоговое окно ODBC Driver Login








Рис. 1.11. Диалоговое окно Database Wizard, шаг 2 из б








Рис. 1.12. Окно SPSS Data Editor, вкладка Variable View








Рис. 1.13. Диалоговое окно Variable Type








Рис. 1.14. Диалоговое окно Value Labels








Рис. 1.15. Диалоговое окно Select Cases





Рис.1.16. Диалоговое окно Select Cases: If








Рис. 1.17. Диалоговое окно Select Cases: Random Sample





Рис. 1.18. Диалоговое окно Sort Cases








Рис. 1.19. Диалоговое окно Categorize Variables








Рис. 1.20. Диалоговое окно Recode into Same Variables








Рис. 1.21. Диалоговое окно Old and New Values








Рис. 1.22. Диалоговое окно Recode into Different Variables








Рис. 1.23. Диалоговое окно Old and New Values








Рис. 1.24. Диалоговое окно Automatic Recode








Рис. 1.25. Список перекодировки








Рис. 1.26. Диалоговое окно Compute Variable











Рис. 1.27. Диалоговое окно Type and Label








Рис. 1.28. Диалоговое окно Count Occurrences of Values within Cases











Рис. 1.29. Диалоговое окно Values to Count








Рис. 1.31. Диалоговое окно Weight Cases








Рис. 2.1. Диалоговое окно Frequencies с 


выбранной для анализа переменной Возраст








Рис. 2.2. Диалоговое окно Statistics








Рис. 2.3. Диалоговое окно Charts








Рис. 2.4. Диалоговое окно Format








Рис. 2.5. Таблица Statistics
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Рис. 2.6. Таблица Возраст
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Рис. 2.7. Диаграмма Возраст








Рис. 2.8. Диалоговое окно Pie Options
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Рис. 2.9. Таблица Statistics








Рис. 2.10. Диалоговое окно Define Multiple Response Sets со сформированной многовариантной переменной Торговые точки








Рис. 2.11. Диалоговое окно Multiple Response Frequencies
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Рис. 2.12. Таблица Multiple Response, отражающая результаты построения линейного распределения по многовариантной переменной Торговые точки





Рис. 2.13. Диалоговые окна Bar Charts с выбранными параметрами для построения гистограмм и сектограмм по многовариантной переменной





Рис. 2.14. Диалоговые окна Pie Charts с выбранными параметрами для построения гистограмм и сектограмм по многовариантной переменной





Рис. 2.15. Диалоговое окно Summaries of Separate Variables с выбранной для построения многовариантной переменной Торговые точки





Рис. 2.16. Диалоговое окно Summary Function








Рис. 2.17. Диалоговое окно Options





Рис. 2.18. Гистограмма по многовариантной переменной Торговые точки





Рис. 3.1. Диалоговое окно Independent-Samples T Test





Рис. 3.2. Диалоговое окно Define Groups








Рис. 3.3. Диалоговое окно Independent-Samples T Test: Options
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Рис. З.4. Результаты расчета t-теста для независимых выборок








Рис. 3.5. Диалоговое окно Paired-Samples T Test
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Рис. З.6. Результаты расчетов t-теста для спаренных выборок








Рис. 3.7. Диалоговое окно One-Sample T Test








Рис. З.8. Результаты расчета t-теста для одной выборки








Рис. 3.9. Диалоговое окно Univariate





Рис. 3.10. Диалоговое окно Univariate: Post Hoc Multiple Comparisons for Observed Means








Рис. 3.11. Диалоговое окно Univariate: Options








Рис. 3.12. Таблица Levene's Test of Equality of Error Variances








Рис. 3.13. Таблица Tests of Between-Subjects Effects





Рис. 3.14. Таблица Multiple Comparisons





Рис. 3.15. Таблица Homogeneous Subsets





Рис. 3.16. Таблица Levene's Test of Equality of Error Variances





Рис. 3.17. Таблица Tests of Between-Subjects Effects





Рис. 3.18. Таблицы Estimated Marginal Means





Рис. 3.19. Диалоговое окно Univariate: Model





Рис. 3.20. Диалоговое окно Univariate: Profile Plots








Рис. 3.21. График взаимодействия q3*q4





Рис. 3.22. Значимые различия между взаимодействиями факторов





Рис. 3.23. Незначимые различия между взаимодействиями факторов








Рис. 3.24. Диалоговое окно Repeated Measures Define Factors





Рис. 3.25. Диалоговое окно Repeated Measures





Рис. 3.26. Таблица Box's Test of Equality of Covariance Matrices





Рис. 3.27. Таблица Multivariate Tests








Рис. 3.28. Таблица Levene's Tests of Equality of Error Variances








Рис. 3.29. Таблица Tests of Between-Subjects Effects








Рис. 3.30. Таблица Homogeneous Subsets (вторая часть: MEASURE_1)








Рис. 3.31. Диалоговое окно Multivariate








Рис. 3.32. Таблица Box's Test of Equality of Covariance Matrices





Рис. 3.33. Таблица Levene's Test of Equality of Error Variances








Рис. 3.34. Таблица Tests of Between-Subiects Effects








Рис. 3.35. Таблицы Homogeneous Subsets для переменных Возраст и Количество членов семьи








Рис. 4.1. Диалоговое окно Crosstabs








Рис. 4.2. Диалоговое окно Cell Display


Crosstabs








Рис. 4.3. Диалоговое окно Table Format








Рис. 4.4. Таблица перекрестного распределения по трем вопросам: Частота посещения, Возраст и Пол








Рис. 4.5. Диалоговое окно Statistics





Рис. 4.6. Таблица Chi-Square Tests








Рис. 4.7. Таблица Symmetric Measures для порядковых переменных





Рис. 4.8. Таблица Symmetric Measures для номинальных переменных (пример)





Рис. 4.9. Диалоговое окно Exact Tests








Рис. 4.10. Таблица Chi-Square Tests с результатами теста Monte-Carlo





Рис. 4.11. Таблица Symmetric Measures с результатами теста Monte-Carlo





Рис. 4.12. Диалоговое окно Multiple Response Crosstabs








Рис. 4.13. Диалоговое окно Define Variable Ranges








Рис. 4.14. Диалоговое окно Options








Рис. 4.15. Таблица Crosstabulation для мужчин








Рис. 4.16. Таблица Crosstabulation для женщин








Рис. 4.17. Диалоговое окно Bivariate Correlations (корреляция Пирсона)








Рис. 4.18. Таблица Correlations (корреляция Пирсона)





Рис. 4.19. Окно SPSS Data Editor с двумя ранжированными перечнями наиболее значимых для респондентов факторов выбора магазинов одежды





Рис. 4.20. Окно SPSS Data Editor с двумя ранжированными перечнями наиболее значимых для респондентов факторов выбора магазинов одежды одежды





Рис. 4.21. Диалоговое окно Bivariate Correlations 


(корреляция Спирмана)одежды





Рис. 4.22. Таблица Correlations (корреляция Спирмана)





Рис. 4.23. Коэффициенты корреляции (Пирсона) для трех переменных: возраст, уровень доходов и количество членов семьи





Рис. 4.24. Диалоговое окно Partial Correlations





Рис. 4.25. Таблица Partial Correlation Coefficients








Рис. 4.26. Диалоговое окно Set Rule








Рис. 4.26. Диалоговое окно Set Rule








Рис. 4.28. Диалоговое окно Linear Regression





Рис. 4.29. Таблица ANOVA





Рис. 4.30. Таблица Model Summary





Рис. 4.31. Таблица Coefficients








Рис. 4.32. Рейтинг значимости параметров сервиса на борту





Рис. 4.33. Диалоговое окно Scatterplot





Рис. 4.34. Диалоговое окно Simple Scatterplot








Рис. 4.35. Диаграмма Scatterplot с построенной линией тренда








Рис. 5.1. Диалоговое окно Logistic Regression








Рис. 5.2. Диалоговое окно Define Categorical Variables








Рис. 5.3. Диалоговое окно Save New Variables








Рис. 5.4. Таблица Omnibus Tests of Model Coefficients





Рис. 5.5. Таблица Model Summary








Рис. 5.6. Таблица Classification Table





Рис. 5.7. Таблица Variables in the Equation





Рис. 5.8. Диалоговое окно Multinomial Logistic Regression





Рис. 5.9. Диалоговое окно Statistics








Рис. 5.10. Диалоговое окно Save








Рис. 5.11. Таблица Model Fitting Information





Рис. 5.12. Таблица Pseudo R-Square





Рис. 5.13. Таблица Likelihood Ratio Tests








Рис. 5.14. Таблица Parameter Estimates








Рис. 5.15. Таблица Observed and Predicted Frequencies





Рис. 5.16. Диалоговое окно Discriminant Analysis





Рис. 5.17. Диалоговое окно Define Range








Рис. 5.18. Диалоговое окно Statistics





Рис. 5.19. Диалоговое окно Stepwise Method





Рис. 5.20. Диалоговое окно Classification





Рис. 5.21. Диалоговое окно Save





Рис. 5.22. Таблица Tests of Equality of Group Means








Рис. 5.23. Таблица Test Results





Рис. 5.24. Таблица Variables in the Analysis





Рис. 5.25. Таблица Eigenvalues








Рис. 5.26. Таблица Wilks' Lambda








Рис. 5.27. Таблица Standardized Canonical Discriminant Function Coefficients





Рис. 5.28. Таблица Structure Matrix








Рис. 5.29. Таблица Canonical Discriminant Function Coefficients





Рис. 5.30. Таблица Functions at Group Centroids





Рис. 5.31. Таблица Classification Results








Рис. 5.32. Диалоговое окно Factor Analysis





Рис. 5.33. Диалоговое окно Descriptives





Рис. 5.34. Диалоговое окно Extraction





Рис. 5.35. Диалоговое окно Rotation








Рис. 5.36. Диалоговое окно Factor Scores








Рис. 5.37. Диалоговое окно Options











Рис. 5.38. Таблица КМО and Barlett s Test











Рис. 5.39. Таблица Rotated Component Matrix





Рис. 5.40. Таблица Rotated Component Matrix, содержащая все факторные коэффициенты





Рис. 5.41. Диалоговое окно Rank Cases








Рис. 5.42. Диалоговое окно Types








Рис. 5.43. Перекрестное распределение: влияние пола респондентов на их оценку текущего состояния дел в авиакомпании X








Рис. 5.44. Диалоговое окно Hierarchical Cluster Analysis








Рис. 5.45. Диалоговое окно Plots








Рис. 5.46. Таблица Average Linkage (Between Groups)





Рис. 5.47. Диалоговое окно создания новой переменной








Рис. 5.48. Диалоговое окно Method





Рис. 5.49. Линейное распределение для 16-кластерного решения





Рис. 5.50. Численность кластеров (решение для 2 кластеров)








Рис. 5.51. Диалоговое окно Means





Рис. 5.52. Диалоговое окно Options








Рис. 5.53. Сравнение средних для двух выделенных кластеров





Рис. 5.54. Членство авиакомпаний в кластерах








Рис. 5.55. Диалоговое окно Hierarchical Cluster Analysis при кластеризации переменных





Рис. 5.56. Таблица Agglomeration Schedule








Рис. 5.57. Диалоговое окно Statistics





Рис. 5.58. Таблица Cluster Membership








Листинг П.1. Скрипт для переноса таблиц из SPSS Viewer в MS Word








Рис. П.1. Диалоговое окно One-Sample Kolmogorov-Smirnov Test








Рис. П.2. Таблица One-Sample Kolmogorov-Smirnov Test
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